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Introduction 

Where do I start? 

Start by reading this introduction in its entirety. It contains useful general information 

about the Modeller user interface and details of how the examples are formatted. 

Software requirements 

The examples are written for use with version 15.1 of LUSAS software products.  

The LUSAS software product (and version of that product) and any product options 

that are required in order to run an example will be stated in a usage box like this: 

For software product(s):  All (except LT versions) 

With product option(s): Nonlinear 

 

Note that Composite examples can be run in any software product if a Composite 

product option has been purchased. Similarly, LUSAS Analyst or LUSAS Composite 

products can run bridge or civil examples if a Bridge or Civil product option was 

purchased. The LUSAS Academic software product will run any example. 

What software do I have installed? 

To find out which software product(s), which version of that product, and which 

software options are installed and licensed for your use run LUSAS and select Help > 

About LUSAS Modeller and press the Key Information button to display a dialog 

that lists the facilities and options supported by your software license. 

About the examples 

The examples are of varying complexity and cover different modelling and analysis 

procedures using LUSAS. The first example in this manual contains detailed 

information to guide you through the procedures involved in building a LUSAS model, 

running an analysis and viewing the results. This fully worked example details the 

contents of each dialog used and the necessary text entry and mouse clicks involved.  



Introduction 

 2 

The remaining examples assume that you have completed the fully worked example and 

may not necessarily contain the same level of information. It will benefit you to work 

through as many examples as possible, even if they have no direct bearing on your 

immediate analysis interests. 

Except where mentioned, all examples are written to allow modelling and analysis to be 

carried out with the Teaching and Training version of LUSAS which has restrictions on 

problem size. The teaching and training version limits are currently set as follows: 

500  

Nodes 

100 

Points 

250 

Elements 

1500  

Degrees of Freedom 

10  

Loadcases 

 

Because of the modelling and analysis limits imposed by the Teaching and Training 

Versions some examples may contain coarse mesh arrangements that do not necessarily 

constitute good modelling practice. In these situations these examples should only be 

used to illustrate the LUSAS modelling methods and analysis procedures involved and 

should not necessarily be used as examples of how to analyse a particular type of 

structure in detail.  

Other worked examples 

A separate worked examples manual Application Examples Manual (Bridge, Civil & 

Structural) contains application-specific examples for civil, structural and bridge 

enegineering. 

User Manuals for optional software products and options, such as IMD Plus, or Rail 

Track Analysis contain worked examples to illustrate the use of each. 

Format of the examples 

Headings 

Each example contains some or all of the following main headings: 

 Description contains a summary of the example, defining geometry, material 

properties, analysis requirements and results processing requirements. 
 

 Objectives states the aims of the analysis. 

 Keywords contains a list of keywords as an aid to selecting the correct 

examples to run.  

 Associated Files contains a list of files held in the \<Lusas 

Installation Folder>\Examples\Modeller directory that are associated with 

the example. These files are used to re-build models if you have problems, or 
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can be used to quickly build a model to skip to a certain part of an example, 

for instance, if you are only interested in the results processing stage. 
  

 Modelling contains procedures for defining the features and attribute datasets 

to prepare the LUSAS model file. Multiple model files are created in some of 

the more complex examples and these therefore contain more than one 

‘Modelling’ section. 

 Running the Analysis contains details for running the analysis and 

assistance should the analysis fails for any reason.  

 Viewing the Results contains procedures for results processing using 

various methods. 
 

Menu commands 

Menu entries to be selected are shown as follows: 

This implies that the Geometry menu should be selected from the menu bar, followed 

by Point, followed by the Coordinates... option.  

Sometimes when a menu entry is referred to in the body text of an example it is written 

using a bold text style. For example the menu entry shown above would be written as 

Geometry > Point > Coordinates... 

Toolbar buttons 

For certain commands a toolbar button will also be shown to show the ‘short-cut’ 

option to the same command that could be used instead: 

The toolbar button for the Geometry > Point > Coordinates… command is 

shown here.  

User actions 

Actions that you need to carry out are generally bulleted (the exception is when they are 

immediately to the right of a menu command or a toolbar button) and any text that has 

to be entered is written in a bold text style as follows: 

 Enter coordinates of (10, 20). 

So the selection of a typical menu command (or the equivalent toolbar button) and the 

subsequent action to be carried out would appear as follows: 

Enter coordinates of (10, 20). 

 

Geometry 

Point > 

Coordinates... 

 

Geometry 

Point > 

Coordinates... 
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Selecting the menu commands, or the toolbar button shown will cause a dialog box to 

be displayed in which the coordinates 10, 20 should be entered. 

Filling-in dialogs 

For filling-in dialogs a bold text style is used to indicate the text that must be entered. 

Items to be selected from drop-down lists or radio buttons that need to be picked also 

use a bold text style. For example:  

 In the New Model dialog enter the filename as frame_2d and click the OK 

button to finish. 

Grey-boxed text  

Grey-boxed text indicates a procedure that only needs to be performed if problems 

occur with the modelling or analysis of the example. An example follows: 

Rebuilding a model 

 Start a new model file. If an existing model is open Modeller will prompt for any  

un-saved data to be saved before opening the new file. 

 Enter the file name as example 

To recreate the model, select the file example_modelling.vbs located in the \<LUSAS 

Installation Folder>\Examples\Modeller
 
directory. 

 

 

Visual Basic Scripts 

Each example has an associated set of LUSAS-created VBS files that are supplied on 

the release kit.  These are installed into the \<Lusas Installation 

Folder>\Examples\Modeller directory. If results processing and not the actual 

modelling of an example is only of interest to you the VBS files provided will allow 

you to quickly build a model for analysis. These scripts are also for use when it proves 

impossible for you to correct any errors made prior to running an analysis of an 

example. They allow you to re-create a model from scratch and run an analysis 

successfully. For more details refer to Creating a Model From The Supplied VBS files. 

File 

New… 

File 

Script > 

Run Script... 
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Modelling Units 

At the beginning of each example the modelling units used will be stated something like 

this: 

“Units used are N, m, kg, s, C throughout” 

 
Model units are specified as part of the creation of a new model and are reported at all 

times in the status bar at the bottom of the Modeller window. Once set, for all dialogs 

with grid cells permitting dimensional input, the units expected are  displayed as a 

tooltip when the cursor is hovered over the input cell. 

Timescale Units 

Timescale units are specified as part of the creation of a new model and can be changed 

on the Model Properties dialog. Choosing a timescale unit dictates how time-based 

values are displayed on dialogs during modelling, and how they are output when 

processing results 

Icons Used 

Throughout the examples, files, notes, tips and warnings icons may be found. They can 

be seen in the left margin. 

Files.  The diskette icon is used to indicate files used or created in an example. 

  

Note.  A note is information relevant to the current topic that should be drawn to your 

attention. Notes may cover useful additional information or bring out points requiring 

additional care in their execution. 

Tip.  A tip is a useful point or technique that will help to make the software easier to 

use.  

Caution.  A caution is used to alert you to something that could cause an inadvertent 

error to be made, or a potential corruption of data, or perhaps give you results that you 

would not otherwise expect. Cautions are rare, so take heed if they appear in the 

example.  








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Running LUSAS Modeller 

 Start LUSAS Modeller from the start programs menu. This differs according to the 

operating system in use, but typically is done by selecting: 

Start > All Programs > LUSAS 15.x for Windows > LUSAS Modeller 

 A licence option will need to be selected 

 The on-line help system will be displayed showing the latest changes to the 

software. 

 Close the on-line Help system window. 

(LUSAS Academic version only)  

 Select your chosen LUSAS product and click  the 

OK button. 
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Creating a new model / Opening an existing 

model 

When running LUSAS for 

the first time the LUSAS 

Modeller Startup dialog will 

be displayed. This dialog 

allows either a new model to 

be created, or an existing 

model to be opened. 

Note.  When an existing 

model is loaded a check is 

made by LUSAS to see if a 

results file of the same name 

exists. If so, you have the 

option to load the results file 

on top of the opened model. 

Note.  If an existing model is loaded, that in a previous session caused a crash to 

occur in LUSAS Modeller, options are provided to help you to recover your model 

data. 

If creating a new model the 

New Model dialog will be 

displayed. 

 Enter information and 

make selections for 

the new model and 

click the OK button. 

Product specific menu entries 

for the selected software 

product in use e.g. Bridge or 

Civil will be added to the 

LUSAS Modeller menu bar. 

Saving model files 

The worked examples as written do not generally advise you where to save a model, 

and by default the New Model dialog will initially save files to the <LUSAS Installation 

 




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Folder>\Projects directory. For the purposes of carrying out the various examples of 

interest this is acceptable, but note that for real ‘live’ projects it may be beneficial to 

save models in separate projects folders, each named according to the individual 

projects that will be undertaken. This can assist with backup and eventual deletion of 

data on a project-by-project basis. 

Specifying the saved location of results/intermediate files 

The LUSAS Configuration Utility can be used to specify where files created in the 

course of building a model are saved.  See the online help pages for details of how to 

access this tool. Using this facility, the location of files that are created in the course of 

a building a model and running the various analyses associated with it can be specified 

as being: 

 Within a folder for each model, within a folder called "Associated Model 

Data" This is the default setting. Note that the model file itself does not reside 

within the folder created.  

 Within a folder with the same name as the model Note that the model file 

itself does not reside within the folder created.  

 Within the same folder as the model (This was the Version 14.7 behaviour)  

 To a specified folder where the location can be defined by internal LUSAS 

tokens and ordinary text. For example, the token%ModelLocn% is substituted 

with the working current folder for the model; and %ModelName% is 

substituted with the model's file name. Relative links (e.g. ..\ to use the parent 

folder) can alternatively be specified. 

For the purposes of carrying out the worked examples these settings do not need to be 

changed. 

Creating a Model from the Supplied VBS Files  

If results processing and not the actual modelling of an example is only of interest, the 

VBS files provided will allow you to quickly build a model for analysis.  

Proceed as follows to create the model from the relevant VBS file supplied: 

 Start a new model file.  

 Enter the file name as example name and click OK 

 In general, ensure that the User interface selected is of the same type as the analysis 

to be carried out. 

File 

New… 
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 Select the file example_name_modelling.vbs located in the \<LUSAS 

Installation Folder>\Examples\Modeller
 
directory. 

Note.  VBS scripts that create models automatically perform a File > Save menu 

command as the end. 

Some additional modelling may need to be carried out prior to an analysis being run. 

See individual examples for details. 

The LUSAS Modeller Interface 

The principal regions and components of theModeller user interface are shown on the 

following image and are described below. 

 

Main Menu and Toolbars 

The main menu and associated toolbars which contain toolbar buttons provide the 

means to define model related geometry and other data. On initial start-up of 

File 

Script > 

Run Script... 





Introduction 

 10 

LUSAS Modeller the Main, Define and View Toolbars are displayed. All toolbars can 

be shown, hidden, or customised, using the View> Toolbar menu item.  

View window 

A View Window is where each model is developed and manipulated. Any number of 

view windows can be created with each displaying a unique view of a model. Pre-

defined view layers inside each window hold model information that can be generally 

manipulated in the current view window as required. 

Modelling in LUSAS 

A LUSAS model is graphically represented by geometry features (points, lines, 

surfaces, volumes) which are assigned attributes (mesh, geometric, material, support, 

loading etc.). Geometry is defined using a whole range of tools under the Geometry 

menu, or the buttons on the Toolbars. Attributes are defined from the Attributes menu. 

Once defined attributes are listed in the Treeview. 

Treeviews 

Treeviews are used to organise various aspects of the model in graphical frames. There 

are a number of  Treeviews showing Groups , Attributes , Analyses , Utilities 

, and Reports .  

 

 The Layers  Treeview controls the display of selective model data and 

results data to a view window.  

 The Groups  Treeview is used to store selected user-defined collections of 

objects (geometry, nodes or elements) under a collective name.  

 The Attributes Treeview is where defined contains information relating to 

the model; the element type and discretisation on the geometry; section 

properties and thicknesses; the materials used; how the model is supported or 

restrained; and how the model is loaded. 

 The Analyses  Treeview shows all analyses defined; loadcases defined 

including analysis control loadcases defined during the modelling stage; 

results loadcases containing solutions for results processing; loadcase 

combinations and envelopes; and IMD and Fatigue calculations.  

 The Utilities  Treeview contains utility items used in the definition of 

model geometry or attributes, or to control an analysis, or to provide a 

particular functionality, such as to define a load combination or produce a 

report for example. 
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 The Reports  Treeview contains a user-defined folder structure of reports, 

chapter and image entries to allow a report to be generated in a variety of 

formats. 

Treeviews use drag and drop functionality. For example, an attribute in the Attributes 

 Treeview can be assigned to model geometry by dragging the attribute onto an 

object (or objects) currently selected in the graphics window, or by copying and pasting 

an attribute onto another valid Treeview item as for instance, a group name, as held in 

the Groups  Treeview. 

Text Output Window 

The Text Output Window displays messages and warnings during a modelling session. 

When an error message or warning relating to a particular object is written to the text 

output window, extra information is usually available by double-clicking on that line of 

text. 

Browse Selection 

This window is not displayed by default but can be viewed using the View> Browse 

Selection menu item. Once visible it will contain a list of all currently selected items 

which may then be individually deselected.  

Browse Cyclable Items 

This window is not displayed by default but can be viewed using the View> Browse 

Cyclable Items menu item. Once visible it will contain a list of all cyclable items. 

These may then be individually selected or deselected.   

Browse Selection Memory 

This window is not displayed by default but can be viewed using the View> Selection 

Memory> Browse Memory Selection menu item. Once visible it will contain a list of 

all items currently in Selection Memory which may then be individually deselected. 

Status Bar 

The Status Bar displays progress messages and help text during a modelling session, the 

model units, the current cursor position in model units (if the model is displayed in an 

orthogonal plane) and the item or number of items in the current selection.  The View> 

Status Bar menu item may be used to hide or show the Status Bar. 

Data Tips and Tooltips 

Data tips and tool tips provide basic information about whatever is under the cursor. 

Datatips generally report information relating to the model geometry, attributes and 
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assignments etc. Tool tips report on uses of toolbar buttons or expected input for grid 

cells etc.  

Context Menus 

Although commands can be accessed from the main menu, pressing the right-hand 

mouse button with an object selected usually displays a context menu which provides 

access to relevant operations. Treeview panels also have a context menu which provides 

access to additional functionality such as editing of data, control of visibility, 

visualisation of assignments, and selective control of results plotting on selected 

attributes. 

Properties 

General information relating to a model is presented in property dialogs. Properties may 

relate to the whole model or the current window, or a single geometric feature - in fact 

most objects have properties. To view an object’s properties, select it, press the right 

mouse button, then choose Properties from the context menu 

Getting Help 

LUSAS contains a comprehensive Help system. The Help consists of the following:  

 The Help button  on the Main toolbar is used to get context-sensitive help on 

the LUSAS interface. Click on the Help button, then click on any toolbar button or 

menu entry (even when greyed out). 

 Most dialogs include a Help button which provides information on that dialog. 

 Selecting Help > Help Topics from the main menu provides access to all the Help 

files.  

 If the Help Contents, the Help Index and the Search facility are not shown 

when a help page is first displayed pressing the Show button will show these tabs in the 

HTML Help Window.
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Linear Elastic 

Analysis of a 

Spanner 

For software product(s):  All (except LT versions) 

With product option(s): None. 

Description 

A linear static analysis is to 

be carried out on the spanner 

shown. 

The spanner is supported as 

though it were being used to 

turn a nut, and is loaded with 

a constant pressure load 

along the top edge of the 

handle. 

Units used are N, mm, t, s, C, throughout. 

Keywords 

2D, Linear, Elastic, Regular Meshing, Irregular Meshing, Copy, Rotate, Mirror, 

Transformation, Groups, Deformed Shape, Contour Plot, Principal Stress Vector 

Plot, Graph Plotting, Slice Section Results. 

 



Linear Elastic Analysis of a Spanner 

 14 

 

Objectives 

The required output from the analysis is: 

 A plot of the deformed shape. 

 A plot of the equivalent stresses in the spanner. 

 A graph showing the variation in equivalent stress where the handle meets the 

jaws. 
  

Associated Files 

 spanner_modelling.vbs  carries out the modelling of the example. 
 
 

Modelling : Features 

This section covers the definition of the features (Points, Lines and Surfaces) which 

together form the geometry of the spanner. 

 The symmetry of the spanner will be used by firstly defining one half and then 

mirroring about a horizontal centre-line. 

 One half of the jaws will be defined by three Surfaces using 3 different methods. 

One Surface will be defined simply by its bounding coordinates, a second by 

sweeping a Line through a rotational transformation and a third by copying the 

second Surface using a pre-defined rotation. 

 One half of the handle will be defined using one Surface. It will be bounded by 

three Lines, one of which will be a cubic spline. 

 Once the Surfaces have been defined, they will all be mirrored about the spanner 

centre-line. 

 The features which make up the spanner will be divided into two Groups, the 

jaws and the handle, to make the assignment of attributes easier.  
 

Running LUSAS Modeller 

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller 

in the Examples Manual Introduction. 

Note. This example is written assuming a new LUSAS Modeller session has been 

started. If continuing from an existing Modeller session select the menu command 

File>New to start a new model file. Modeller will prompt for any unsaved data and 

display the New Model dialog. 







Modelling : Features 

 15 

Creating a new model 

 Enter the File name as 

spanner 

 Use the Default Working 

folder. 

 Enter the Title as Spanner  

 Set Model units of 

N,mm,t,s,C 

 Leave the Timescale units 

as Seconds 

 Ensure an Analysis type of 

Structural is set. 

 Select a Standard Startup template. This populates the Attributes  treeview with 

useful basic line mesh, geometric and support entries. 

 Ensure the Vertical axis is set to Z 

 Click the OK button. 

Note. Save the model as the example progresses. The Undo button  may be used 

to correct a mistake. The undo button allows any number of actions since the last save 

to be undone. 

Modelling Geometry 

LUSAS Modeller is a feature-based modelling system. The model geometry is defined 

in terms of features (Points, Lines, Surfaces and Volumes) which are later meshed to 

generate the Finite Element Model ready for solution. The features form a hierarchy, 

with Points defining Lines, Lines defining Surfaces and Surfaces defining Volumes. 

 


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 Enter coordinates of (0, 20), 

(-20, 20), (-20, 30) and (0, 40) to 

define the vertices of the Surface.  

Note. Sets of coordinates are 

separated by commas or spaces. 

The Tab key is used to create new 

entry fields. The arrow keys are 

used to move between entries. 

 Click the OK button to make 

the dialog  disappear and 

generate the Surface as 

shown.  

Note. If the Z ordinate is omitted 

zero is assumed. 

Note. Confirmation that the 

Surface has been created is given 

in the message window. 

Note. Cartesian, cylindrical or 

spherical coordinates systems may be used to define models. In this example Cartesian 

coordinates will be used throughout. 

The right-hand vertical Line will be used to create a Surface by sweeping the line 

through a rotation of 45 degrees clockwise. 

 Select the Line by moving 

the cursor over the Line 

shown and clicking the left-

hand mouse button.  

The line will change colour to 

show it has been selected. 

Note. Feedback on the items 

currently selected is provided on 

the right-hand side of  the status 

bar at the bottom of the display. 

 

Geometry 

Surface > 

Coordinates... 

 









Select this Line

... and sweep it to

form this Surface

 


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 Select the Rotate option and 

enter -45 for the angle of rotation 

about the Z-axis.  

 

 Enter the attribute name as  

Rotate 45 Clockwise 

 Click the Save button to save the 

dataset for re-use later. 

 Click the OK button to sweep 

the Line clockwise through 45 

degrees about (0,0,0) to create a 

Surface. 

Note. Clockwise angles are 

negative and anti-clockwise angles 

are positive.  

The Surface just drawn will now be 

copied by rotating it through a 45 

degree rotation clockwise. 

 Select the previously drawn 

Surface by clicking on it with 

the left-hand mouse button. 

 

 

 

 

 

 

 

 

Geometry 

Surface > 

By Sweeping.. 

 



Select and copy

this Surface

To form this Surface
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 Select the attribute Rotate 45 

Clockwise from the drop down list. 

 Ensure that the number of copies 

is set to 1 

 Click the OK button to copy the 

Surface, rotating it clockwise 

through 45 degrees. 

 

 

 

 

 

To define the top line of the handle of the spanner a cubic spline will be created. 

Note. A cubic spline is a Line which passes through any number of Points. If required, 

the start and finish directions of the spline can be defined by specifying end-tangents 

(i.e. by specifying the directions of Lines at its ends).  

In this example end-tangents are used to fix the start and finish directions of the spline 

so a construction Line must first be defined.  

 Enter coordinates of (200, 0) and (200, -10) 

to define the construction Line. 

 Click the OK button to generate a vertical 

Line away from the existing Surfaces. 

This Line will be used to specify the finishing 

direction of the cubic spline. 

Note. When selecting features to define a cubic 

spline it is very important that the correct features 

are selected in a particular order. The Lines that 

define the start and finish directions of the spline 

are to be selected first, followed by the Points that 

define the start and end positions of the spline. 

 

Geometry 

Surface > 

Copy... 



Geometry 

Line > 

Coordinates... 

 


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Defining a cubic spline 

 Select the arc shown by 

moving the mouse over 

the arc and click the 

left-hand mouse button. 

(This arc defines the 

direction in which the 

spline starts). 

 Hold the Shift key 

down to add additional 

features to the selection  

 Select the construction Line defined earlier by moving the mouse over the Line 

shown and click the left-hand mouse button. (This Line defines the direction in 

which the spline ends). 

 Continue holding the Shift key down to further add to the selection. Select the 

Point on the end of the first arc selected. (This defines where the spline starts). 

 Still holding the Shift key down, select the Point on the end of the construction 

Line. (This defines where the spline ends). 

Click the OK button to generate a default cubic spline to form the handle of the 

spanner, ensuring that both reverse options are off. 

 

Note. Line directions can be seen by double-clicking on the Geometry entry in the  

Treeview and selecting the Line directions check box. 

Once the spline is drawn correctly the construction Line is deleted. 

 Drag a box around 

the construction 

Line by firstly 

moving the mouse 

above and to the left 

of the Line.  

 Click the left-hand 

mouse button and 

holding it down move the mouse to the right and down so that a box is shown 

which completely encloses the Line as shown. Release the left-hand mouse button. 

LUSAS will highlight the selected features. 

4. Select this Point

1. Select this arc

2. Select this Line

3. Select this Point

 

Geometry 

Line > 

Spline > 

Tangent to 
Lines... 



Drag a box around the construction Line
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 Delete the selected features. 

 Click the Yes To All button to delete the selected Line and Points 

Note. The Del key can also be used to delete features. For a full list of keyboard 

shortcuts refer to the Online Help file, which can be accessed from the Help > Help 

Topics menu. 

The centre-line of the spanner can now be defined by joining the two unconnected 

points into a Line. 

 Drag a box around 

the two Points on 

the centre-line of the 

spanner as shown 

 

 A Line will be 

drawn between the points selected. 

The Surface forming the handle of the spanner will now be defined by selecting the 

three Lines bounding the Surface. 

 Select the 3 Lines 

which define the 

Surface of the handle 

in the order shown, 

ensuring the Shift 

key is held down to 

keep adding to the 

selection. 

 If prompted, press 

OK to draw the Surface formed by the 3 lines selected. 

Note. Selecting the Lines in this anti-clockwise order ensures that the local element 

axes of the Surface will be suitable for the applied face loading that will be applied later 

in the example. Selecting the Lines by dragging a box around them would not 

necessarily produce the same Surface axes. 

Mirroring model information 

Half of the model has now been defined. This half can now be mirrored to create the 

whole model. The first step in the process is to define a mirror plane. 

Edit 

Delete 



Drag a box around these 2 Points
 

Geometry 

Line > 

Points... 

1. Select this Line

2. Hold Shift key down

3. With Shift key

down select this Line

4. With Shift key

down select this Line
 

Geometry 

Surface > 

Lines... 


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 Select the 2 points 

shown, making sure the 

Shift key is held down 

in order to add the 

second Point to the 

initial selection. 

These Points define the axis 

about which the spanner 

will be mirrored.  

Places the Points selected into memory. 

 

Next, the Surfaces to be mirrored are to be selected. This will require the whole model 

to be selected.  

 Select the whole model by dragging a box around the features 

Note. An alternative to dragging a box around all the features to select them is to 

press the Ctrl and A keys at the same time. 

  Select Mirror – from Point 14 

and Point 15 from the drop down list 

and click the Use button on the 

dialog to use the points previously 

stored in memory. 

 Click the OK button to copy all 

of the Surfaces, mirroring them 

about the centre-line to give the 

model shown in the previous 

diagram. 

If the model features have been 

mirrored successfully the Points held 

in memory may be cleared. 

The Points are now cleared from 

memory. 

Note. Right-clicking on the view with geometry selected opens a menu with shortcuts 

to Delete, Move, Copy and Sweep. 

This has completed the spanner geometry. 

1. Select this Point

2. Hold the Shift key down

3. Select this Point
 

Edit 

Selection Memory > 

Set 



Geometry 

Surface > 

Copy… 

 

Edit 

Selection Memory > 

Clear 


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Using Groups 

Tip. Model features can be grouped together to make assignment and viewing of 

model attributes easier.  

In this example the Surfaces defining the jaws of the spanner will form one Group. The 

Surfaces defining the handle of the spanner will form another Group. 

 Drag a box around the 

Surfaces representing 

the jaws of the 

spanner.  

 This adds a New 

Group entry to the  

Treeview for the features 

selected.  

 

 

 Enter the group name as Jaws and click OK to finish defining the group.  

 

 Drag a box around 

the Surfaces 

representing the 

handle of the 

spanner. 

 This adds a New 

Group entry to the 

Treeview for the 

features selected.  

 

 Enter the group name as Handle and click OK to finish defining the group. 



Drag a box to select

the Jaw features

 

Geometry 

Group > 

New Group 

Drag a box to select the Handle features
 

Geometry 

Group > 

New Group 
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Modelling Features Recap 

The features that form the 2-Dimensional representation of the spanner have been 

defined.  In this section the following topics have been covered: 

 How to define Points, Lines and Surfaces. 

 How to define Lines by specifying the coordinates of their Points and by joining 

existing Points.  

 How to define Surfaces by their bounding coordinates, by sweeping, and by 

copying. 

 How to define a cubic spline. 

 How to select features by using the Shift Key to add to a previous selection. 

 How to select features by dragging a box around features to be selected. 

 How to select all features in a model by pressing the Control and A keys. 

 How to rotate and mirror model features. 

 How to define groups of features. 

Modelling : Attributes 

Defining and Assigning Model Attributes 

In order to carry out an analysis of the model various attributes must be defined and 

assigned to the model. 

The following attributes need to be defined: 

 The finite element mesh to be used. 

 The thickness of the spanner. 

 The material from which the spanner is made. 

 The supports to be used. 

 The loading on the spanner. 
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Note. LUSAS Modeller works on a define and 

assign basis where attributes are first defined, then 

assigned to features of the model. This can be done 

either in a step-by-step fashion for each attribute or 

by defining all attributes first and then assigning all 

in turn to the model.  

 Attributes are first defined and are 

subsequently displayed in the  Treeview 

as shown.  Unassigned attributes appear 

‘greyed-out’. 

 Attributes are then assigned to features by 

dragging an attribute dataset from the 

Treeview onto previously selected features. 
  

Tip. Useful commands relating to the manipulation 

of attributes can be accessed by selecting an 

attribute in the  Treeview, then clicking the 

right-hand mouse button to display a shortcut menu. 

 

 

Defining the Mesh 

The spanner will be meshed using both regular and irregular Surface meshes. A regular 

mesh is to be used for the jaws of the spanner. An irregular mesh will be used for the 

handle.  

The number of elements in the regular Surface mesh will be controlled by defining line 

meshes on the Lines defining the boundary of the Surfaces. The number of elements in 

the irregular Surface mesh will be controlled by specifying an ideal element size. Other 

methods of controlling mesh density are also available. 



 





Modelling : Attributes 

 25 

Defining a regular Surface mesh 

 Select Plane stress 

elements, which are 

Quadrilateral in 

shape with a 

Quadratic 

interpolation order.  

 Ensure that the  

Regular Mesh button 

is selected and Allow 

transition pattern is 

not selected. 

 Enter the attribute 

name as Regular 

Plane Stress 

 Click the OK button 

to add the Surface 

mesh dataset to the  

Treeview. 

The mesh will be assigned to the model at a later stage. 

Controlling mesh density 

The lines currently defined have 4 divisions per line by default, but in this example only 

2 divisions are required for the Lines defining the jaws. This can be done by either 

changing the default number of divisions per Line or by making use of Line mesh 

attributes. In this example, the default number of divisions will be changed. 

 Select the Meshing tab and set the Default Line divisions to 2. 

 Click the OK button. 

Attributes 

Mesh > 

Surface… 

 

File 

Model Properties… 
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Defining an irregular Surface mesh 

 Select Plane stress, 

Triangle, 

Quadratic 

elements. 

 Select the 

Irregular mesh 

button.  

 Select Element 

Size and then 

specify an element 

size of 18 

 Enter the attribute 

name as Irregular 

Plane Stress.  

 Click the OK 

button to add the 

Surface mesh 

attribute to the Treeview. 

The mesh will be assigned to the model at a later stage. 

Defining the Thickness 

So far the spanner has been defined in two dimensions. In order to give the spanner its 

thickness geometry attributes will be used. The jaws of the spanner are 15mm thick 

whilst the handle is 10mm thick. Two geometry attributes are required. 

 Enter the thickness 

as 15.  

 Enter the Attribute 

name as 

Thickness=15 

 Click the Apply 

button to add the 

geometry attribute to 

the  Treeview. 

 

Attributes 

Mesh > 

Surface… 

 

Attributes 

Geometric > 

Surface… 
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Note. The Apply button allows information for another attributes to be entered using 

the same dialog. 

 Change the thickness to 10 

 Change the attribute name to Thickness=10 and click the OK button to add the 

additional geometry attribute to the  Treeview. 

Assigning a Surface mesh and Thickness to the Jaws 

The Surface mesh and geometry attributes defined previously can now be assigned to 

the relevant features of the spanner. As an alternative to selecting features by dragging a 

box around them, the previously named Groups can be used. 

 In the  Treeview, click the right-hand mouse button on the group name Jaws 

and select the Select Members option from the menu. If you already have some 

features selected click Yes to deselect them first. 

 Drag and drop the Surface 

mesh attribute Regular Plane 

Stress from the Treeview 

onto  the selected Surfaces. 

Modeller will confirm the 

mesh assignment for each 

Surface in the text window. 

The element mesh for the jaws of the spanner will be drawn. 

 Drag and drop the Surface geometry attribute Thickness=15 from the  Treeview 

onto the selected Surfaces. The elements of the jaws remain selected. 

 Click the left-hand mouse button in a blank part of the Graphics Window to 

deselect any previously selected model features. This shows that the geometric 

assignment has been visualised by default. 

 Select the fleshing on/off button to turn-off geometric property visualisation. 

Assigning Surface mesh and Thickness to the Handle 

 In the  Treeview, click the right-hand mouse button on the Group name Handle 

and select the Select Members option from the menu.  

All Surfaces forming the group Handle will be selected. 


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 Drag and drop the Surface mesh attribute Irregular Plane Stress from the  

Treeview onto the selected Surfaces defining the Handle. 

LUSAS will draw the 

irregular element mesh for 

the handle of the spanner. 

Note. The text output 

window will show messages 

relating to the radius of 

curvature for two of the 

elements created. These can 

be ignore for this example. 

 Drag and drop the Surface geometry attribute Thickness=10 from the  Treeview 

onto the selected Surfaces. Again confirmation of the assignment is provided in the 

text window. 

 Click the left-hand mouse button in a blank part of the Graphics Window to 

deselect any previously selected model features. 

Defining the Material 

 Select the material Mild Steel of Grade Ungraded from the drop-down list and 

click OK to add the material attribute to the  Treeview. 

 Right-hand click the material attribute Iso1 (Mild Steel Ungraded) from the  

Treeview and select Assign to all to apply the mild steel attribute to the whole 

model. 

Visualising Model Attributes 

Note. Any attributes (i.e. geometry, material, supports etc.) assigned to the model can 

be checked visually to ensure that the correct item has been assigned to the correct part 

of the model. For example: 

 Click the left-hand mouse button in a blank part of the Graphics Window to 

deselect any previously selected model features. 

 In the  Treeview, click the right-hand mouse button on the Thickness=15 

material attribute name and select the Visualise Assignments option from the 

dialog. 

 



Attributes 

Material > 

Material Library… 


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All features to which the 

Thickness=15 attribute is 

assigned will be visualised. 

To turn-off the visualisation 

of the assignments, click the 

right-hand mouse button on 

the Thickness=15 material 

attribute name in the  

Treeview and select the Visualise Assignments option again from the dialog. 

Note. This method can be used at any time during this example to check that selected 

attributes have been correctly assigned to the model. 

Manipulating layers 

At any time the layers displayed in the  Treeview may be re-ordered, hidden, 

removed or be re-added. 

 Select the Mesh entry in the  Treeview and drag it down to sit beneath the 

Geometry entry. In the view window the mesh can now be seen drawn on top of the 

geometry. 

 Click the right-hand mouse button on the Mesh entry in the  Treeview and select 

the On/Off option. The mesh will be hidden from the display. 

Fleshing  

Visualisation of assigned geometric attributes can also be seen using the fleshing 

option. 

 Select the fleshing 

on/off button to turn-on 

geometric property 

visualisation. 

 Select the isometric 

button to see the geometric 

visualisation on the elements.  

 Select the dynamic 

rotate button to view the 

spanner from the side. The 

difference in thickness between the handle and the jaws can be seen. 

 


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 Select the fleshing on/off button to turn-off the geometric visualisation. 

 Select the Home button to return the model to the default view. 

 Reset to normal cursor mode. 

Supports 

When using the standard template, LUSAS provides the more common types of support 

by default. These can be seen in the  Treeview. Two support attributes are required, 

one which restrains movement in the X direction, and one which restrains movement in 

the Y direction.  

Assigning the Supports 

 Select the Point on the 

centreline of the spanner 

as shown to assign the 

support Fixed in X. 

 Drag and drop the 

support attribute Fixed 

in X from the 

Treeview onto the 

selected point.  

 Click the OK button to 

assign the support to the Point selected for all the loadcases in analysis 1.  

The support will be visualised using an arrow symbol. 

Select the 2 Points shown to assign the support Fixed in Y. Hold the Shift key down to 

add the second point to the initial selection. 

 

 Drag and drop the support attribute Fixed in Y onto the selected points.  

 Click the OK button to assign the support to the points selected.  

The supports will be visualised using arrow symbols. 

 Click the left-hand mouse button in a blank part of the graphics window to deselect 

any previously selected model features. 

Select this Point for support

'Fixed in X'

Select these 2 Points for support 'Fixed in Y'
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Defining the Loading 

A pressure load is to be distributed evenly along the top edge of the handle. 

 Select the Face option and click Next 

 

 On the Face loading dialog enter a load of 0.1 in the y direction. 

 Enter the attribute name as Face Load of 0.1.  

 Click the Finish button to add the loading attribute to the Treeview. 

 

 

Attributes 

Loading… > 
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Assigning the Loading 

 Select the Line on the 

top edge of the spanner 

handle. 

 Drag and drop the 

loading attribute Face 

Load of 0.1 from the 

 Treeview onto the 

selected Line.  

 Click the OK button 

to assign the loading 

to the Line selected.  

 

 

 

 

Note. If the loading is displayed in the opposite direction to that shown the Surface 

forming the top half of the handle may be reversed as follows: 

 Select the Surface defining the top-half of the spanner by dragging a box around it. 

This will reverse the Surface axes and hence the direction of the loading.  

 

Saving the model 

 To save the model file. 

Modelling Attributes Recap 

In this section, the attributes of the model were defined and assigned to the features. 

 A regular Surface mesh with quadrilateral plane stress elements was defined and 

assigned to the jaws of the spanner. An irregular Surface mesh with triangular 

plane stress elements and a fixed element size was defined and assigned to the 

handle of the spanner. 

 Two geometry attributes were used to specify the spanner jaws and handle 

thickness. 

Select this Line

 

 



Geometry 

Surface > 

Reverse... 

File 

Save 
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 A material attribute specifying the properties of steel was defined and assigned 

to all Surfaces. 

 Two support attributes were defined in order to simulate the spanner being used 

to turn a nut and a structural face load was applied to the top edge of the handle. 

 Attributes assigned to the model were checked visually for correct assignment. 
  
The model definition is now complete. The next step in the process is to run an analysis 

to solve the problem. 

Running the Analysis 

 Open the Solve Now dialog and press OK to run the analysis. 

If the analysis is successful... 

Analysis loadcase results are added to the  Treeview.  

In addition, 2 files will be created in the Associated Model Data directory where the 

model file resides: 

 spanner.out  this output file contains details of model data, assigned 

attributes and selected statistics of the analysis. 

 spanner.mys  this is the LUSAS results file which is loaded automatically 

into the  Treeview to allow results processing to take place. 

 

If the analysis fails... 

If the analysis fails, information relating to the nature of the error encountered can be 

written to an output file in addition to the text output window.  Any errors listed in the 

text output window should be corrected in LUSAS Modeller before saving the model 

and re-running the analysis. Note that a common mistake made when using LUSAS 

Modeller for the first time is to forget to assign particular attribute data (geometry, 

mesh, supports, loading etc.) to the model.  

Rebuilding a Model  

If it proves impossible for you to correct the errors reported a file is provided to enable 

you to re-create the model from scratch and run an analysis successfully. 

 spanner_modelling.vbs  carries out the modelling of the example. 

 Start a new model file. If an existing model is open Modeller will prompt for 

unsaved data to be saved before opening the new file. 



File 

New… 
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 Enter the file name as spanner 

To recreate the model, select the file spanner_modelling.vbs located in the \<LUSAS 

Installation Folder>\Examples\Modeller
 
directory. 

 

 Rerun the analysis to generate the results. 

 

Viewing the Results  

In this section the results produced by the analysis of the spanner will be viewed. There 

are a number of ways to do this in LUSAS, allowing you to choose the most appropriate 

way to present your results. For this example: 

 A plot of the deformed mesh will be displayed and superimposed upon the 

undeformed shape for comparison. 

 The principal stress vectors will be plotted. 

 The von Mises stress contours for averaged stress values will be displayed. 

 Peak values of von Mises stress will be marked. 

 A graph will be produced showing the variation of stress along a slice section 

through the handle of the spanner. 
 

Selecting the results to be viewed 

Analysis loadcase results are present 

in the  Treeview inside the 

Analysis 1 entry as signified by the 

results bitmap . 

 

 

 

 

 

File 

Script > 

Run Script... 
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Using Page Layout Mode 

The model was created using a Working Mode view which allows a model of any size 

to be created. Results could be viewed using this mode of operation, but in order to 

allow additional information to be added without obscuring the model, Page Layout 

Mode can be used instead. 

The graphics window will resize to show the model view fitted on a piece of paper. 

 

 Ensure that the Landscape 

option is selected and that left, 

right, top and bottom page 

Margins of 60, 10, 10, 10 

respectively are set. 

 Click the OK button. 

 

 

 

 

 

 

 

Deformed Mesh Plot 

To plot a deformed mesh the Geometry and Attribute layers will be hidden, the Mesh 

layer will be turned on and Deformed mesh layer will be added to the  Treeview. 

 Click the right-hand mouse button on the Geometry entry in the  Treeview and 

select the On/Off option. The geometry will be hidden from the display. 

 Repeat to turn off the Attributes layer. 

 Turn on the Mesh layer. 

 Double click on the Mesh layer in the  Treeview to display the mesh layer 

properties. 

View 

Page Layout 
Mode... 

File 

Page Setup... 
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The mesh layer is to be plotted in green. 

 

 Select  and a dialog will 

appear showing the range of pens and 

colours in use.  

The mesh is currently drawn in a solid grey line 

style and is shown by the button with dashed 

outline. 

  

 Select the Green line pen. 

 Click OK to redraw the mesh in the new 

colour. 

 Double click on the Deformed mesh layer in the  Treeview to display the 

deformed mesh layer properties. 

 Click the OK button to 

select the defaults and 

display the deformed 

mesh. 

 

 

 

Principal Stress Vector Plots 

Principal stresses can be plotted as vectors with different colours being used to signify 

tension and compression.  

The mesh layer is no longer required and it will now be hidden. 

 Click the right-hand mouse button on the Mesh entry in the  Treeview and select 

the On/Off option. 

 Click the right-hand mouse button in a blank part of the graphics window and 

select the Vectors option to add the vectors layer to the  Treeview. 

The vector properties dialog will be displayed. 
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 Select Stress - Plane Stress 

vector results of Principal 

stresses from the entity drop 

down list.  

 Click the OK button to 

display the vector plot with 

tension vectors shown in red 

and compression vectors 

shown in blue. 

 

 

 

 

 

 

 

 

 

Creating New View Windows 

As an alternative to hiding, adding or removing layers from the  Treeview for each 

type of results to be displayed in a single view window, the multiple view windows 

facility can be used. New views can be created using default settings, or existing views 

can be saved before being applied to new views.  

This creates a new view window with default view layers of Mesh, Geometry, and 

Attributes. In the  Treeview a new folder for spanner.mdl Window 2 will appear. 

 Turn-off the Geometry, Attributes and Deformed mesh layers 

 In the  Treeview Loadcase 1 will be set active by default. 

 

 

 

 

 

Window 

New Window 
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Von Mises Stress Contour Plot 

Contours of von Mises Stress (Equivalent Stress) may be plotted as lines or as colour-

filled contour ranges. To display stress contours the contour layer needs to be added to 

the  Treeview. 

 With no features selected, click the right-hand mouse button in a blank part of the 

active window and select the Contours option to add the contours layer to the  

Treeview. 

The contour plot properties dialog will be displayed. 

 Ensure Stress - Plane 

Stress contour results from 

the Entity drop down list, 

equivalent stresses SE from 

the Component list, and 

Averaged nodal from the 

Display list are selected. 

 On the same dialog select 

the Contour Display tab 

and ensure that the Contour 

key button is selected. 

 Click the OK button to 

display the contour plot of equivalent stress along with the contour key. 

Re-ordering layers in the Treeview 

The order of the layers in the 

 Treeview governs the 

order in which the layers are 

displayed. To see the mesh 

layer on top of the contours 

the mesh layer must be 

moved down the  

Treeview list to a position 

after the contour layer. 

 

 



Viewing the Results 

 39 

 In the  Treeview select the Mesh layer within Window 2, and drag and drop the 

Mesh layer name on top of the contour layer name. The mesh layer name will then 

follow the contour name and the mesh itself will then be displayed on top of the 

contour layer.  

Note. This ordering of layer names can also be done using the right-hand mouse 

button and selecting the Move Down option from the context menu presented.  

Moving the contour key 

 In the  Treeview double-click 

Contours to open the properties dialog. 

 Select the Contour Display tab and 

press the Details button next to the 

Contour key option. 

 Set the X position to 50mm From 

right of paper, and the Y position to 

75mm From bottom of paper. 

 Limit the Significant figures to 4 and 

press OK to return to the contour 

properties dialog. 

 Press OK to save changes and move 

the contour key to the bottom-right 

corner for the view. 

Note. The contour key can also be moved graphically by selecting any text or contour 

key colouring and dragging the key to a new position. 

Marking Peak Values 

 With no features selected click the right-hand mouse button in a blank part of the 

graphics window and select the Values option to add the values layer to the 

Treeview. 

The values properties dialog will be displayed. 

 



 


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 Ensure Stress - Plane 

Stress contour results from 

the Entity drop down list, 

equivalent stresses SE from 

the Component list, and 

Averaged nodal from the 

Display list are selected. 

 On the same dialog, select 

the Values Display tab and 

set Maxima values to 

display the top 1% of 

results. (This will show the 

peak stress value) 

 Click the OK button to add the peak values to the contour plot. 

 Use the Zoom in button 

to enlarge the view of the 

spanner to check the number 

obtained. 

 Use the Home button  

to re-scale the model to the 

full view window. 

Saving View windows 

View layers and settings defined for a view can be saved for use with other view 

windows and for use within reports. 

 Accept the default settings presented and press the OK button to create a Saved 

view entry  ‘View 1’ in the Utilities  treeview. 

To update a view with the settings from a saved view: 

 Create a New Window using the Window > New Window main menu item. 

 Click on the Utilities  treeview and drag and drop the Saved view entry  for 

View1 onto the newly created view window.  This updates the newly created view 

to show those layers and settings saved with View 1.  

Note. It is very useful to name a saved view with a name that reflects the contents of 

the view. For example, saved view names of ‘Contours of SE’, or ‘Maximum 

displacement, or ‘Isometric view’ might be used, when relevant. 

 

 

Window 

Save View 


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Creating a Slice Section of Results 

Section slicing of a model to create graphs of results should always be done with a 

model lying orthogonal to the screen. For this example, the selection of the Home 

button on the previous page will ensure that this is the case. 

 Ensure the Snap to grid button is selected 

and a grid size of 10 is specified. 

 Click the OK button. 

 

 

 

 

 

 Click and drag the cursor 

as shown (at the X=40 

location) to define a 

section slice through the 

handle of the spanner 

where it joins the jaws. 

This operation leads directly 

on to creating a graph using the graph wizard… 

Selecting the Slice Data Results to be Plotted 

In this example a graph is to be plotted of the variation in stress through the specified 

section of the spanner. The X axis results of distance through the spanner have been 

defined by the section slice. The Y axis results now need to be specified. 

Utilities 

Graph Through 2D... 

 

Click here

Drag to here
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 Ensure Stress - Plane 

Stress contour results 

from the Entity drop 

down list, equivalent 

stresses SE from the 

Component list, and 

Averaged nodal from 

the Display list are 

selected. 

 Click the Next button 

to define the Y axis 

results.  

 

 

 

 

Title information for the graph is now to be added. 

 Enter the graph title as 

Stress at neck section 

 Enter the X axis label 

as Distance along 

section 

 Enter the Y axis label 

as Equivalent Stress 

(N/mm2) 

 Deselect the Show 

symbols button. 

 Click the Finish button 

to display the graph in 

a new window and 

show the values used 

in an adjacent table.  

Note. If the graph title or axes labels are left unspecified Modeller will use default 

names.  

 To see the graph at the best resolution enlarge the window to a full size view. 

 

 


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Note. The properties of the graph may be modified by clicking on the graph with the 

right-hand mouse button and selecting the Edit Graph Properties option. 

 

 To exit from the Graph Through 2D option click the Select Any cursor button. 

The grid will be removed. 

 

This completes the example. 
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Arbitrary Section 

Property 

Calculation and Use 

For software product(s):  All (except LT versions) 

With product option(s): None. 

Description 

The section properties of an 

arbitrary shaped box section are 

to be computed and saved in a 

user library. Section geometry is 

supplied as a DXF file. 

Units of N, mm, t, s, C are used. 

 Objectives 

The required output from the 

analysis consists of: 

 Section Properties of a 

box section 

Keywords 

Section Properties, Arbitrary Section, Holes, Local Library, Server Library 

  

Associated Files 

 box_section.dxf  DXF file containing geometry of section. 
 
 

 


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Modelling 

Running LUSAS Modeller 

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller 

in the Examples Manual Introduction. 

Note. This example is written assuming a new LUSAS Modeller session has been 

started. If continuing from an existing Modeller session select the menu command File> 

New to start a new model file. Modeller will prompt for any unsaved data and display 

the New Model dialog. 

Creating a new model 

 Enter the file name as box_section 

 Use the Default working folder. 

 Enter the title as Box Section 

 Set model units of N,mm,t,s,C 

 Leave the Timescale units as Seconds 

 Ensure an Analysis type of Structural is set. 

 Set the Startup template as None 

 Ensure the vertical axis is set to Z 

 Click the OK button. 

Discussion 

The arbitrary section property calculator within LUSAS Modeller computes the section 

properties of any open or closed section. Cross-sections are created either as a single 

regular or irregular surface, or as a group of surfaces (including holes). Fibre definitions 

(positions on the cross-section at which stresses or values can be plotted when viewing 

results) are also created for each drawn section at the time of section property 

calculation.  

Caution.  2D cross-sections for section property calculation must be defined in the 

XY plane. 


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Feature Geometry 

 Set the Files of type drop-down menu to DXF Files (*.dxf) 

 Locate the box_section.dxf file in the \<Lusas Installation 

Folder>\Examples\Modeller directory and click the Import button to read in the 

DXF file and create the cross section geometry as shown below. 

Defining holes within a section 

This is done by first defining a 

surface that represents the total 

extent of the box-section, then 

defining a surface that represents 

the void or hole, and then selecting 

both the surrounding and inner 

surface to create the hole in the 

bounding surface. 

 Drag a box around the 

whole model 

 

 

 Create an outer Surface from the selected Lines. 

 Now, drag a box around the 

only the lines defining the void. 

 Create an inner Surface from the 

selected Lines. 

 

 

 

 

 

 

 

File 

Import... 

Box select the whole model

 
Geometry 

Surface > 

Lines… 

Box select the lines defining the void
 

Geometry 

Surface > 

Lines… 
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 Select the outer Surface of the box-

section followed by the inner 

Surface representing the void. (Use 

the Shift key to pick the inner 

Surface to add it to the initial  

selection) 

 

 

 

 

 On the Create Holes dialog, ensure the 

option Delete geometry defining holes 

is selected. 

A new singular Surface will be created, 

containing a void. This can be seen by 

clicking inside the outer perimeter of the box section and seeing that all lines are 

selected. 

 Save the cross-section model for any future modifications or for use with the 

definition of any additional fibre locations. 

The section properties can now be calculated as follows: 

 

 

 

 

 

 

 

 

Select these two surfaces

1

2

 

Geometry 

Surface > 

Holes > 

Create 

 

File 

Save... 
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Calculating Section Properties 

Select the Add to local library option. 

 Click the Apply button, and after a short wait the calculated section properties will 

be displayed in the grid at the top of the dialog. 

 

 Click Cancel to close the dialog. 

Note. There is no need to compute the section properties in the units they are to be 

used in the analysis model because units conversion is carried out when the section 

properties are extracted from the section library if it is found to be required.  

Note. Section properties may be added to local (user) or server (all users) section 

property libraries by selecting the appropriate option(s) prior to selecting the Apply 

button. Alternatively you can deselect the ‘Recompute section properties’ option after 

selecting the ‘Add local library’ or ‘Add server library’ options. By default the model 

name is entered as the Section Name. This can be modified if required. 

Utilities 

Section Property 
Calculator > 

Arbitrary 
Section… 
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Notes on the automatic meshing used 

The mesh used to compute the properties of each of the surfaces (and the holes) is 

displayed in the graphics window. Centroid, Shear Centre and Plastic Neutral Axis 

symbols and locations are also shown. 

 

By default an element size is selected which will assign 15 elements to the longest side 

and a minimum of 2 elements is applied to the shorter sides. This mesh may be adjusted 

by deselecting the automatic mesh check box and changing the mesh size in the  

Treeview. Alternatively, the maximum element on the longest side may be adjusted by 

changing the ‘Max elements/line’ option as required prior to selecting the Apply button. 

As with all finite element models the more elements used the more accurate the results 

but the slower the calculation. A good compromise of 2 elements across all thin 

sections has been found to provide reasonable results without using excessive 

computation time. 

Viewing and using sections in the user library 

 Create a new model called Test and select units of N,mm,t,s,C from the drop 

down list provided. Click OK. 

 Select User Sections from the top-right drop-down on the dialog 

 Browse for, and select the box_section name. The basic section will be visualised. 

 Select the Visualise button and the fibre definitions will be seen. Click Close 

File 

New… 

Attributes 

Geometric > 

Section library… 
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Visualisation of local library item Visualisation of fibre locations 

 

Fibre locations can be used to calculate beam stress results for plotting force and 

moment diagrams. LUSAS automatically creates one for every extreme point on a 

section. 

 On the Geometric Line dialog, select the 

Enter Properties option then press the 

Section Details button. 

 Select the Fibre locations tab.  

 Additional fibre locations can be added 

manually to the library item by clicking in 

the Fibre locations area and pressing the 

TAB key until a new line is created, and 

then entering the coordinate of the fibre 

location required. 

 Press OK to save changes and return to the 

Geometric Line dialog. 

 

 



Arbitrary Section Property Calculation and Use 

 52 

Tip. If additional fibre locations are required on the section use Modeller to obtain the 

properties of any additional points on the saved model and enter the point coordinates 

in the manner described above. Note that if invalid coordinates are used the fibre 

location will be added to the nearest point on the outer perimeter of the section. 

Finally, to add the local library section to the Attributes  Treeview (for subsequent 

assignment to selected lines representing beams in the model) press the OK button. 

 

This completes the example. 
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Contact Analysis of 

a Lug 

For software product(s):  All (except LT versions) for the first stage of the example 

Any Plus version for the second stage of the example. 

With product option(s): Nonlinear (for the second part of the example) 

Note: Stage 2 of the example exceeds the limits of the LUSAS Teaching and Training 

Version. 

Description : Linear Analysis 

A large lug is 

supported at its left-

hand edge and 

subjected to a 

prescribed pressure 

load around the 

inside of the hole, 

modelling a loaded 

pin. 

The lug is 0.546 m 

thick and made of 

steel with a Young's 

modulus of 210E9 N/m
2
, a Poisson's ratio of 0.3 and a mass density of 7800kg/m3.  

This is a two stage example. A linear static analysis is carried out initially and the 

material properties and loading are then modified to investigate the response of the lug 

using a nonlinear analysis.  

Units used are N, m, kg, s, C throughout. 

 

1.5 1.0

0.75

0.75

R = 0.5

Loading
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Objectives 

The output required from the linear analysis consists of: 

 Deformation Plot  A plot of the undeformed and deformed mesh. 

 Contour Plot  A Von Mises stress plot. 

 Principal Stress Vectors  A plot of principal stress vectors. 

 Fatigue Damage  A plot of the fatigue damage when the component is 

subjected to a prescribed loading sequence. 

 Cycles to Failure  A contour plot of the number of cycles to failure for the 

area around the hole. 
 

Keywords 

2D, Default Assignments, Linear, Slideline, Nonlinear, Contact, Fatigue, Damage, 

Cycles to Failure, Stress Contours, Displacement Results, Animation, Graph 

Plotting. 

Associated Files 

 lug_linear_modelling.vbs carries out the modelling for the linear 

analysis. 

 lug_nonlinear_modelling.vbs carries out the modelling for the 

nonlinear contact analysis. 

Stage 1. Linear Analysis 

An initial linear investigation is performed to verify the model. An assessment of 

potential damage and a calculation of the cycles to failure is performed.   

Stage 2. Nonlinear Analysis 

Material properties on the linear model are then modified to investigate the response of 

the lug using a nonlinear analysis. The pressure loading is removed and an additional 

pin of 0.9m diameter is defined. Slidelines are defined on the surfaces that will come 

into contact and the pin is then subjected to a prescribed concentrated loading and 

moved into contact with the lug.  
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Stage 1 : Modelling : Linear Analysis 

Running LUSAS Modeller 

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller 

in the Examples Manual Introduction. 

Note. This example is written assuming a new LUSAS Modeller session has been 

started. If continuing from an existing Modeller session select the menu command 

File>New to start a new model file. Modeller will prompt for any unsaved data and 

display the New Model dialog. 

Creating a new model 

 Enter the file name as lug_linear 

 Use the Default working folder. 

 Enter the title as Fixing Lug (Linear analysis) 

 Set the model units to N,m,kg,s,C 

 Ensure the timescale units are Seconds 

 Ensure an analysis type of Structural is set. 

 Select the startup template Standard 

 Specify the vertical axis in the Y direction. 

 Click the OK button. 

Note. Save the model regularly as the example progresses. Use the Undo button to 

correct any mistakes made since the last save was done. 

Default Attribute Assignments 

The material properties of the lug, its element type and thickness are uniform over the 

model. Default attribute assignments can therefore be used, meaning that any material, 

mesh or geometry attribute defined will be automatically assigned to any features that 

are subsequently generated. 

Default Element Selection 

The lug is a relatively thin structure and all deformations take place in the plane of the 

structure therefore plane stress continuum elements will be used. 


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 Select Plane stress, Quadrilateral, Quadratic elements. Ensure the Regular mesh 

option is selected with Automatic mesh divisions so that LUSAS uses the default 

number of mesh divisions on each line.. Name the attribute QPM8 (after the 

element type) and Click OK 

Modeller will add the QPM8 attribute to the  Treeview. 

 To make this attribute the default for all subsequent geometry, click the right-hand 

mouse button on the mesh attribute QPM8 in the  Treeview and select the Set 

Default option. 

The selected attribute will be highlighted to signify that it has been set as the default for 

all subsequent features. 

Default Geometric Properties 

 Click in the thickness value area and press the  button to open the Unit 

Convertor and Variation Utility. 

 Change the units to mm in the drop-down menu and enter a value of 546. Press OK 

to convert the 546mm into model units and populate the thickness value. 

 No eccentricity needs to be entered. 

 Enter the attribute name as Lug Thickness 0.546 and click OK. 

 To make this attribute the default for all subsequent geometry click the right-hand 

mouse button on the geometry attribute name in the  Treeview and select the Set 

Default option. 

Default Material Properties 

 Select material Mild Steel of type Ungraded from the drop-down lists and click 

OK to add the material attribute to the  Treeview. 

 To make the mild steel material attribute the default for all subsequent geometry 

click the right-hand mouse button on the Iso1 (Mild Steel Ungraded) material 

attribute name in the  Treeview and select the Set Default option. 

Defining the Geometry 

Use will be made of the symmetry of the lug by defining the top half and then mirroring 

it to form the whole structure. In this problem the centre of the hole will be taken as the 

origin (0,0,0). 

 

Attributes 

Mesh > 

Surface… 

Attributes 

Geometric > 

Surface... 

Attributes 

Material > 

Material Library… 
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 Define a Surface by specifying the coordinates of its 

vertices using the following values (-2.5, 0), (-1, 0), (-1, 

0.75) and (-2.5, 0.75). 

 Select the fleshing on/off button to turn-off 

geometric property visualisation. 

Note. Whenever a Surface is created the corresponding Surface mesh will be 

displayed.  

For clarity the diagrams accompanying this example will not generally show the mesh.  

At any time the mesh can be turned on or off by right-clicking on the Mesh entry in the 

 Treeview and selecting the On/Off menu item. 

 Define a Line by 

specifying the coordinates of 

either end as (0.5, 0) and 

(0.75, 0). 

The resulting features should 

be as shown. 

Note. LUSAS will automatically generate any necessary lower order features when 

higher order features are defined. 

New Surfaces will be created by sweeping the Line just drawn through a positive 

(anti-clockwise) angle about the centre of the hole.  

 Select the new Line. 

 Rotate the Line 

through an angle of 45 

degrees about the Z-axis 

and an origin of (0,0,0) to 

sweep through a Minor 

arc to create the surface. 

 Enter the attribute 

name as Rotate 45 

Degrees so that it can 

be re-used.  

 Click on the Save button to save the attribute information and click the OK button 

to finish. 

Geometry 

Surface > 

Coordinates… 
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Geometry 

Line > 

Coordinates… 
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Geometry 

Surface > 

By Sweeping… 

Select this Line to

form first Surface

Copy this Surface to form next Surface
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LUSAS will create a new Surface from the selected Line. This will now be copied to 

create the adjoining surface. 

 Select the Surface just created. 

 On the Copy dialog, select the Rotate 45 degrees attribute from the drop-down list 

to use the values defined. 

Click the OK button to create the new Surface.  

The arc forming the Surface of the hole is to be extended. 

 First, select the Point, 

as shown.  

 Select the Rotate 

45 degrees attribute 

from the drop-down list 

to use the values defined.  

 Click the OK button 

to create the new arc. 

 Secondly, select the 

Point at the end of the new arc and repeat the previous process to draw a second arc.  

 Thirdly, drag a box around the two unconnected Points at the top of the model. 

 Select the new Line button to create the connecting Line. 

Two new Surfaces will now be formed by joining existing opposite Lines. 

 Select the first two 

Lines required in the 

order shown. Use the 

Shift key to add to 

the initial selection. 

 Use the joining 

function, to create a 

surface between the 

specified lines. 

 Repeat for the 

remaining two Lines as shown. 

The top half of the lug is now complete. 

Geometry 

Surface > 

Copy... 

Geometry 

Line > 

Arc/Circle > 

By Sweeping 
Points… 

1. Select this Point

to create first arc.

3. Drag a box to

select these 2 Points

2. Select this Point to

create second arc.
 

1. Select this Line

2. Select this Line

3. Select

menu option

4. Select

this Line

5. Select this Line

6. Select menu option
 

Geometry 

Surface > 

By Joining... 
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Mirroring the Lug 

The bottom half of the lug is to be formed by mirroring the top half. 

 Select 2 Points on the 

centreline. 

The points are stored in 

memory. 

 Drag a box around 

the whole of the top half of the lug or use the Ctrl + A keys together to select the 

whole model. 

 Select the Mirror – from Point 1 and Point 2 from the drop down list and click 

the Use button to use the mirror transformation defined. Click the OK button to finish. 

The surfaces will be copied and mirrored. 

The points are cleared from selection memory. 

 

Note. As a consequence of mirroring the Surfaces, the orientation of the Surfaces in 

the top half of the model will be opposite to the orientation of the Surfaces in the 

bottom half of the model. The orientation of the Surfaces must therefore be checked.  

Aligning Surface axes 

To ensure the loading directions are consistent the element axes should be aligned. The 

element axes follow the direction of the surface they are generated from. These may 

vary depending upon how your surfaces were created. 

 In the  Treeview right click on 

Geometry and select Properties 

 On the properties dialog select the 

Surface axes button and click OK to 

display the surface axes. 

The axes of all surfaces can be aligned to 

axes of the first surface in the selection 

using the cycle relative facility. 

 Select the top left-hand surface. 

 Hold the Shift key and box-select the whole model to add the remaining surfaces to 

the selection. 

Select these 2 Points

to define mirror plane

 

Edit 

Selection Memory > 

Set 

Geometry 

Surface > 

Copy... 

Edit 

Selection Memory > 

Clear 
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The axes of all surfaces will be aligned 

to the axes of the first element selected. 

 In the  Treeview right click on 

Geometry and select Properties 

 On the properties dialog deselect the 

Surface axes button and click OK to 

remove the surface axes from the 

display. 

Supports  

When using the Standard template, LUSAS provides the more common types of 

support by default. These can be seen in the  Treeview.  

 Drag a box around the 2 

vertical Lines on the left of 

the model.  

 Drag the support attribute 

Fixed in XY from the  

Treeview and drop onto the 

selected Lines in the 

graphics window.  

 Choose options to Assign to 

lines for All analysis 

loadcases and click OK to finish assigning the support attribute. 

The supports will be visualised as arrows at the supported nodes in the directions of the 

restraints. 

Loading 

In this linear analysis, pin loading is to be approximated by defining a face load of a 

value equivalent to the full load that will be applied during the nonlinear analysis. The 

face load will be assigned to the 2 Lines defining the lower side of the hole. 

Note. Face loads are applied in local element directions, hence a load in the Y 

direction will act in a radial direction. 

 Select the Face option and click Next 

 Click in the Component > y Direction cell and press the  button to open the Unit 

Convertor and Variation Utility. 

Geometry 

Surface > 

Cycle Relative 

 

Drag a box to select these 2 Lines
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Loading… 
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 Input a load value of 10 N/mm
2
 and press OK to convert the face load to model 

units and populate the grid. 

 Enter the attribute name as Face Load and click Finish to add the attribute to the 

 Treeview. 

 Select the 2 arcs forming the 

lower side of the hole, then 

drag and drop the Face Load 

attribute from the  Treeview 

onto the selected features.  

 Ensure that only the Assign to 

Lines and Single loadcase 

options are selected. The press 

OK to assign the load to that 

Analysis 1 and Loadcase 1  

 If not already displayed, turn on the display of the mesh. 

Saving the model 

 Save the model file. 

 

Running the Analysis : Linear Analysis 

 Open the Solve Now diloag and press OK to run the analysis. 

A LUSAS Datafile will be created from the model information. The LUSAS Solver 

uses this datafile to perform the analysis. 

If the analysis is successful... 

Analysis loadcase results are added to the  Treeview.  

In addition, 2 files will be created in the Associated Model Data directory where the 

model file resides: 

 lug_linear.out this output file contains details of model data, assigned 

attributes and selected statistics of the analysis. 

 lug_linear.mys this is the LUSAS results file which is loaded automatically 

into the  Treeview to allow results processing to take place. 
 

Select these 2 Lines
 

File 

Save 
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If the analysis fails... 

If the analysis fails, information relating to the nature of the error encountered can be 

written to an output file in addition to the text output window.  Any errors listed in the 

text output window should be corrected in LUSAS Modeller before saving the model 

and re-running the analysis.  

Rebuilding a Model  

If it proves impossible for you to correct the errors reported a file is provided to enable 

you to re-create the model from scratch and run an analysis successfully.  

 lug_linear_modelling.vbs carries out the modelling of the example.  
 
 

 

 Start a new model file. If an existing model is open Modeller will prompt for 

unsaved data to be saved before opening the new file. 

 Enter the file name as lug_linear 

To recreate the model, select the file lug_linear_modelling.vbs located in the 

\<LUSAS Installation Folder>\Examples\Modeller
 
directory. 

 

 Rerun the analysis to generate the results. 

 

Viewing the Results : Linear Analysis 

Analysis loadcase results are present in the  Treeview and the loadcase results for the 

last solved loadcase (Loadcase 1) are set to be active by default. 

For clarity, the lug geometry will be removed from the display to leave only the 

undeformed mesh displayed. 

 If present, turn off the display of the Mesh, Geometry and Attributes layers from 

the  Treeview. 
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File 

New… 

File 

Script > 

Run Script... 
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Using Page Layout Mode 

The model was created using a Working Mode view which allows a model of any size 

to be created. Results could be viewed using this mode of operation, but, in order to 

allow additional information to be added without obscuring the model, Page Layout 

Mode can be used instead. 

The Graphics window will resize to show the mesh layer on an A4 size piece of paper. 

 

 Ensure that the Landscape option is selected, ensure that page margins of 

60,10,10,10 are set for left, right, top and bottom margins respectively and click OK 

This page layout view can also be saved for subsequent re-use with other models. 

 Enter the view name as Landscape Page Layout and click OK 

Deformed Mesh Plot 

If not already visible, switch the Deformed mesh layer on. 

 With no features selected click the right-hand mouse button in a blank part of the 

Graphics window and select the Deformed mesh option to add the deformed mesh 

layer to the  Treeview. 

 Click on the OK button to accept the default properties and display the deformed 

mesh. 

Von Mises Stress Contours 

 With no features selected click the right-hand mouse button in a blank part of the 

graphics window and select the Contours option to add the contours layer to the  

Treeview. 

The contour layer properties will be displayed. 

View 

Page Layout Mode 

File 

Page Setup... 

Window 

Save View... 
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 Select Stress - Plane Stress contour results of equivalent stresses SE 

 Click the OK button to display the contours and annotated contour summary.  

Note. The order of the layer names in the  Treeview determines the order in which 

the layers will be displayed in the graphics window. To ensure a particular layer is 

displayed after another layer, click on the layer name to be moved in the  Treeview 

and drag the layer name onto the layer name after which it is to be displayed. The 

display in the graphics window will be updated accordingly. 

 Move the Deformed mesh layer to 

follow the Contours layer in the  

Treeview as described in the previous 

note. 

 

Marking Peak Values 

 With no features selected click the right-hand mouse button in a blank part of the 

Graphics window and select the Values option to add the values layer to the  

Treeview. 

The values properties will be displayed. 

 Select Stress - Plane Stress contour 

results of Equivalent stresses SE 

 Select the Values Display tab and set 

Maxima values to display the top 1% 

of results on the Deformed shape.  

 Click the OK button to redisplay the 

contours with the peak value marked. 

Principal Stress Vectors 

 Turn off the Contours and Values layers in the  Treeview. 

 With no features selected, click the right-hand mouse button in a blank part of the 

Graphics window and select the Vectors option to add the vectors layer to the  

Treeview. 

The vector layer properties will be displayed. 
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 Select Stress - Plane Stress vector 

results.  

 Click the OK button to display 

vectors with tension vectors 

displayed in red and compression 

vectors displayed in blue. Note that 

the length of a vector can be  

controlled by a scale setting on the 

vector layer properties dialog. 

 Turn off the Vectors layer in the  Treeview.  

Defining a Fatigue Spectrum 

 Ensure Analysis 1 is selected 

from the drop-down list.  

 Select Loadcase 1  

 Click the ‘Add to’ button 

to include Loadcase 1 in the 

fatigue load spectra calculation.  

 Click on Loadcase 1 in the 

Included panel of the dialog 

and enter the number of Cycles 

as 10000 

 Leave the name as Fatigue 1 

and select Sabs from the component drop-down list. 

 Select the S N Curve tab and enter the values as shown in the 

adjacent table. 

 Click the OK button to finish. 

 In the  Treeview right-click on the loadcase Fatigue 1 and 

select the Set Active option.  

Contouring Damage 

Contouring damage must be done on an undeformed mesh view. 

 Turn off the Deformed mesh layer in the  Treeview. 

 Turn on the Mesh layer in the  Treeview.  

 

Analyses 

Fatigue… 

 

Log 

Stress/ 

Strain 

Log 

Cycle 

4.7323 15 

9.7323 0 
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 Turn on the Contours layer in the  Treeview.  

The contour plot properties will be 

displayed. 

 Select Stress - Plane Stress and 

ensure contour results of Damage 

are selected. 

 Select the Contour Display tab and 

ensure the Contour key option is 

selected. 

 Click the OK button to display contours of damage and a contour summary. 

 Move the Mesh layer to follow the Contours layer in the  Treeview so the mesh 

is visible on top of the contour display. 

Contouring Cycles to Failure 

Modeller can calculate the number of repeats of a given loading sequence to failure. An 

extra fatigue spectrum will be created containing only a single loading cycle. 

 Ensure Analysis 1 is selected from the drop-down list.  

 Select Loadcase 1  

 Click the ‘Add to’ button to include Loadcase 1 in the fatigue load spectra 

calculation.  

 Leave the name as Fatigue 2 and select Sabs from the component drop-down list. 

 Select the S N Curve tab and enter the values as shown in 

the table. 

 Click the OK button to finish. 

In the  Treeview right-click on the loadcase Fatigue 2 and 

select the Set Active option. 

 In the  Treeview double-click on the Contours layer.  

The contour plot properties will be displayed. 

 Select entity Stress - Plane Stress contour results of component Log-Life 

 Click the OK button to display contours of log life. 

 

Analyses 

Fatigue… 

Log 

Stress/ 

Strain 

Log 

Cycle 

4.7323 15 

9.7323 0 
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Note. As an alternative to having to enter S N Curve data again for this second 

loadcase, double-clicking on loadcase Fatigue 1 and changing the loadcase name to 

Fatigue 2 and setting the number of Cycles to 1 would achieve the same result.  

Changing the levels 

The contours of log-life will be easier to 

understand if the contour levels are 

adjusted so that they are plotted in unit 

(1.0) increments, representing 10 to the 

power of 0 cycles to failure.  

 In the  Treeview, double-click on 

the Contours layer name and select the Contour Range tab. 

 Set the Contour range to show a contour Interval of 1. Ensure the Value to pass 

through is set to 0 

 Click the OK button to display 

contours of Log Life and a contour 

summary using the increments 

specified. 

A maximum value of 14.78 should be 

obtained for the log-life. 

 

This completes the linear analysis section of the example. 

Note. Saving the model file now will also save the fatigue loadcases. 
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Stage 2 : Nonlinear Contact 

For software product(s):  Any Plus version. 

With product option(s): Nonlinear. 

Note: Stage 2 of the example exceeds the limits of the LUSAS Teaching and Training 

Version. 

Description : Nonlinear Analysis 

This part of the example 

extends the previously defined 

lug model used for the linear 

analysis.  

The pressure loading is 

removed and an additional pin 

of 0.9m diameter is defined. 

Slidelines are defined on the 

surfaces that will come into 

contact and the pin is then subjected to a prescribed concentrated loading and moved 

into contact with the lug.  

A schematic of the lug and pin geometry is shown. 

The units of the analysis are N, m, kg, s, C throughout. 

Objectives 

The output required from the analysis is as follows: 

 Equivalent Stress Contours A plot of the stress in the lug only. 

 Graph of Displacement against Applied Load A graph of the 

resultant displacement at a selected node. 
 

Stage 2 : Modelling : Nonlinear Analysis 

If the linear analysis was successful: 

 If the previous linear analysis was performed successfully open the model file 

lug_linear.mdl saved after completing the first part of this example and select No to 

not load a results file of the same name on top of this model. 

 Enter the model file name as lug_nonlinear and click the Save button. 

 

File 

Open... 

File 

Save As... 
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Creating a suitable model from a supplied file 

If the linear analysis was not successful a file is provided to enable you to re-create the 

model for use in this part of the example. 

 Start a new model file. If an existing model is open Modeller will prompt for 

unsaved data to be saved before opening the new file. 

 Enter the file name as lug_nonlinear_modelling 

To recreate the model, select the file lug_linear_modelling.vbs located in the 

\<LUSAS Installation Folder>\Examples\Modeller
 
directory. 

 

 

Changing the model description 

 Change the model title to Fixing Lug - Nonlinear Contact Analysis and click OK 

 If present, turn off the Contours, Mesh and Annotation layers in the  Treeview. 

 Turn on the Geometry layer. 

 In the  Treeview expand Analysis 1 and ensure Loadcase 1 is set active. 

Defining the Lug 

For clarity the diagrams accompanying this example will not generally show the mesh.   

 Drag a box around the whole of the model (or use the Ctrl + A keys) to select the 

whole model. 

 Select the group button to create a group.  

 Enter the name Lug and click OK to finish creating the group and add it to the 

Treeview. 

File 

New… 

File 

Script > 

Run Script... 

File 

Model Properties… 
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Defining the Pin 

 Select the Line on the lug shown. 

Take care to not include any other 

features. 

 Select the Scale option and enter 

a scale factor of 0.9 

 Click the OK button to create the 

arc. 

 Enter coordinates of (0, 0) to 

define a point at the origin and click OK 

 Select the Line just created and 

holding the Shift key down, also 

select the point at the origin. 

 A new Surface will be created. 

The other surfaces of the pin will be 

created shortly.  

 

 

Modifying the Line mesh divisions 

The total number of mesh divisions on the Pin is to be reduced and modified.  

 Turn on the Mesh layer. 

Select this Line

 

Geometry 

Line > 

Copy... 

Geometry 

Point > 

Coordinates... 

1. Select this Line

2. Press Shift key

3. Select this Point

 

Geometry 

Surface > 

By joining... 
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 Select the arc on the initial segment of the pin. 

 Drag and drop the Line mesh attribute 

Divisions=2 from the  Treeview onto the 

selected Line. 

 With the Element description set as None, enter 

the number of divisions as 2 

 Click the Spacing button, select a Uniform 

transition ratio of last to first element of 0.333 

and click OK to return to the mesh dialog. 

 Enter the attribute name as Divisions=2(3:1) 

and click OK 

LUSAS will add the attribute name to the  Treeview. 

 Select the 2 straight Lines on the first surface of the Pin.  

 Drag and drop the Line mesh attribute Divisions=2(3:1) from the  Treeview 

onto the selected features. 

Note. The last/first element spacing ratio depends upon the direction of the Line on 

which it is assigned. If the mesh is finer at the centre of the Pin than at the edge then 

reverse the line(s) by first selecting with the mouse and using the menu command 

Geometry>Line>Reverse 

The remainder of the Pin is to be generated by copying the initial segment of the Pin. 

 Select the Surface defining one-eighth of the Pin. 

 From the drop-down list, select the attribute Rotate by 45 degrees 

 Set the number of copies to 7 

 Click the OK button to create the new Surfaces forming the entire pin.  

Assign

'Divisions=2' to

this Line

Assign Line mesh

'Divisions=2(3:1)'

to these 2 Lines
 

Attributes 

Mesh > 

Line… 



Geometry 

Surface > 

Copy… 
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Using Groups 

To allow easy selection of the features defining the 

pin, the group named Lug is to be hidden. 

 In the  Treeview right-click on the group name 

Lug and select the Invisible option to leave just 

the Surfaces representing the pin displayed. 

 Drag a box around the features defining the pin 

(or use the Ctrl + A keys). 

 Select the group button to create a group.  

 Enter the name Pin and click OK to finish creating the group and add it to the 

Treeview. 

Geometric properties of the pin 

 Enter the thickness as 10 and the attribute name as Pin Thickness 10. Click OK 

 Box-select the Pin in the Graphics Area and drag and drop this geometric dataset 

from the  Treeview onto the selected features. 

Redisplay the lug 

In the  Treeview right-click on the group name Lug and select the Visible option to 

re-display the lug. 

 If not already displayed, display the mesh layer.  

Modifying the mesh 

If quadratic elements are used for slideline models, constraints are automatically 

introduced to make the contact face perform as a linear element. It is therefore 

recommended that linear, rather than quadratic, elements be used. 

 In the  Treeview double-click 

on the QPM8 attribute name. 

 Change the interpolation order 

to Linear and click OK to 

overwrite the previous mesh 

details 

 

Attributes 

Geometric > 

Surface... 
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The mesh should match as shown.  

Slidelines 

Slidelines define the contacting Surfaces of the model. They are used in pairs (a master 

and a slave) and define opposing contacting Surfaces. They are assigned to Lines for 

2D analyses and to Surfaces for 3D analyses. In this analysis, the master and slave 

slides are assigned to selected internal Lines of the Lug and selected external Lines of 

the Pin. 

 Ensure that the Close Contact parameter is set to 0.1 and leave the remaining 

values as their default settings. 

 Enter the attribute name as Lug_Pin and click OK 

 Select the 4 internal 

lower arcs of the Lug. 

 Drag and drop the 

slideline attribute 

Lug_Pin from the  

Treeview onto the 

selected features, 

setting this slideline to 

be the Master. Leave 

the orientation as 

Default and click OK 

 Select the 4 lower arcs of the Pin. 

 Drag and drop the slideline attribute Lug_Pin from the  Treeview onto the 

selected features, setting this slideline to be the Slave and click OK 

 To visualise the 

slidelines assigned to the 

model click the 

right-hand mouse button 

on the slideline attribute 

name in the  Treeview 

and select Visualise 

Master Assignments 

and Visualise Slave 

Assignments 

 After visualising, de-select the visualisation of both sets of slidelines. 

Attributes 

Slideline... 

Select these 4 Lines for Master slideline

Select these 4 Lines for Slave slideline
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Supports and Loads 

The loading from the first part of this example is to be removed and will be replaced by 

a concentrated load. The supports will remain unaltered. 

 In the  Treeview click the right-hand mouse button on the loading attribute Face 

load. Select the Deassign > From all option. 

 With the Concentrated option selected click Next 

 Input a load in the Y direction of -2e8. 

 Enter the load attribute name as Concentrated Load and click the Finish button. 

 Select the Point at the centre of the Pin. 

 Drag and drop the loading attribute Concentrated Load from the  Treeview 

onto the selected point, ensuring that it is applied as Loadcase 1 

Preventing features from merging together 

Now that the modelling is complete the pin can be moved into contact with the lug. 

This could be done by entering a known dimension, or, as shown in this example, by 

selecting the Points to be brought into contact. To prevent the features in the pin 

merging with those on the lug when the pin is moved into contact the points in the pin 

are set as unmergable. 

 Select all the features in the pin by right-clicking Pin in the  Treeview and 

picking the Select Members option. 

This ensures the points in the pin are not merged with those in the lug. 

Moving the Pin to touch the Lug 

 Select the lowest Point 

on the Pin. Hover over 

the point and make a 

note the Point number 

shown. 

 Holding the Shift key 

down, select the Point 

immediately beneath it 

on the hole of the Lug. 

Hover over the point 

and make a note the Point number shown. 

Attributes 

Loading... 

Geometry 

Point > 

Make 
Unmergable 

2. Select this Point

1. Select this Point
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 Click the right-hand mouse button and select the Selection Memory>Set option.  

 In the  Treeview right-click on the group name Pin and select the Select 

members option to highlight all features representing the pin. Click OK to deslect 

the previously selected Points. 

 Select the Translation – from Point 45 to point 30 transformation (or the one 

that relates to your selected points) from the drop down menu and click the Use button 

to use the distance between the Points stored in memory as the move distance. Click the 

OK button to finish. 

The pin will be moved to rest against the lug at the starting point of the analysis. 

Nonlinear Analysis Control 

Nonlinear analysis control properties are defined as properties of a load case.  

 In the  Treeview right-click on Loadcase 1 and select the Nonlinear and 

Transient option from the Controls menu.  

The Nonlinear & Transient dialog will appear:  

 Select Nonlinear 

incrementation with 

Automatic control.  

 Enter the Starting load 

factor as 0.001 

 Enter the Max change 

in load factor as 0.5 

 Enter the Max total 

load factor as 2 

 Ensure that Adjust load 

based on convergence 

is selected. 

 Enter the number of 

Iterations per 

increment as 6 

 Enter the Maximum time steps or increments as 100 

 Click the OK button to finish. 

Geometry 

Point > 

Move… 
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Note. A nonlinear contact analysis performs best when a small amount of load (0.001 

of the load in this example) is applied to the model initially. Thereafter, once the results 

for a load increment have been obtained the load factor for the next increment is 

automatically adjusted by LUSAS based upon the number of iterations taken for the 

previous load increment to converge. After a number of such iterations the loading will 

be progressively applied to the model until the total load factor is reached. 

Saving the model 

The model is now complete and the model data is to be saved before an analysis is run 

using the LUSAS Solver.  

 To save the model. 

 

Running the Analysis : Nonlinear Analysis 

 Open the Solve Now dialog. Press OK to run the analysis. 

 If the non-linear model includes the Fatigue loading from the linear model, a 

prompt will appear asking to renaming the loadcases. Press OK.  

During the analysis 2 files will be created: 

 lug_nonlinear.out  this contains the statistics of the analysis, for example 

how much disk space was used, how much CPU time was used, and any errors 

or warning messages from LUSAS, and so on. Always check the LUSAS output 

file for error messages. 

 lug_nonlinear.mys  this is the LUSAS results database which will be used 

for results processing. 
 

If the analysis is successful... 

Analysis loadcase results are added to the  Treeview.  

If the analysis fails... 

In the event of the analysis failing due to errors in the model that you cannot correct, a 

file is provided to re-create all modelling features and attributes to allow the analysis to 

be run successfully. 

 lug_nonlinear_modelling.vbs  carries out the modelling of the example.  

 



File 

Save 
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 Start a new model file. If an existing model is open Modeller will prompt for 

unsaved data to be saved before opening the new file. 

 Enter the file name as lug_nonlinear 

To recreate the model, select the file lug_nonlinear_modelling.vbs located in the 

\<LUSAS Installation Folder>\Examples\Modeller
 
directory. 

 

 Rerun the analysis to generate the results. 

Viewing the Results : Nonlinear Analysis 

Analysis loadcase results are present in the  Treeview and the load case results for 

the last solved loadcase (Increment 19 Load Factor = 2.0) are set to be active by 

default. 

Making the Pin invisible 

Note. When a results file is loaded on top of a corresponding model file groups of 

features can be made visible or invisible. This is of particular use when results are to be 

displayed only on selected parts of the model. In this example, results are only to be 

viewed on the Lug. 

 In the  Treeview right-click on the group name Lug and select the Set as Only 

Visible option. 

Deformed Mesh Plot 

With Increment 19 Load Factor = 2.0 in the  Treeview Set Active 

 Turn off the Geometry, Mesh and Attributes layers in the  Treeview. 

 Turn on the Deformed mesh layer in the  Treeview. 

The deformed mesh plot will be displayed. 

 

 

 

 

 

File 

New… 

File 

Script > 

Run Script... 
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Equivalent Stress Contour Plots 

 Add (if necessary) or turn-on the Contours layer in the  Treeview. 

The contour properties will be 

displayed. 

 Select Stress - Plane 

Stress contour results of 

Equivalent stresses SE 

 Select the Contour Range 

tab and set the Number 

option to 9. (Leave the 

value to pass through set to 

0).  

 Click the OK button to display contours and a contour summary for the final load 

increment. 

 Change the layer display order to display the Deformed mesh on top of the 

Contours by selecting Deformed Mesh in the  Treeview with the right-hand 

mouse button and selecting the Move Down option. 

The contour plot for the final increment will be displayed. 

Creating Animations 

As an alternative to viewing results individually for each load case, the change of stress 

due to the increasing load increments can be animated instead. To ensure consistent 

contour values throughout the animation the range of contours is to be specified. 

For the final load increment the contour key shows a maximum stress in the order of 

7E9. To create contours of 5E8 intervals the contour interval needs to be set. 

 In the  Treeview double-click on Contours. The contour layer properties will be 

displayed. 

 Select the Contour Range tab and click the Interval button. Set the contour 

interval as 5E8. Click the Set as global range button and ensure that the Use 

global range button is also selected.  

 Click the OK button to finish. 

Note. When animating nonlinear loadcases it is important that the deformed mesh is 

plotted using a factor of 1 and not using a fixed screen size otherwise the deformed 

mesh for each load increment would be drawn the same. With this in mind: 
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 In the  Treeview double-click on the Deformed mesh layer, select the Specify 

Factor option, enter a factor to 1 and click OK 

 Select the Load 

history option and 

click the Next 

button.  

 Select Analysis 1 

from the drop-down 

menu. The list of 

available load cases 

for selection will 

appear. Select the 

All loadcases button 

and the Finish 

button to create an 

animation for all 

loadcases and 

display the animation. 

Note. The buttons at the bottom of the window may be used to slow-down, speed-up, 

pause, step through frame by frame, or stop the animation. 

Saving Animations 

Animations may be saved for replay in other standard windows animation players. 

 Ensure the animation window is the active window. 

 Enter lug_nonlinear for the animation file name. An .avi file extension is 

automatically appended to the file name when the file is saved. 

 Click OK to save. 

 Delete the animation window and maximise the graphics window. 

 Turn off the display of the Annotation layer in the  Treeview. 

Creating Graphs 

Any set of results may be graphed against any other set of results. For example, a graph 

of resultant displacement for the node at the bottom of the hole of the lug is to be 

plotted against the load increment.  

Utilities 

Animation Wizard... 
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File 

Save As AVI... 
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 Select the node defining the 

bottom of the hole in the 

lug.  

The graph wizard provides a 

step-by-step means of selecting 

which results are to be plotted 

on the X and Y axes of the 

graph. The X axis is always 

defined first. 

 Ensure the Time history 

option is selected and click the Next button. 

 Ensure the Nodal results button is selected and click the Next button. 

 Select Displacement results for resultant displacement RSLT. The node number of 

the previously selected node will be shown in the Specify node pull-down. Click 

the Next button. 

The X axis results have been selected. The Y axis results to be graphed are now 

defined. 

 Select Named results and click the Next button. 

 Select Total Load Factor data. Click the Next button. 

Title information for the graph can be added at this stage. 

 Leave all title information blank.  

 Click the Finish button 

A graph is created in a new window with 

the values used shown in an adjacent 

table.  

 To see the graph at the best 

resolution enlarge the window to a full 

size view. 

Note. The graph shows a linear 

displacement history for the node. This is because no geometric nonlinearity has been 

allowed for in the analysis. 

 Close the graph using the  in the top right-hand corner of the graph window.  

Select this Node
 

Utilities 

Graph Wizard... 
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Slideline Results 

Results can be presented on the contact surfaces as vectors or values, or as a graph on 

any specified load increment.  

 Turn off the Contours and Deformed mesh layers in the  Treeview. 

 Turn on the Mesh layer in the  Treeview. 

 In the  Treeview select the slideline results group on which the results are to be 

displayed by right-clicking on the group Lug_Pin (master) and selecting the Set 

as Only Visible option. Click Yes to act on sub groups. 

 In the  Treeview ensure that the last load increment showing Load Factor = 

2.00000 is active. 

 With no features selected, click the right-hand mouse button in a blank part of the 

graphics window and select the Values entry. 

 In the properties box, select the Entity Slideline Results and the Type ContPress 

to look at results of Contact Pressure. 

 Select the Values Display tab and de-select Symbols, ensure both Maxima and 

Minima are selected, set the range to 100 % and change the number of significant 

figures to 4. Click the OK button. 

 

To plot a graph of the contact pressure distribution around the contact surface: 

 Choose the Slidelines (assigned to lines) option and click Next 

 Select the Component ContPress 

 To plot the results against angle rather than length select the Calculate distance as 

angle option.  

Utilities 

Graph Wizard... 
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 Click Next followed by Finish 

 

Note. The graph properties and titles may be modified using the right-hand mouse 

button in the graph window if required. 

 

This completes the nonlinear analysis part of the example. 
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Linear Buckling 

Analysis of a Flat 

Plate 

For software product(s):  Any Plus version. 

With product option(s): None. 

Description 

This example determines 

the critical buckling load 

for a 2m x 0.5m 

rectangular panel of 1mm 

thickness subject to 

in-plane compressive 

loading.  

Material properties for 

the panel are: Young's 

modulus 70E9 N/m2, 

Poisson's ratio 0.3. 

The panel is meshed 

using 64 Semiloof shell elements and is simply supported on all sides. An in-plane 

compressive load of a total of 24N is applied to one of the short edges, parallel to the 

long sides. 

Units used are N, m, kg, s, C  throughout. 

Keywords 

2D, Plate, Linear Buckling, Eigenvalue Buckling, Deformed Mesh, Printing 
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Associated Files 

 plate_modelling.vbs  carries out the modelling of the example. 
 
 

Modelling 

Running LUSAS Modeller 

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller 

in the Examples Manual Introduction. 

Note. This example is written assuming a new LUSAS Modeller session has been 

started. If continuing from an existing Modeller session select the menu command 

File>New to start a new model file. Modeller will prompt for any unsaved data and 

display the New Model dialog. 

Creating a new model 

 Enter the file name as plate 

 Use the Default working folder. 

 Enter the title as Buckling of a flat plate 

 Set the model units to N,m,kg,s,C 

 Ensure that timescale units are Seconds  

 Ensure an analysis type of Structural is set. 

 Select the model template Standard 

 Select the Vertical Z axis option.  

 Click the OK button. 

Note. Save the model regularly as the example progresses. Use the Undo button to 

correct any mistakes made since the last save was done. 

 

 

 




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Feature Geometry 

 Enter  coordinates of (0, 

0), (2, 0), (2, 0.5) and (0, 

0.5) to define a Surface. 

 Click the OK button. 

Meshing 

 Select Thin shell, Quadrilateral, elements with Quadratic interpolation.  

 Enter the attribute name as Thin Shell. 

 Click the OK button.  

LUSAS will add the mesh dataset to the  Treeview. 

 Select the Surface of the 

plate. 

 Drag and drop the 

Surface mesh attribute 

Thin Shell from the  

Treeview onto the 

selected feature. 

Note. If the number of divisions is not specified on the mesh dialog the default 

number of 4 divisions per Line will be used. In this example 4 divisions per Line is 

sufficient for the ends of the plate but 16 divisions are required on each of the sides. 

 In the  Treeview double-click on the Line mesh Divisions=8 

 On the Line Mesh dialog change the number of line divisions to 16, change the 

Attribute name to Divisions=16 and click the OK button. 

 Select the two long sides 

of the plate and drag and 

drop the Line mesh 

attribute Divisions=16 

from the  Treeview 

onto the selected features. 

 

Geometry 

Surface > 

Coordinates... 

 

Attributes 

Mesh > 

Surface… 
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Geometric Properties 

 Specify a thickness of 0.001. 

 Enter the attribute name as Plate Thickness 

(The eccentricity can be left blank, as it is not used in this analysis). 

 Click the OK button to add the attribute to the  Treeview. 

 With the Surface selected, drag and drop the geometry attribute Plate Thickness 

from the  Treeview onto the selected feature. 

Assigned geometric attributes are visualised by default.  

 Select the fleshing on/off button to turn-off geometric property visualisation. 

Material Properties 

 Specify the Young's modulus as 70E9 

 Enter Poisson's ratio as 0.3 

(Mass density can be left unspecified for Eigenvalue buckling analyses). 

 Enter the attribute name as Plate Material 

 Click the OK button to add the attribute to the  Treeview. 

 With the Surface selected, drag and drop the material attribute Plate Material from 

the  Treeview onto the selected surface. 

Supports 

With the standard template, LUSAS provides the more common types of support by 

default. These can be seen in the  Treeview.  Four support datasets are to be assigned 

to selected features of the model. 

Attributes 

Geometric > 

Surface... 

Attributes 

Material > 

Isotropic… 
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 Select the top line, hold 

the Shift key, and select 

the left and bottom 

Lines as shown.  

 Drag and drop the 

Fixed in Z support 

attribute from the  

Treeview onto the 

selected Lines.  

 Ensure that the supports 

are assigned to Lines for All loadcases and click the OK button. 

 Similarly for each of the other features shown above drag and drop the relevant 

support attributes from the  Treeview to assign the required supports. 

 Use the Isometric 

button to rotate the model to 

this view.  

 Check the position and 

type of supports on the 

model match those 

above 

 

 

Loading 

A global distributed load is to be applied to the left-hand end of the plate. 

Point 'Fully Fixed'
Points 'Fixed in YZ'

Line 'Fixed in XZ'Lines 'Fixed in Z'
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 Select the Global 

Distributed option and 

click Next 

 Enter a Total load of 24 

in the X direction. 

 Enter the attribute name 

as Distributed Load. 

 Click the Finish button. 

 Select the left hand edge 

of the plate and drag and 

drop the loading dataset Distributed Load from the  Treeview onto the selected 

Line.  

 Click OK to assign the load to Loadcase 1  

Eigenvalue Analysis Control 

Eigenvalue analysis control is defined as a loadcase property. 

 In the  Treeview expand Analysis 1 then right-click on Loadcase 1 and select 

Eigenvalue from the Controls menu. 

 Select a Buckling Load 

solution for the Minimum 

number of eigenvalues. 

 Enter the Number of 

eigenvalues required as 3 

 Enter the Shift to be applied 

as 0 

 Click the OK button to 

select the Default eigensolver.  

Saving the model 

 Save the model file. 

 

Attributes 

Loading... 

 

 

File 

Save 
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Running the Analysis 

 Open the Solve Now dialog and press OK to run the analysis. 

A LUSAS Datafile will be created from the model information. The LUSAS Solver 

uses this datafile to perform the analysis. 

If the analysis is successful... 

Eigenvalue results loadcases will be seen in the  Treeview.  

In addition, 2 files will be created in the Associated Model Data directory where the 

model file resides: 

 plate.out  this output file contains details of model data, assigned attributes 

and selected statistics of the analysis. 

 plate.mys  this is the LUSAS results file which is loaded automatically into 

the Treeview to allow results processing to take place. 
 

If the analysis fails... 

If the analysis fails, information relating to the nature of the error encountered can be 

written to an output file in addition to the text output window.  Select No to not view 

the output file.  Any errors listed in the text output window should be corrected in 

LUSAS Modeller before saving the model and re-running the analysis.  

Rebuilding a Model  

If it proves impossible for you to correct the errors reported a command file is provided 

to enable you to re-create the model from scratch and run an analysis successfully. 

 plate_modelling.vbs  carries out the modelling of the example. 
 
 

 Start a new model file. If an existing model is open Modeller will prompt for 

unsaved data to be saved before opening the new file. 

 Enter the file name as plate 

 To recreate the model, select the file plate_modelling.vbs located in the \<LUSAS 

Installation Folder>\Examples\Modeller
 
directory. 

 

 Rerun the analysis to generate the results. 





File 

New… 

File 

Script > 

Run Script... 
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Viewing the Results 

Loadcase results for each eigenvalue can be seen in the  Treeview. For eigenvalue 

analyses the first loadcase is set to be active by default. 

 Turn off the Mesh, Geometry and Attributes layers in the  Treeview. 

Deformed Mesh Plot 

 In the  Treeview press the 

Deformations... button and 

ensure that specify 

magnitude is selected with a 

value of 6. 

 Use the Dynamic Rotation 

button to ensure that the model 

is rotated to a similar view to 

that shown. 

 

 Return to normal cursor mode 

Changing the Results Loadcase 

To view the second eigenmode: 

 In the  Treeview right-click on Eigenvalue 2 and select the Set Active option. 

The second eigenmode shape 

will be displayed. 

 

The third eigenmode can be 

viewed in a similar manner. 

Note. Mode shapes may be 

the opposite to those shown. 

 

Printing the Buckling Load Factors 

In an eigenvalue buckling analysis, the load factors are equivalent to the eigenvalues.  

Load factors are the values by which the applied load is factored to cause buckling in 
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the respective modes. Eigenvalue results for the whole model can be displayed in the 

text window. 

 Select Active and press Next. 

 Select the entity None and ensure that results type Eigenvalues is selected and 

click the Finish button. 

The Eigenvalue results will be printed to the text window with the Load factors being 

given in the eigenvalue results column. 

 

Note that error norms may vary from those shown. 

Calculating the Critical Buckling Load 

The applied load (24N) must be multiplied by the first load factor (19.0779) to give the 

value of loading which causes buckling in the first mode shape. The initial buckling 

load is therefore 24x19.0779 = 457.87 N.  

Note. An applied load of unity could be used in an eigenvalue analysis - in which case 

the eigenvalues produced would also represent the critical loads at which the structure 

would buckle. However, to prevent potential convergence problems with the analysis it 

is more usual to apply actual in-service loading and multiply the applied load by the 

eigenvalue to give the critical buckling load for each eigenvalue. 

 

This completes the example. 

 

 

 

 

 

 

Utilities 

Print results  wizard... 
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Elasto-Plastic 

Analysis of a V-

Notch 

For software product(s):  All (except LT versions) for the first stage of the example 

Any Plus version for the second stage of the example. 

With product option(s): Nonlinear (for the second stage of the examples) 

Note: Stages 3 and 4 of the example exceed the limits of the LUSAS Teaching and 

Training Version. 

Description 

A 5mm thick V-shaped, 

notched specimen is to 

be subjected to two load 

types; a pressure load 

distributed along the 

inner edge of its opening 

and a loading caused by 

pushing a bolt into the 

notch of the specimen. 

After an initial linear 

analysis with the specimen subjected to the pressure load, nonlinear material properties 

are defined and a nonlinear analysis is carried out using the same pressure loading.  

An additional linear and nonlinear analysis is done to investigate the insertion of a bolt 

into the notch of the specimen with slidelines being used to model the contact behaviour 

between the two components. Because of symmetry only half of the V-notch need be 

modelled. 

Units are N, mm, t, s, C throughout. 

90

40

30

Radius 10

10

All dimensions in mm

Centreline
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Objectives 

 Initial Yield  Investigate the load which causes initial yielding. 

 Spread of Yield  Under continued loading investigate the progression of 

plastic deformation under pressure loading. 

 Ultimate Capacity (Pressure)  Investigate the ultimate capacity of the 

specimen under pressure loading. 

 Transfer of Force from Bolt  Investigate the transfer of forces from the 

loading bolt from a preliminary linear contact and subsequent nonlinear contact 

analysis. 
 

Keywords 

Plane Stress, Contact, Geometrically Nonlinear (GNL), Materially Nonlinear 

(MNL), Contour Plot, Elasto-Plastic, Yield, Yield Symbol, Plastic Strain, 

Animation 

Associated Files 

 vnotch_linear_modelling.vbs carries out the modelling for the linear 

notch analysis.  

 vnotch_nonlinear_modelling.vbs carries out the modelling of the 

nonlinear material model.  

 vnotch_linear_contact_modelling.vbs carries out the modelling of 

the specimen using a linear analysis and a geometrically nonlinear model. 

 vnotch_nonlinear_contact_modelling.vbs carries out the modelling 

of the notch and bolt with nonlinear material properties.  

Discussion 

The response of this component is dominated by materially nonlinear effects. After an 

initially elastic response, the material undergoes elastic-plastic yielding. In a simple von 

Mises model the tensile and compressive stress regions are considered to cause 

identical plasticity. The post-yield response is governed by the hardening slope. A zero 

slope denotes elastic-perfectly plastic behaviour. 

Stage 1. Linear Material Analysis 

An initial linear investigation is performed to verify the model and to find the maximum 

stress induced by a unit intensity load. This information is used to design the 

incrementation strategy for the initial coarse nonlinear analysis. 


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Stage 2. Nonlinear Material Analysis 

The material nonlinearity is specified in LUSAS by the addition of plastic material 

properties and a hardening curve. 

The nonlinear strategy is designed such that the first increment (arrived at from the 

linear analysis) stresses the material to just below yield in a single step. The model is 

loaded until a specified displacement is reached at a selected Point. The incrementation 

strategy is designed to develop the yielded region in a gradual and stable manner. 

Stage 3. Contact Analysis with Linear Materials 

Once the behaviour of the structure is understood under pressure-loaded conditions, the 

pressure load is removed. A bolt is added to the model and slidelines are defined to 

model the contact between the notch and the bolt. 

Stage 4. Contact Analysis with Nonlinear Materials 

Once the behaviour of the multiple-bodied structure is understood the nonlinear 

materials in the specimen are re-introduced and a full geometric, nonlinear contact 

analysis performed. 

Stage 1 : Modelling : Linear Material 

This worked example will create a LUSAS model of half of the notched V-specimen. 

Initially, a linear elastic analysis with an applied unit structural face load will be 

prepared. Then the material properties will be made nonlinear and a suitable analysis 

control defined and assigned. 

Running LUSAS Modeller 

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller 

in the Examples Manual Introduction. 

Note. This example is written assuming a new LUSAS Modeller session has been 

started. If continuing from an existing Modeller session select the menu command 

File>New to start a new model file. Modeller will prompt for any unsaved data and 

display the New Model dialog. 

Creating a new model 

 Enter the file name as vnotch_linear 

 Use the Default working folder. 

 Enter the title as V-Notch - Linear Analysis 


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 Select model units of N,mm,t,s,C 

 Select timescale units as Seconds 

 Ensure the analysis type is Structural 

 Select the model template Standard 

 Select the Vertical Y axis option and click OK 

Note. Save the model regularly as the example progresses. Use the Undo button to 

correct any mistakes made since the last save was done. 

Feature Geometry 

 Select the 3 Columns grid style. 

Using the X and Y coordinates shown in the table define 

Points which mark out half of the model. Use the Tab key 

to move to the next entry field. Use the arrow keys to 

move around fields. 

 Click the OK button to finish. 

Note.  The Z coordinate does not have to be entered. A dimension of zero will be 

assumed. 

The V shaped notch will be 

created using an arc and a 

Line drawn tangential to the 

arc. 

 Select the Point shown 

to generate the arc.  

 Rotate the Point 

through an angle of  

-120 degrees about an origin of (40,0,0).  Click the OK button to finish. 

 



Geometry 

Line > 

Coordinates... 

X Y 

90 20 

90 30 

0 30 

0 0 

30 0 



Select this Point

 Geometry 

Line > 

Arc/Circle > 

By Sweeping 
Points… 
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 Select the Point shown 

and add the Arc to the 

selection by holding 

down the Shift key. 

 

 With Multiple straight 

line tangents selected, 

ensure that Split tangent lines and Delete geometry on splitting are also selected 

on the Straight Line Tangent dialog.  

 Click OK to draw the Line representing the notch. 

The model can now be tidied by deleting the redundant Lines and Points.  

 Drag a box to select the 

features shown. 

 Delete the selected 

features, confirming that 

Lines and Points are to be 

deleted.  

 

Note. The Points and Lines used to define features extending outside of the area 

selected will not be deleted. 

Finally, a Surface is to be created from the line features. 

 Select the whole model 

using the Ctrl + A keys 

together. 

 Create a General 

Surface from the selected 

Lines. 

Meshing 

 Define Plane stress, Triangle, Quadratic elements with an Irregular mesh 

spacing. Ensure that a specified element size is not selected. 

 Enter the mesh attribute name as Plane Stress TPM6 and click OK 

LUSAS will add the mesh attribute to the  Treeview. 

Select this Line

Select this Point

 
Geometry 

Line > 

Tangent > 

Point to Line 

Drag a box to select these features
 



 

Geometry 

Surface > 

Lines... 

Attributes 

Mesh > 

Surface… 
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 Select the newly created 

surface using the Ctrl 

and A keys together.  

 Drag and drop the 

Surface mesh attribute 

Plane Stress TPM6 from 

the  Treeview onto the 

selected features. Click OK to complete the mesh assignment. 

Note.  When selecting lines to create a surface, and creating the surface the selection 

viewed on the screen will still be only the lines and not the new surface. It is for this 

reason that the whole model (and hence the surface) must be selected again using the 

Ctrl + A keys as described above. 

Note.  TPM6 elements are low-order elements and are used in this example to keep 

within the evaluation version limits. More accurate modelling is obtained when using 

Plane Stress, Quadrilateral, Quadratic elements (QPM8) which have more nodes per 

element. 

LUSAS will mesh the Surface based upon a default Line division of 4. To improve the 

shape and arrangement of elements, a Line mesh attribute will be used to control the 

Surface mesh density.  

 With the Structural element type set as None, define an average Element length of 

5 mm. Enter the Line mesh attribute name as Element Length 5 and click OK 

 With the whole model 

selected, drag and drop 

the Line mesh attribute 

Element Length 5 from 

the  Treeview onto the 

selected features. 

 

Local mesh refinement will now be applied by giving the Arc a finer Line mesh. 

 Double-click on the Line mesh attribute Element Length 5 from the  Treeview 

to re-open the Line Mesh dialog and use the attribute as a template. 

 Change the average Element length to 2.5 mm. 

 Enter the Line mesh attribute name as Element Length 2.5 and click OK to create a 

new attribute. 

 





Attributes 

Mesh > 

Line... 
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 Select the arc 

 Drag and drop the Line 

mesh attribute Element 

Length 2.5 from the  

Treeview onto the selected 

Line. 

The mesh will be refined as shown. 

Geometric Properties 

 Define a geometric property attribute with a thickness of 5 mm.  

 Enter the attribute name as Thickness=5 and click OK to add the attribute to the  

Treeview. 

 With the whole model selected, drag and drop the geometry attribute Thickness=5 

from the  Treeview onto the selected features. 

 Select the fleshing on/off button to turn-off the automatic geometric property 

visualisation. 

Material Properties 

The only material properties that are essential for a linear elastic static analysis are 

Young's modulus and Poisson's Ratio. The units of Young's modulus in this particular 

example are N/mm2.  

 Enter a Young's modulus of 210e3 and a Poisson's Ratio of 0.3. Leave the other 

fields blank.  

 Enter the attribute name as Steel (N mm)and click OK to add the attribute to the  

Treeview. 

 With the whole model selected, drag and drop the material attribute Steel (N mm) 

from the  Treeview onto the selected features and click OK to assign to surfaces. 

Support Conditions 

When using the Standard template, LUSAS provides the more common types of 

support by default. These can be seen in the  Treeview. The specimen is to be 

restrained along the horizontal axis of symmetry in the X and Y axes. 

 

Attributes 

Geometric > 

Surface… 

Attributes 

Material > 

Isotropic… 
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 Select the horizontal 

Line along the axis of 

symmetry. 

 Drag and drop the 

support attribute Fixed 

in XY from the  

Treeview onto the 

selected Line and click 

OK to assign to lines. 

Loading 

A unit pressure load is to be defined and applied to the edge of the Surface  

 Select the Face option and click Next 

 Define a face load in the y direction of 1 

 Enter the attribute name as Face Load 1 and click Finish 

Note. Face loads are pressure loads which can be applied to the edges of Surfaces or 

the faces of Volumes. 

 Select the angled Line 

of the notch. 

 Drag and drop the 

loading attribute Face 

Load 1 from the  

Treeview onto the 

selected Line and click 

OK to assigned to 

Lines. 

Note. Structural face loading uses local element directions. If the loading is 

incorrectly oriented it may be due to the local element direction of the Surface. To 

rectify this either reverse the element direction of the Surface by selecting the Surface 

using Geometry> Surface> Reverse or double-click on the loading attribute name in 

the  Treeview and change the sign of the loading. 

Saving the model 

 Save the model file.  

 

Select this Line
 

Attributes 

Loading… 



 



File 

Save 
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Running the Analysis : Linear Material 

 Open the Solve Now dialog and press OK to run the analysis. 

A LUSAS Datafile will be created from the model information. The LUSAS Solver 

uses this datafile to perform the analysis. 

If the analysis is successful... 

Analysis loadcase results are added to the  Treeview  

In addition, 2 files will be created in the Associated Model Data directory where the 

model file resides: 

 vnotch_linear.out  this output file contains details of model data, assigned 

attributes and selected statistics of the analysis. 

 vnotch_linear.mys  this is the LUSAS results file which is loaded 

automatically into the  Treeview to allow results processing to take place. 
 

If the analysis fails... 

If the analysis fails, information relating to the nature of the error encountered can be 

written to an output file in addition to the text output window.  Any errors listed in the 

text output window should be corrected in LUSAS Modeller before saving the model 

and re-running the analysis.  

Rebuilding a Model  

If it proves impossible for you to correct the errors reported a file is provided to enable 

you to re-create the model from scratch and run an analysis successfully.  

 vnotch_linear_modelling.vbs carries out the modelling of the example. 
 
 

 Start a new model file. If an existing model is open Modeller will prompt for 

unsaved data to be saved before opening the new file. 

 Enter the file name as vnotch_linear 

To recreate the model, select the file vnotch_linear_modelling.vbs located in the 

\<LUSAS Installation Folder>\Examples\Modeller
 
directory. 

 

 

 Rerun the analysis to generate the results 





File 

New… 

File 

Script > 

Run Script... 
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Viewing the Results : Linear Material 

Analysis loadcase results are present in the  Treeview. 

Deformed Mesh Plot 

Once the linear version of the model has been run it is prudent to check the deformed 

shape for obvious errors such as overlarge displacements in unexpected areas, which 

could be accounted for by incorrect properties, incorrect positioning of the load or 

incorrect support conditions. The deformed shape also provides a general check on the 

overall load direction.  

 If present in the  Treeview turn off the Mesh, Geometry and Attributes layers 

by right-clicking on a layer name and selecting the On/Off menu item.. 

 The Deformed 

mesh layer 

should be visible 

by default. If not, 

with no features 

selected, click 

the right-hand 

mouse button in 

a blank part of 

the Graphics 

window and 

select the Deformed mesh option to add the deformed mesh layer to the  

Treeview. 

 Click the OK button to display the deformed mesh plot.  

Von Mises Stress Contours 

The linear elastic results provide an opportunity to establish a faster loading scheme for 

the nonlinear analysis to come. Checking the maximum von Mises stress values will 

allow calculation of a factor of load that can be sustained without yielding the material.  

 With no features selected click the right-hand mouse button in a blank part of the 

Graphics window and select the Contours option to add the contour layer to the  

Treeview. 
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 Select entity Stress - Plane 

Stress and component 

equivalent stress SE 

 Click the OK button to 

display the contours. 

 

Changing the layer 

display order 

Note. The order of the layer names in the  Treeview determines the order in which 

the layers will be displayed. To make a layer display after another layer, click on the 

layer name in the  Treeview and drag the layer name onto the layer name after which 

it is to be displayed. The display in the graphics window will be updated accordingly. 

 Following the note above make the deformed mesh display after the contours by 

dragging the Deformed Mesh layer onto Contours layer in the  Treeview. 

Note. The material chosen for the analysis is assumed to yield at 300 N/mm2. From 

the contour key results the maximum stress induced from a unit face load results in a 

stress of just over 30 N/mm2. Therefore, a factored load value of 9 would be suitable 

for use as the first load increment level in the nonlinear analysis as this would result in 

stresses just below the yield stress. 

This completes the linear analysis stage of the example. 

 




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Stage 2 : Modelling : Nonlinear Material 

For software product(s):  Any Plus version. 

With product option(s): Nonlinear. 

 

Files. The geometry of the notch is the same as that defined for the linear model. It 

may be recovered by one of two methods; either by loading the previously created 

model file, and by creating the initial model from a supplied file as described below. 

 If the previous linear analysis was performed successfully open the model file 

vnotch_linear.mdl which was saved after completing the first part of this example and 

select No to not load a results file of the same name on top of this model. 

 Enter the model file name as vnotch_nonlinear and click the Save button. 

Creating the initial model from a supplied file 

 Alternatively, start a new model file. If an existing model is open Modeller will 

prompt for unsaved data to be saved before opening the new file. 

 Enter the file name as vnotch_nonlinear 

To create the model, select the file vnotch_linear_modelling.vbs located in the 

\<LUSAS Installation Folder>\Examples\Modeller
 
directory. 

 

 

Change the model description 

Change the model description to V-Notch - Nonlinear Analysis and click OK 

Modifying the Material 

The linear material dataset needs to be modified to include plastic properties. 

 In the  Treeview double-click on the material attribute Steel (N mm) 

 Select the Plastic check box and for a Stress potential model enter an Initial 

uniaxial yield stress of 300 

  Select the Hardening check box, select the Hardening gradient option and enter a 

Slope of 0 and a Plastic strain of 1000 in the first row of the table. 

 Click the OK button to finish and overwrite the existing material dataset. 

File 

Open... 

File 

Save As... 

File 

New… 

File 

Script > 

Run Script... 

File 

Model Properties… 
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Note. The von Mises material model used assumes identical behaviour in 

compression and tension. 

Nonlinear Analysis Control 

From the results of the Linear analysis, initial yielding is expected at a load factor of 

nearly 10 (Yield Stress/Max Stress). Therefore the nonlinear loading strategy will be to 

apply an initial load factor of 9, and use unit factor increments as the yielding 

progresses. The analysis will be set to stop once the Point at the inside end of the arm of 

the notch has displaced 10mm from its original position. 

 Ensure that the geometry layer is present in the  Treeview and turned On. 

 Select the Point at 

the end of the notch 

as shown.  

Note. The number of 

the Point selected will be 

displayed in the status 

bar at the bottom of the 

graphics window. 

Nonlinear analysis control options are defined as properties of a loadcase. 

 In the  Treeview expand Analysis 1 then right-click on Loadcase 1 and select 

Nonlinear and Transient from the Controls menu. 

The Nonlinear & Transient 

dialog will appear.  

 Select the Nonlinear option. 

 From the Incrementation 

drop down list select 

Automatic control.  

 Set the Starting load factor 

as 9 

 Set the Max change in load 

factor as 1 

 Set the Max total load 

factor as 0 to enable the load 

to increase without limit. 



Select this Point

 



 



Elasto-Plastic Analysis of a V-Notch 

 106 

To terminate the load on a limiting variable the advanced nonlinear parameters need to 

be set in the Incrementation section. 

 Select the 

Incrementation 

Advanced button.  

 Click the Terminate on 

value of limiting 

variable option. 

 Set the Point number 

from the drop-down list 

to the Point selected 

earlier. 

 Set the Variable type in the drop down list as V to limit the displacement in the 

local Y direction. 

 Set the Value as 10 

 Ensure the Allow step reduction option is ticked. 

 Click the OK button to return to the load case dialog. 

 Click the OK button to finish. 

Save the model 

 To save the model. 

 

Note Geometric stiffening is not considered in this example because the nonlinear 

effects are predominantly due to yield in the material. 

 

Running the Analysis : Nonlinear Material 

 Open the Solve Now dialog and press OK to run the analysis. 

A LUSAS Datafile will be created from the model information. The LUSAS Solver 

uses this datafile to perform the analysis. 

 

File 

Save 
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During the analysis… 

Apart from the increment and iteration, several parameters output are of special interest 

during the nonlinear analysis phase: 

 TLMDA  (Total Load Factor)  The factor of load applied using the 

incrementation control is displayed here. It shows how the load application is 

progressing for a load control and an arc-length solution. 

 DTNRM (Displacement Norm)  The changes in this value indicate how 

well the problem is converging. 

If the analysis is successful... 

Analysis loadcase results are added to the  Treeview  

In addition, 2 files will be created in the Associated Model Data directory where the 

model file resides: 

 vnotch_nonlinear.out  this output file contains details of model data, 

assigned attributes and selected statistics of the analysis. 

 vnotch_nonlinear.mys  this is the LUSAS results file which is loaded 

automatically into the  Treeview to allow results processing to take place. 
 

If the analysis fails... 

If errors are listed that for some reason you cannot correct, a file is provided to re-

create the model information correctly, allowing a subsequent analysis to be run 

successfully. 

 vnotch_nonlinear_modelling.vbs carries out the complete nonlinear 

material modelling of the example.  
 
 

 Start a new model file. If an existing model is open Modeller will prompt for 

unsaved data to be saved before opening the new file. 

 Enter the file name as vnotch_nonlinear 

To re-create the model, select the file vnotch_nonlinear_modelling.vbs located in the 

\<LUSAS Installation Folder>\Examples\Modeller
 
directory. 

 

 

 Rerun the analysis to generate the results 





File 

New… 

File 

Script > 

Run Script... 
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Viewing the Results : Nonlinear Material 

This section covers a typical results processing session for a nonlinear analysis. In this 

session the following procedures will be carried out: 

 A von Mises stress contour plot and associated yielded region plot will be 

drawn. 

 A graph showing the displacement history of the notch opening through the 

analysis will be created. 
  

Plotting Stress Contours 

Analysis loadcase results are present in the  Treeview, and for a nonlinear analysis 

the load case results for the largest loading increment will be set active by default. 

 In the  Treeview, right-click on the first load increment Increment 1 Load 

Factor = 9 and select the Set Active option. 

 In the  Treeview ensure that the Contours and Mesh layers are present and are 

turned On, and that Geometry and Deformed Mesh are turned Off. 

 Double click on the Contours entry to show its property dialog and select entity 

Stress - Plane Stress and component equivalent stress SE  

 Click the Contour Range tab and set the Maximum stress contour value to be 

plotted as 300 so all stresses above yield are drawn in red. 

 Click the OK button to display contours for the first load increment. 

 Select OK to accept 

the default properties 

and add the mesh to 

the display. 

 

 

 

The display will show that the yield stress of 300Nmm
-2

 has not been reached after the 

first loading increment.  

 



Viewing the Results : Nonlinear Material 

 109 

Changing the Active Results Loadcase 

 In the  Treeview, 

right-click on the 

last load increment 

and select the Set 

Active option. 

Contours for the 

selected increment will 

be displayed. The red 

area shows the peak von Mises stress which is being limited to 300 N/mm2 by the zero 

hardening slope as defined in the plastic material properties section for the model.  

Yielded Material Plot 

In addition to using contours to show yielded regions of the model, the spread of 

plasticity can be visualised using yield symbols.  

 With no features selected click the right hand mouse button in a blank part of the 

graphics window and select the Values layer. 

 Select the Stress - 

Plane Stress entity 

and Yield 

component and 

click the OK 

button to display 

the yielded Gauss 

points with an 

asterisk. 

Note. By changing the active loadcase the spread of yield through the model can be 

viewed. 

 

 


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Displacement History Graph 

To illustrate the nonlinear behaviour of the model a displacement history graph showing 

the displacement of a node on the notch against the total applied load factor is to be 

displayed. 

 Select the node on 

the end of the 

notch as shown. 

 

 

 

 

The graph wizard provides a step-by-step means of selecting which results are to be 

plotted on the X and Y axes of the graph. The X axis is always defined first. 

 Ensure the Time history option is selected and click the Next button. 

 Ensure the Nodal results button is selected for the X axis results and click the Next 

button. 

 Select Displacement from the entity drop down list for the component DY. The 

node number of the selected node will be shown. Click the Next button. 

This defines the X axis results.  

 Select Named results and click the Next button. 

 From the drop down list select Total Load Factor data and click the Next button. 

Select this Node

 

Utilities 

Graph Wizard… 
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This defines the Y axis 

results.  

 Leave all title and axis 

fields blank and click 

the Finish button to 

create the graph in a 

new window and 

display the values used 

in an adjacent table. 

 To see the graph 

at the best resolution 

enlarge the window to a full 

size view. 

 

Note. The graph shows the progressive softening of the structural response as the load 

is increased. The load value corresponding to the flat section represents the limit of the 

load carrying capacity of the model.  

 Delete the graph window. 

Stage 3: Modelling : Contact Analysis (Linear Material) 

For software product(s):  Any Plus version. 

With product option(s): Nonlinear. 

Note: The stage of the example exceeds the limits of the LUSAS Teaching and 

Training Version. 

 

This section details the changes required to the linear material model from the first part 

of the example to incorporate the geometry of a bolt which will be positioned and 

loaded to prise the notch arms apart. A nonlinear analysis is required because of the 

presence of slidelines and the boundary conditions used. 

 If the initial linear analysis was performed successfully open the model file 

vnotch_linear.mdl saved after completing the first part of this example and select No 

to not load a results file of the same name on top of this model. 

 Enter the model file name as vnotch_contact and click the Save button. 

 

 



File 

Open... 

File 

Save As... 
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Creating the starting model from a supplied file 

 Alternatively, start a new model file. If an existing model is open Modeller will 

prompt for unsaved data to be saved before opening the new file. 

 Enter the file name as vnotch_linear_contact 

To create the model, select the file vnotch_linear_modelling.vbs located in the 

\<LUSAS Installation Folder>\Examples\Modeller
 
directory. 

 

 Change the model description to V-Notch - Contact Analysis (Linear Material) 

and click OK 

 In the  Treeview ensure that the Geometry, Mesh and Attributes layers are 

present and are turned On. 

Deassigning the Loading 

The initial pressure loading is no longer required. In the nonlinear contact model the 

loading will be applied as a prescribed displacement to the centre-line of the bolt. 

 In the  Treeview click the right hand mouse button on the loading attribute Face 

Load 1 and select the Deassign > From all option. 

Modelling the Bolt 

Note.  At this stage the bolt will be defined separated from the notch specimen. This 

will make assigning the attributes, especially the slidelines, easier. Once the attributes 

are assigned, the bolt will be moved to its starting position before the analysis is run. 

 Enter coordinates of (75,0), (90,0) and (105,0) and click OK to define 2 horizontal 

Lines on the bolt centreline. 

 Enter coordinates of (90,0) and (90,15) and click OK to define a vertical Line on 

the bolt centreline. 

File 

New… 

File 

Script > 

Run Script... 

File 

Model Properties… 



Geometry 

Line > 

Coordinates... 
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An arc is to be drawn to 

form the upper half of the 

bolt. 

 Select the 3 Points in 

the order shown. 

 Click OK to accept 

the values present on 

the dialog and the arc 

will be drawn. 

 

This arc will now be split into 2 new arcs. 

 Select the arc just drawn 

 Enter the number of divisions as 2 

 Click OK to create 2 arcs and delete the original arc. 

Surfaces will now be defined on the bolt. 

 Select the left hand arc 

and then the 2 Lines as 

shown. 

 The left hand Surface 

of the bolt will be drawn. 

 Select the right-hand 

arc and then the other 2 

Lines to create the 

Surface for the other half of the bolt. 

 The right-hand Surface of the bolt will be drawn. 

Meshing the Bolt 

 In the  Treeview double-click on the mesh attribute Plane Stress TPM6 

 Change the element shape to Quadrilateral, select Regular Mesh, and change the 

attribute name to Plane Stress Quads.  

 Click the OK button to create a new mesh dataset in the  Treeview. 

1. Select

this Point

2. Select this Point

3. Select this Point
 

Geometry 

Line > 

Arc/Circle 

From 
Coords/Points
… 

Geometry 

Line > 

By splitting > 

In Equal 
Divisions… 

1. Select this Arc

2. Select

this Line

3. Select this Line
 

Geometry 

Surface > 

Lines… 

Geometry 

Surface > 

Lines… 
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 Select both Surfaces 

defining the bolt and 

drag and drop the 

surface mesh dataset 

Plane Stress Quads 

from the  Treeview 

onto the selected 

features. 

Modifying the mesh on the bolt 

 Select the 2 arcs at 

the top of the bolt as 

shown. 

 Drag and drop the 

line mesh attribute 

Divisions=6 from the 

 Treeview onto 

the selected Lines. 

The mesh will be 

redrawn as shown. 

Geometric Properties 

 In the  Treeview double click on the geometry attribute Thickness=5 

 Change the thickness to 10 and change the attribute name to Thickness=10 

 Click the OK button to create a new geometric mesh attribute in the  Treeview. 

 Select both Surfaces of the bolt and drag and drop the geometry attribute 

Thickness=10 from the  Treeview onto the selected features. 

Material Properties 

 With the bolt selected, drag and drop the material attribute Steel (N mm) from the 

 Treeview onto the selected features.  

Note. At this stage the material model is linear elastic and does not include plasticity 

effects. The addition of plasticity is included at the next stage of the example. 

Select these

2 Surfaces

 

Select these 2 Lines for 'Divisions = 6'

 


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Support Conditions 

A roller support is required at the bolt centreline to restrain in the Y direction only.  

 Select the 2 horizontal 

Lines on the bolt 

centreline. 

 Drag and drop the 

support attribute Fixed 

in Y from the  

Treeview onto the 

selected lines. 

 Click OK to assign the support dataset to the selected Lines. 

Loading Conditions 

An incremental prescribed displacement will be used. At this stage a negative unit 

displacement will be applied. The magnitude of each increment is controlled later using 

nonlinear control parameters. 

 Select the Prescribed Displacement option and click Next 

 Select the Incremental button and enter a prescribed displacement in the X 

direction of -1 

 Enter the attribute name as Prescribed Load 1 and click Finish 

 With the 2 

horizontal Lines on 

the bolt centreline 

selected, drag and 

drop the loading 

dataset Prescribed 

Load 1 from the  

Treeview onto the 

selected features. 

 Click OK to assign the loading to Loadcase 1 with a factor of 1 

Slideline Definition 

Slidelines automatically model components having dissimilar meshing patterns and can 

also model any frictional contact between interacting components. Slidelines are to be 

applied to the contacting Lines of the notch and the bolt. 

 

Attributes 

Loading… 
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 Ensure the Master Stiffness Scale and Slave Stiffness Scale values are set to 1 and 

leave the remaining values as defaults. 

 Enter the slideline attribute name as Slideline 1 and click OK to add the slideline 

attribute to the  Treeview. 

The Coulomb friction coefficient defaults to zero, which will define a standard no 

friction slideline. 

 Select the inclined 

Line of the notch. 

 Drag and drop the 

slideline attribute 

Slideline 1 from 

the  Treeview 

onto the selection.  

 Ensure the Master 

option is selected and click OK to accept the default orientation. 

 Select the left arc of the bolt. 

 Drag and drop the slideline attribute Slideline 1 from the  Treeview onto the 

selection. 

  Select the Slave option and click the OK button to accept the default orientation. 

 To visualise the 

slidelines assigned to 

the model click the 

right-hand mouse 

button on the 

slideline attribute 

name in the  

Treeview and select 

Visualise MasterAssignments and Visualise Slave Assignments 

 Repeat the process above to deselect the slideline visualisation. 

 

 

 

 

Attributes 

Slideline… 

Select this Line for the Master

Select this Line

for the Slave
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All assignments are now complete, and the bolt can be moved into a starting position 

just adjacent to the notch ready for the analysis.  

 Drag a selection box around the bolt. 

  Enter a translation of 

-24 in the X direction.  

 Leave the attribute 

name blank and click 

the OK button to move 

the bolt into position. 

 

Nonlinear Analysis Control 

A bolt displacement of 1mm is to be specified. This will be done in 10, 0.1mm 

increments using nonlinear control properties. The nonlinear analysis control 

parameters are applied as properties of the loadcase. 

 In the  Treeview expand Analysis 1 then right-click on Loadcase 1 and select 

Nonlinear and Transient from the Controls menu.  

The Nonlinear & Transient dialog will appear. 

 Set Nonlinear incrementation with Automatic control.  

 Set the Starting load factor as 0.1 

 Set the Maximum change in load factor as 0.1 

 Set the Maximum total load factor as 1 

 Deselect the option to Adjust load based upon convergence 

 Click the OK button to finish the definition of the nonlinear parameters. 

 

Running the Analysis : Contact Analysis (Linear Material) 

 Open the Solve Now dialog and press OK to run the analysis. 

A LUSAS Datafile will be created from the model information. The LUSAS Solver 

uses this datafile to perform the analysis. 

Geometry 

Point > 

Move… 

 



Elasto-Plastic Analysis of a V-Notch 

 118 

If the analysis is successful... 

Analysis loadcase results are added to the  Treeview  

In addition, 2 files will be created in the Assosiated Model Data directory where the 

model file resides: 

 vnotch_linear_contact.out  this output file contains details of model 

data, assigned attributes and selected statistics of the analysis. 

 vnotch_linear_contact.mys  this is the LUSAS results file which is 

loaded automatically into the  Treeview to allow results processing to take 

place. 
 

If the analysis fails... 

If errors are listed that for some reason you cannot correct, a file is provided to re-

create the model information correctly, allowing a subsequent analysis to be run 

successfully. 

 vnotch_linear_contact_modelling.vbs  carries out the modelling of 

the example. 
  
  

 Start a new model file. If an existing model is open Modeller will prompt for 

unsaved data to be saved before opening the new file. 

 Enter the file name as vnotch_linear_contact 

To recreate the model, select the file vnotch_linear_contact_modelling.vbs located in 

the \<LUSAS Installation Folder>\Examples\Modeller
 
directory. 

 

 

 Rerun the analysis to generate the results 

 

Viewing the Results - Contact Analysis (Linear Material) 

Analysis loadcase results are present in the  Treeview. For a nonlinear analysis the 

results for the last load increment are set to be active by default. 

Equivalent Stress Contour Plots  

 In the  Treeview, right-click on the first load increment Increment 1 Load 

Factor = 1 and select the Set Active option. 





File 

New… 

File 

Script > 

Run Script... 



Viewing the Results - Contact Analysis (Linear Material) 

 119 

 If present in the  Treeview turn off the Mesh, Geometry and Attributes layers. 

And turn on the Deformed Mesh layer. 

 Press the Deformations button in the  Treeview and select Specify factor with a 

value of 1. 

Note. When viewing results for contacting components it is important that the 

deformed mesh is plotted using a specified factor of 1 rather than a specified magnitude 

otherwise the components appear to contact incorrectly.  

 With no features selected click the right-hand mouse button in a blank part of the 

Graphics window and select the Contours option to add the contours layer to the 

 Treeview and display the contour properties. 

 On the contour properties dialog select entity Stress - Plane Stress and component 

equivalent stress SE from the contour property dialog. 

 Click the Contour range tab and set the Maximum stress contour value to be 

plotted as 300 so all stresses above yield will be drawn in red. 

 Click the OK button to display the contours and contour key for the first load 

increment. 

 In the  Treeview drag 

the Deformed Mesh layer 

onto the Contours layer. 

The contour arrangement 

shows that the first load 

increment does not induce any 

stresses in the arms of the 

notch since contact has not 

yet taken place. 

 

Changing the Active Results Loadcase 

 In the  Treeview right-click on the last load increment for load factor 1.0 and 

select the Set Active option. 


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The contour plot for the final 

increment will be displayed.  

From this stress plot where 

the bolt displacement is 1mm, 

it can be seen from the 

contour key that the material 

in the root of the notch is 

stressed to levels above the yield value of the material.  

Note. By investigating the other load increments it can be seen that after the third load 

increment the bolt begins to induce stresses in the notch and that the load is transferred 

from the bolt to the specimen via the slidelines. 

Stage 4: Modelling : Contact Analysis (Nonlinear Material) 

For software product(s):  Any Plus version. 

With product option(s): Nonlinear. 

Note: This stage of the example exceeds the limits of the LUSAS Teaching and 

Training Version. 

Creating the Model 

Files. The geometry of the notch lug is the same as that defined for the geometrically 

nonlinear contact analysis model. It may be recovered by one of two methods.  

 If the linear contact analysis was performed successfully re-open the model file 

vnotch_contact.mdl and select No to not load a results file of the same name on top of 

this model. 

 Enter a model file name of  vnotch_nonlinear_contact and click the Save button. 

Creating the starting model from a supplied file 

 Alternatively, start a new model file. If an existing model is open Modeller will 

prompt for unsaved data to be saved before opening the new file. 

 Enter the file name as vnotch_nonlinear_contact 

To create the model, select the file vnotch_linear contact.vbs located in the \<LUSAS 

Installation Folder>\Examples\Modeller
 
directory. 

 





File 

Open... 

File 

Save As... 

File 

New… 

File 

Script > 

Run Script... 
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Changing the model description 

 Change the model description to V-Notch - Contact Analysis (Nonlinear 

Material) and click OK 

 

Modifying the Geometry 

The linear material attribute needs to be modified to include plastic properties. 

 In the  Treeview double-click on the material attribute Steel (N mm) 

 Select the Plastic button and enter an Initial uniaxial yield stress of 300 

 Select the Hardening button, select the Hardening gradient button and enter a 

Slope of 0 and a Plastic strain of 1000 in the first line of the table. 

 Click the OK button to overwrite the existing material definition. 

Note. The perfectly plastic assumption is an initial simplification that would in 

practice be replaced by a more detailed description of the hardening behaviour of the 

material. This would typically involve specifying several hardening gradients (i.e 

nonlinear hardening) and the strain limits to which each slope applies. 

Nonlinear Analysis Control 

The nonlinear control properties required for this section of the analysis are already 

specified in the current model. However, the bolt displacement of 1mm is to be 

increased to 2.5mm by specifying 25, 0.1mm increments in the nonlinear section of the 

load case dialog. 

 In the  Treeview double-click on Nonlinear and Transient to edit the existing 

parameters. 

 Set the Max total load factor to 2.5 

 Click the OK button to return to the graphics window. 

Save the model 

 Save the model. 

 

File 

Model Properties… 



File 

Save 
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Running the Analysis : Contact Analysis (Nonlinear Material) 

 Open the Solve Now dialog and press OK to run the analysis. 

A LUSAS Datafile will be created from the model information. The LUSAS Solver 

uses this datafile to perform the analysis.  

If the analysis is successful... 

Analysis loadcase results are added to the  Treeview.  

In addition, 2 files will be created in the Associated Model Data directory where the 

model file resides: 

 vnotch_nonlinear_contact.out  this output file contains details of 

model data, assigned attributes and selected statistics of the analysis. 

 vnotch_nonlinear_contact.mys  this is the LUSAS results file which is 

loaded automatically into the  Treeview to allow results processing to take 

place. 
 

If the analysis fails... 

If errors are listed that for some reason you cannot correct, a file is provided to re-

create the model information correctly, allowing a subsequent analysis to be run 

successfully. 

 vnotch_nonlinear_contact_modelling.vbs  carries out the complete 

modelling of the example. 
  

 Start a new model file. If an existing model is open Modeller will prompt for 

unsaved data to be saved before opening the new file. 

 Enter the file name as vnotch_nonlinear_contact 

To recreate the model, select the file vnotch_nonlinear_contact_modelling.vbs 

located in the \<LUSAS Installation Folder>\Examples\Modeller
 
directory. 

 

 Rerun the analysis to generate the results 
 

Viewing the Results : Contact Analysis (Nonlinear Material) 

Analysis loadcase results are present in the  Treeview. For a nonlinear analysis the 

results for the last load increment are set to be active by default. 




File 

New… 

File 

Script > 

Run Script... 
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Preparing to animate the spread of yielded material 

As an alternative to viewing results individually for each loadcase, the change of stress 

and the spread of yielded material due to the increasing load increments can be 

animated instead. Stress contours and yield symbols will be plotted for selected load 

increments. 

 Where required, turn off the Mesh, Geometry and Attributes layers and turn on 

the Deformed Mesh and Contour layers in the  Treeview.  

 Press the Deformations... button in the  Treeview to open the deformed mesh 

mesh properties dialog. Click the Specify factor option and enter a Factor of 1 and 

click the OK button. 

Note. When animating nonlinear loadcases it is important that the deformed mesh is 

plotted using a specified factor of 1 and not using a fixed screen size value of 

magnitude otherwise the deformed mesh for each load increment would be drawn the 

same.  

With the last load increment (for load factor 2.5) in the  Treeview set active: 

 Double click the Contours layer in the  Treeview. 

The contour plot properties will be displayed. 

 Select Stress - Plane Stress contour results of Equivalent stresses SE 

 Select the Contour Range tab and set the Maximum contour value as 300 

 Click the OK button. 

The contour plot and contour summary for load increment 25 will be displayed showing 

the region of yielded material has spread across the whole arm of the model. 

 If necessary, change the 

layer display order to 

display the deformed mesh 

on top of the contour plot 

by moving the Deformed 

mesh to follow Contours 

in the  Treeview. 

 With no features selected click the right-hand mouse button in a blank part of the 

graphics window and select Values to add the values layer to the  Treeview. 

The values layer properties dialog will be displayed. 
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 Select Stress - Plane 

Stress values of 

component Yield 

 Click the OK button to 

display yield symbols for 

load increment 25 to show 

areas of the model that 

have yielded. 

Animating the results 

 Select the Load history option and click the Next button. 

 Select the Analysis 1 entry from the drop-down menu.  

The list of available load cases for selection will appear.  

Note. With so many load increments there is no need to animate the whole sequence. 

The selected load cases can be filtered to reduce the number to be animated. 

 Enter a Step value of 2 to display every second increment and click the Filter 

button. 

The filtered load increments will displayed in the loadcase panel. 

 Select the first load increment, hold down the Shift key and select the last load 

increment.  

 Click the  button to add the selected load increments to the included panel for 

the animation sequence. 

Click the Finish button to create the animation sequence and display the animation in a 

new window. 

 

Utilities 

Animation Wizard… 





Viewing the Results : Contact Analysis (Nonlinear Material) 

 125 

 

Note. To see the animation at the best resolution enlarge the window to a full size 

view.  The buttons at the bottom of the window may be used to slow-down, speed-up, 

pause, step through frame by frame, or stop the animation. 

Saving Animations 

Animations may be saved for replay in LUSAS at any time or saved for display in other 

windows animation players. 

 Ensure the animation window is the active window. 

 Enter vnotch_nonlinear_contact for the animation file name. An .avi file extension 

is automatically appended to the file name when it is saved. 

 Click OK to create the animation file. 

 

This completes the example. 



File 

Save As AVI... 
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Discussion: Use of the Multiple Analysis Facility 

This example, as written, uses individual models to carry out the various linear and 

nonlinear analyses, ignoring and then considering the contact effects in stages. 

Note that when the model geometry is unchanged between different analyses, the use of 

the multiple facility within LUSAS Modeller does away with the need to create separate 

models, or maintain “clone” copies of a model, in order to switch between and create 

results from linear static analysis and other analysis types.  

For this worked example the linear and nonlinear material analyses could be set-up and 

solved within one model, and the contact analyses could be solved in another model. 

The procedure described below would be used to extend the initial linear analysis to 

additionally include a nonlinear material, and carry out a nonlinear analysis, all within a 

single model. 

With the linear analysis section of the example completed, or with the linear analysis 

model loaded: 

1. Create a new Structural analysis called Analysis 2 that inherits all the base 

analysis assignments. Note that loading assignments are NOT inherited 

between analyses. So: 

2. Assign the loading Face Load 1 to the line representing the inside of the V-

notch for loadcase 2 within Analysis 2. 

3. Define a nonlinear material and assign it to the model geometry for Analysis 2 

(the linear material assignment previously made to the same geometry will still 

be valid for Analysis 1) 

4. Define a nonlinear analysis control for loadcase 2 within Analysis 2. 

5. Solve the model. 

6. After a successful solve, nonlinear loadcase increments will be added to the 

Analysis 2 entry within the  Treeview. 
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Modal Analysis of a 

Tuning Fork 

For software product(s):  All (except LT versions) 

With product option(s): None. 

Note: The example exceeds the limits of the LUSAS Teaching and Training Version. 

Description 

This example demonstrates a natural frequency analysis of a stainless steel tuning fork. 

The dimensions are those of an A tuning fork which vibrates at 440 Hz. The overall 

dimensions of the fork are as shown. 

52.0

48.5

44.0

23.0

7.5
3.5

93.25

134.5

2.0 4.0
R=3.5

All Dimensions are in mm

3.5

R=1.5 R=20.0

 

Units of N, mm, t, s, C are used throughout. 

 For natural frequency analysis consistent units must be adopted. 

 A model for an eigenvalue analysis is created in an identical way to that required 

for a static analysis, using features and attributes, but a relatively coarse mesh is 

used since stress output is not required. 

 No loading is applied to the structure. 

 Eigenvalue control data is included to specify details of the analysis required. 
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In a natural frequency analysis the following assumptions are made: 

 There is no applied load and vibration is due to the mass and stiffness of the 

structure alone. 

 There is no damping. 

 Vibration assuming sinusoidal displacements of the form a = ASin( t). 
  
The numerical solution produces a series of eigen pairs. The eigenvalues which indicate 

frequencies at which the vibration would naturally occur are output. The eigenvectors 

give the associated mode shape of vibration. It is important to note that the solved 

eigenvectors (and hence the resulting mode shape displacements) are normalised and 

hence may be arbitrarily scaled. Although displacement, strain and stress information 

may be plotted, these quantities are therefore only relative and cannot be used directly 

in the design process. It is common for the magnitudes of these quantities to be 

investigated by running subsequent modal analyses such as forced (harmonic) or 

spectral (seismic) response. In this case the resulting eigenvalues will be manipulated 

interactively during results processing using the Interactive Modal Dynamics (IMD) 

facility. 

The default method for Eigenvalue Extraction, used here, is Subspace Iteration. This 

method has the following characteristics: 

 All of the degrees of freedom in the model are used in the solution. 

 An initial estimated solution is improved via subsequent iterations. 

These characteristics make the method very accurate and robust. 

Keywords 

2D, Intersecting Features, Splitting Features, Surfaces by Joining, Mirroring, 

Natural Frequency, Eigenvalue, Eigenvalue Control, Interactive Modal Dynamics 

(IMD), Mode Shapes, Animation, Frequency Response Graphs. 

Associated Files 

 fork_modelling.vbs carries out the modelling of the fork.   
 
 

Modelling 

Running LUSAS Modeller 

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller 

in the Examples Manual Introduction. 
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Note. This example is written assuming a new LUSAS Modeller session has been 

started. If continuing from an existing Modeller session select the menu command File> 

New to start a new model file. Modeller will prompt for any unsaved data and display 

the New Model dialog.  

Creating a new model 

 Enter the file name as fork 

 Use the Default working folder. 

 Enter the title as Tuning Fork - Frequency Analysis 

 Set the model units to N,mm,t,s,C 

 Ensure the timescale units are Seconds 

 Ensure an analysis type of Structural is set. 

 Select the model template Standard 

 Select the Vertical Y Axis option and click the OK button. 

Note. Save the model regularly as the example progresses. Use the Undo button to 

correct any mistakes made since the last save was done. 

Feature Geometry  

 Enter coordinates of (0, 0), (1.5, 0), and (1.5, 1.5) to define the arc at the far left end 

of the fork. Select the coordinate (1.5, 0) as the Centre of the arc and click OK 

 Drag a box to select the 2 Points shown. 

 

 Use the New Line button to create the Line. 

 Select the other 2 Points shown.  

 Use the New Line button to create the Line. 

 Select the Arc, hold down the Shift key and 

then select the 2 straight Lines by individually 

clicking on each in turn.  

 Using the New Surface button, create a Surface from the Lines selected. 

 Click on a blank part of the graphics window to clear the selection.  





Geometry  

Line > 

Arc/Circle 

From 
Coords/Points 
… 

Select these 2 Points

Select these 2

Points
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 Define Points at coordinates of (23,0) and (23,3.5) and click OK 

 Select pairs of Points and create new Lines between each pair. 

 Drag a box around these 

Lines. 

 Create a Surface to form the 

next part of the base of the fork. 

 Click on a blank part of the 

graphics window to clear the selection and then Define Points at coordinates of (44,0) 

and (44,7.5) which form the ends of the radius handle of the fork. 

 

 Select pairs of  Points and use the New Line button to create only the straight Lines 

shown. 

 

1. Select this Point 2. Select this Point

3. Select this Point
 

 To define the arc. Select the arc start and end Points, and the Point at the bottom 

right of the model. 

 

Geometry 

Point > 

Coordinates... 

Select these 4 Lines
 Geometry 

Point > 

Coordinates... 
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 Specify that coordinate 

(44,0) is a Direction 

Point.  

 Ensure that Minor arc is 

selected 

 Enter an arc radius of 20 

 Click OK to draw the 

arc. 

 

The Lines which mark the extent of the support conditions on the handle (that is the 

area over which the fork is assumed to be held) will now be defined. This will be done 

by copying existing Lines. 

1. Select this Line

2. Select this Line

 

 Select the first Line shown. 

 

 Copy the Line once through a distance of 2 in the X direction and click OK 

 Select the second Line shown 

 Copy the Line once through a distance of -4 in the X direction and click OK 

Note. Right-clicking the graphics window with geometry selected provides a menu 

with short-cuts to common commands, such as Copy and Sweep. 

 

 

 

Geometry  

Line > 

Arc/Circle 

From 
Coords/Points… 
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1. Select these 3 Lines

2. Select this Line and these 2 Points
 

Points are now created at the intersections of the arc with the 2 new copied  Lines. 

 Select the 3 upper Lines shown using the Shift key to add to the initial selection. 

 Create Exact intersections only and ensure the Split intersecting lines and Delete 

geometry on splitting options are selected. Click the OK button to create the new 

Points at the Line intersections and also split the selected Lines.  

In order to create 3 separate Surfaces the Line along the axis of symmetry has to be split 

into 3 new Lines. 

 Select the Line and 2 Points shown in the previous diagram. 

 Ensure that Delete features on splitting is selected and click OK to create 3 new 

Lines. 

Three Surfaces are now defined using the Lines previously created. 

Select these 4 Lines to

create a Surface

Create a Surface here also

Create a Surface here also

  

 Select the 4 Lines (remembering to hold the Shift key down after the first line is 

selected to add to the selection) to form the boundary of the Surface shown. 

 Use the New Surface button to create a Surface. 

 Repeat, selecting each set of 4 Lines to define the remaining 2 Surfaces 

Geometry 

Point > 

By Intersection.. 

Geometry  

Line > 

By Splitting > 

At a point … 

Geometry 

Surface > 

Lines... 
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Lines and Points that are left over from the previous operations can be deleted to 

tidy-up the model. 

Select these features only
 

 Drag a box around the features shown, ensuring that no Surfaces are selected. 

 To delete the unwanted Lines. 

 

 Select Yes to delete Lines.  

 Select Yes to delete Points.  

Note. Only those Point and Line features that are not used to define any Surfaces will 

be deleted. Pressing Yes to All will delete all lower order features without prompting. 

 Click on a blank part of the graphics window to clear the selection.  

 Enter coordinates of (48.5,0) and (52,7.5) and click OK to define the points. 

 

 
 

A horizontal Line will now be created. 

 

 Select the two Points and create the horizontal straight Line as shown above. 

Now define the arc at the start of the arm section of the fork. 

Edit 

Delete 



Geometry 

Point > 

Coordinates... 
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Select this Point to create arc

(52,0,0)

 

 Select the single Point. 

 Select the Rotate option to sweep the point through an angle of -90 degrees about 

the Z-axis around an origin Point of (52, 0, 0) 

 Click OK to sweep the Point and create an Arc. 

To avoid the creation of a 5-sided Surface at the start of the arm section the arc will be 

split into two. 

 Select the newly created arc. 

 Enter 2 for the number of divisions. Ensure Delete original lines after splitting is 

selected and click OK to replace the arc with two new arcs. 

To complete the junction section of the fork two new Surfaces will be defined.  

Select this arc

Select this Line

 

 Zoom in to the working area. 

 Revert to standard cursor mode and select one of the Arcs. Hold down the Shift 

key and select the Line on the opposite side as shown above. 

 Create the first Surface. 

 Repeat the previous procedure to create the second Surface as shown below. 

 

Geometry 

Line > 

Arc/Circle > 

By Sweeping 
Points… 

Geometry 

Line > 

By Splitting > 

In equal 
divisions… 

Geometry 

Surface > 

By Joining… 
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The remainder of the fork will be created by sweeping the vertical Line at the right-

hand end of the model through a distance in the X direction. 

 Resize the model so all features are in view. 

1. Select this vertical

Line to create Surface

2. Select this vertical

Line to create Surface

 

 Select the vertical Line shown. 

 Enter a distance of 41.25 in the X direction. 

 Click OK to create the Surface.  

 Select the new Line at the right-hand end of the model. 

 Use the Sweep Feature button to sweep the Line through a distance of 41.25 in the 

X direction to create the Surface. 

The geometry of the half-model of the tuning fork is now complete. Attribute data such 

as mesh, loading and supports will now be added to the half-model before copying and 

mirroring  to create a full model for analysis. 

Meshing 

A frequency analysis can use a relatively coarse mesh, since stress output is not 

required from the analysis. With this in mind, a series of Line meshes will be used to 

control the density of the Surface mesh. 

Line meshes 

As the majority of the Lines require only 2 divisions the default number of mesh 

divisions will be reset. 

 Select the Meshing tab, set the default number of divisions to 2 and click OK to 

return to the graphics window. Any Lines to which a line mesh dataset is not 

assigned will adopt this as a default. 

Selected Lines will be assigned a number of Line divisions. LUSAS provides a limited 

number of Line Mesh datasets by default in the Standard template. These can be found 

in the  Treeview. 

Geometry 

Surface > 

By Sweeping… 

Geometry 

Surface > 

By Sweeping… 

File 

Model Properties… 
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A Line mesh dataset with 12 divisions is not defined by default so one must be created. 

 With the Element description set as None, define a Line mesh dataset containing 12 

divisions named Divisions=12 

Divisions=4

Divisions=1

Divisions=3
Divisions=12

Divisions=4

Divisions=1

Divisions=3

Divisions=12

 

 Click OK to add the dataset name to the  Treeview. 

 With the relevant sets of Lines selected, drag and drop the appropriate Line mesh 

datasets from the  Treeview onto the selected features. Use the Zoom in button as 

necessary. 

Surface mesh 

 Define a Surface mesh using Plane Stress, Quadrilateral, Quadratic elements. 

Name the dataset Plane Stress and click OK 

 Using the Ctrl and A keys together Select the half model of the fork. 

 Drag and drop the Surface mesh dataset Plane Stress from the  Treeview onto 

the selected features. 

  

 

Note. Since all of the Surfaces are 4 (or 3) sided, a regular mesh pattern is created.  

At any time the mesh (and other layers) displayed in the graphics window may be 

hidden or redisplayed. With no features selected click the right-hand mouse button in a 

blank part of the graphics window and select Mesh. If a mesh was previously displayed 

Attributes 

Mesh > 

Line… 

Attributes 

Mesh > 

Surface… 
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it will be hidden. If previously hidden it will be displayed. This facility can be used to 

simplify the display when it is required. 

 Remove the Mesh from the display as described in the previous note. 

Geometric Properties 

 Specify a thickness of 4 and leave the eccentricity blank. 

 Enter the dataset name as Thickness and click OK.  

 With the whole model selected (Using the Ctrl and A keys together) drag and drop 

the geometry dataset Thickness from the  Treeview onto the selected features. 

Geometric assignments are visualised by default. 

 Use the fleshing on/off button to turn off the geometry visualisation. 

Material Properties 

 Select Stainless Steel of grade Ungraded and click OK 

 With the whole model selected, drag and drop the material dataset Iso1 (Stainless 

Steel Ungraded) from the  Treeview onto the selected features. 

 Ensure the Assign to surfaces option is selected and click OK 

Support Conditions 

When using the Standard template, LUSAS provides the more common types of 

support by default. These can be seen in the  Treeview. To model the holding of the 

tuning fork the support dataset Fixed in XY will be used. 

Note. 2D plane stress elements only have X and Y degrees of freedom therefore a 

restraint in the Z direction is not necessary. 

 With the arc shown in the 

diagram selected, drag and drop 

the support dataset Fixed in XY 

from the  Treeview onto the 

selected Line. 

 Ensure the Assign to lines and 

All analysis loadcases options are selected and click OK 

Attributes 

Geometric > 

Surface… 

Attributes 

Material > 

Material Library… 



Select this Line
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 If supports are not visualised when expected they can be visualised for each support 

condition by right-clicking on the support name in the supports section of the   

Treeview and selecting Visualise Assignments. 

Note. In practice this support would not be a rigid support since it is hand-held but 

this should not significantly affect the frequencies obtained.  

Loading 

No loading is required for a natural frequency analysis. 

Note. The fork is symmetrical about its centre-line, therefore only half of the structure 

has so far been created. For static structural analysis it would be common to apply a 

symmetry support condition to the centreline, so that only half of the structure need be 

analysed. However, in a frequency analysis the use of symmetry in this way is less 

common since this will force the analysis to only solve for the symmetric modes of 

vibration ignoring any anti-symmetric modes. Generally, both symmetric and 

unsymmetric vibration modes are of significance, therefore the model will be mirrored 

to form the complete model.  

Select these 2 Points to define mirror plane
 

 Select the 2 Points on the centreline of the tuning fork as shown. 

The Points are stored in memory. 

 Select the whole model using the Ctrl and A keys together. 

 Select Mirror - Points 5 7 (note point numbers may differ between models) from 

the drop-down list and click the Use button on the dialog to use the Mirror Points stored 

in memory.  

 Click OK to create the full model. 

To remove the Points from the selection memory. 

 

 





Edit 

Selection Memory > 

Set 

Geometry 

Surface 

Copy… 

Edit 

Selection Memory > 

Clear 
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Note. The model is 2 Dimensional, therefore only 2 Points are required to define the 

mirror plane (the Z direction is assumed as the screen Z plane). In addition, the 

selection of Points as far away from each other as possible will ensure a good 

specification of the required mirror plane. 

The model is now complete. All attributes assigned to the original half-model features, 

including the support and mesh assignments, will have been identically reproduced on 

the duplicated features. 

Eigenvalue Analysis Control 

The eigenvalue analysis control parameters are applied as properties of the load case.   

 In the  Treeview expand Analysis 1 then right-click on Loadcase 1 and select 

Eigenvalue from the Controls menu option.  

The Eigenvalue dialog will appear. 

 

The following parameters need to be specified to perform a frequency analysis with a 

specified number of the minimum eigenvalues. 

 Set the Number of eigenvalues required to 10 

 Set the Shift to be applied to 0 

 Leave the type of eigensolver as Default 

Note. Eigenvalue normalisation is set to Mass by default. This is essential if the 

eigenvectors are to be used for subsequent IMD analysis in results processing as they 

are in this case. 




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 Click the OK button to finish. 

Saving the model 

 Save the model file. 

Running the Analysis 

 Open the Solve Now dialog and press OK to run the analysis. 

A LUSAS Datafile will be created from the model information. The LUSAS Solver 

uses this datafile to perform the analysis. 

If the analysis is successful... 

LUSAS eigenvalue results will be added to  Treeview.  

In addition, 2 files will be created in the Associated Model Data directory where the 

model file resides: 

 fork.out  this output file contains details of model data, assigned attributes and 

selected statistics of the analysis. 

 fork.mys  this is the LUSAS results file which is loaded automatically into the 

 Treeview to allow results processing to take place. 
 

If the analysis fails... 

If the analysis fails, information relating to the nature of the error encountered can be 

written to an output file in addition to the text output window.  Any errors listed in the 

text output window should be corrected in LUSAS Modeller before saving the model 

and re-running the analysis.  

Rebuilding a Model  

If it proves impossible for you to correct the errors reported a file is provided to enable 

you to re-create the model from scratch and run an analysis successfully.   

 fork_modelling.vbs  carries out the modelling of the example.  
 
 

 Start a new model file. If an existing model is open Modeller will prompt for 

unsaved data to be saved before opening the new file. 

File 

Save 





File 

New… 
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 Enter the file name as fork 

To recreate the model, select the file fork_modelling.vbs located in the \<LUSAS 

Installation Folder>\Examples\Modeller
 
directory. 

 

 

 Rerun the analysis to generate the results 

Viewing the Results 

This section outlines some typical results processing operations for a natural frequency 

and Interactive Modal Dynamics (IMD) analysis. The following interactive results 

processing operations are performed: 

 Mode Shape Plots  Displaying mode shapes from the natural frequency 

analysis. 

 Mode Animation Sequence  Animation of selected mode shapes. 

 Printing Eigenvalue Results  Printing results to a text window. 

 Modal Dynamics (IMD)  Graphing of Displacement vs. Frequency for a 

selected node (all frequencies) using a linear scale.  
  

Selecting a Results Loadcase 

Eigenvalue loadcase results are present in the  Treeview, and for an eigenvalue 

analysis, the first eigenvalue (Eigenvalue 1) is set to be active by default. 

Plotting Mode Shapes 

If present, turn off the Geometry, Attributes and Mesh layers in the  Treeview. 

 If not already on, turn the Deformed mesh layer on: With no features selected click 

the right-hand mouse button in a blank part of the Graphics window and select 

Deformed mesh to add the deformed mesh layer to the  Treeview. 

 Click the OK button and the deformed mesh plot for Eigenvalue 1 will be 

displayed.  

File 

Script > 

Run Script... 



Modal Analysis of a Tuning Fork 

 142 

 

Note. The mode shape may be inverted. This is because the sense is arbitrary since 

during vibration the deformed shape will appear in both directions. 

To view other mode shapes, in the  Treeview right-click on the Eigenvalue required 

and select the Set Active option. 

Creating Animations of Mode Shapes 

This section will create an animation of the third mode shape.  

 In the  Treeview right-click on Eigenvalue 3 and select the Set Active option. 

 The deformed shape for Eigenvalue 3 will be displayed. 

 Select the Active loadcase button and select the Next button. 

 Use a Sine deformation with 8 frames. Set the range to –1 to 1. Set the deformation 

magnitude of 6 mm. 

 Click Finish and LUSAS will create the animation sequence and display the 

animation in a new window.  



Utilities 

Animation Wizard... 
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 To see the animation at the best resolution enlarge the window to full size. The 

buttons at the bottom of the window may be used to slow-down, speed-up, pause, 

step through frame by frame, or stop the animation. 

Saving Animations 

Animations may be saved for replay in other Windows applications. 

 Ensure the animation window is the active window. 

 Enter fork_mode3 for the animation file name. An .avi file extension is 

automatically appended to the file name when the file is saved. Click OK. 

 Close the animation window without saving changes. 

Printing Eigenvalue Results 

Eigenvalue results for the model can be displayed in the Text Output window. 

 Select the Active loadcase; the choice of loadcase is irrelevant when reporting 

Eigenvalues. Press Next. 

 Select Entity None of results Type Eigenvalues and click the Finish button to print 

the eigenvalues to the text output window. Your values should be similar to these: 

     MODE    EIGENVALUE      FREQUENCY       ERROR NORM 

File 

Save As AVI... 

Utilities 

Print Results 
Wizard… 
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        1    0.725647E+07     428.729        0.137567E-08 

        2    0.740305E+07     433.037        0.136178E-08 

        3    0.272988E+09     2629.61        0.461326E-10 

        4    0.283643E+09     2680.44        0.430260E-10 

        5    0.200119E+10     7119.74        0.392818E-10 

        6    0.214224E+10     7366.38        0.127963E-10 

        7    0.375775E+10     9756.28        0.252194E-10 

        8    0.572457E+10     12041.8        0.139476E-10 

        9    0.668763E+10     13015.4        0.258395E-09 

       10    0.810989E+10     14332.7        0.956746E-07 

Note. The error norms may vary as they are dependent on the Eigensolver used for the 

solution. 

 Close the text window. 

Interactive Modal Dynamics 

The vertical displacement response of a selected node for a unit vertical force is to be 

plotted against the sampling frequency over the entire solved frequency range (0-15000 

Hz) on a linear scale.  

 Select the node at the end of the arm shown. 

Select this Node
 

Using the Graph Wizard 

The graph wizard provides a step-by-step means of selecting results to be plotted on the 

X and Y axes of a graph. The X axis data is always defined first. 

 Select the Modal Expansion option and click the Next button. 

 The Frequency response for All modes is to be calculated for the X axis data. 

Ensure the Damping Type is set to None  



Utilities 

Graph Wizard... 
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 On the Modal Excitation section of the dialog ensure that Point excitation is 

selected and click the adjacent Set button.  

 Select the Node number previously selected from the drop-down list. Select 

component Y and click the OK button to return to the main dialog.  

 Click the Next button. 

The excitation loading has been defined. The response has now to be defined. 

 On the Modal Frequency Domain dialog select Displacement results of component 

DY. Enter Sampling frequency values of Start as 0, End as 15000 and Step as 

100 

 Click the Next button.  

The response has now been defined. Frequency (X) and Amplitude (Y) axis datasets are 

now generated to graph the displacement frequency response at the selected node.  

Additional information for the graph can now be added. 

 Leave all graph title information blank. 

 De-select the Show symbols button. 

 Click the Finish button to end. 

 

Note. If no graph or axis titles are entered default names will be used. The graph 

attributes may be edited by right clicking on the graph and selecting Edit Graph 

Properties 

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LUSAS will create the 

graph in a new window 

and display the values 

used in an adjacent table.  

To see the graph at the 

best resolution enlarge the 

window to a full size 

view. 

 Position the cursor 

over the first peak on 

the graph to see the 

values at the peak of 

X=400 (Frequency) 

and Y=0.371 

(Amplitude DY) 

Note.  Using a large frequency range with a 100Hz interval means the actual mode 1 

frequency (of 428.729Hz) has been missed. When plotting graphs of this nature it is 

therefore better to use a smaller frequency range and interval in order to isolate the peak 

results. 

To produce a more detailed graph 

 Close the current graph window. 

 Ensure the same node is selected on the fork.  

 With the Modal Expansion option selected click the Next button. 

 With all options that were set previously selected click the Next button.  

 Select Displacement results of component DY. Enter sampling frequency values of 

Start as 0, End as 800 and Step as 1 

 Click the Next button. 

 Leave all graph title information blank. 

 Ensure the Show symbols option is not selected 

 Click the Finish button to end. 

 



Utilities 

Graph Wizard... 
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LUSAS will create a 

graph in a new window 

and display the values 

used in an adjacent 

table.  To see the graph 

at the best resolution 

enlarge the window to a 

full size view. 

 Position the cursor 

over the main peak 

on the graph to see 

the values at the 

peak of X=433 

(Frequency) and 

Y=145.89 

(Amplitude DY). 

This is a theoretical 

amplitude and is related to no damping being present. 

 Click and drag the cursor over the region as shown and a new graph the peak for 

the first mode shape will be seen 

 

This displays a better representation of the displacement/ frequency response in the 

vicinity of the first two mode shapes. 
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 Position the cursor over the first peak on the graph to see the values at the peak of 

X=429 (Frequency) and Y=18.89 (Amplitude DY) 

These values compare more favourably with those obtained from using the Print Results 

Wizard for mode 1 earlier in the example.  

 Right-click and select Unzoom to return to the previous graph view. 

 Close all graph windows to leave the model window active. Ensure the node at the 

end of the fork is still selected. 

Plotting Dynamic Response for a Particular Frequency 

In some analyses, dynamic responses are required at a specified frequency. In these 

cases, an Interactive Modal Dynamics (IMD) load case is defined to allow the 

frequency and type of excitation to be specified. In this example, deformed shapes and 

peak displacements are to be plotted for excitation frequencies of 750Hz and 1500Hz. 

On the IMD Loadcase properties dialog: 

 Select Point excitation 

and click the adjacent Set 

button. 

 On the Point Excitation 

dialog, for a Force, select 

the Node number 

previously selected from 

the drop-down list. Select 

Direction component Y 

and click the OK button 

to return to the IMD 

Loadcase main dialog. 

 Select Frequency results 

and click the adjacent Set button. 

 On the Frequency Results dialog, for Type Amplitude, enter a Frequency of 750 

 Click the OK button to return to the main IMD Loadcase dialog. 

 Ensure the name is set to be IMD 1 

 Click the OK button to finish defining the IMD loadcase. 

Analyses 

IMD Loadcase... 
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Selecting the IMD Results Loadcase 

 In the  Treeview right-click on IMD 1 and select the Set Active option. 

 

The deformed mesh plot is updated to show the deformed mesh at the specified 

frequency. 

Marking Peak Values 

 With no features selected click the right-hand mouse button in a blank part of the 

Graphics window and select the Values option to add the Values layer to the  

Treeview. 

 The values properties will be displayed. 

 Select Displacement  results of displacement in the Y direction DY. Select the 

Values Display tab and select the top 0% of Maxima values.  

 Click the OK button to display the top value of displacement for this IMD results 

loadcase frequency. 

 

Changing the results frequency 

 In the  Treeview double-click the IMD 1 dataset name.  

 Click the Set  button adjacent to the Frequency option. 

 Change the frequency to 1500 and click the OK button to return to the main dialog. 

 Click the OK button to finish defining the IMD loadcase. 
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The deformed mesh plot will be updated to show the revised mode shape and 

corresponding values for the specified frequency. 

 

Note.  Since the eigenvalue is independent of sign the deformed shape may appear 

inverted from that shown. 

 

This completes the example. 

 

 

 

 

 

 


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Modal Response of 

a Sensor Casing 

For software product(s):  All (except LT versions) 

With product option(s): Plus 

Description 

An aerospace sensor casing is to be 

assessed for dynamic stresses induced 

by vibration of the airframe to which it 

is attached. 

The sensor casing is manufactured from 

steel plate with a uniform thickness of 

0.8 mm. 

The surfaces at the top of the sleeve are 

rigidly held. The loading is 

characterised by a random vibration at 

the supports of the airframe and is defined as an acceleration Power Spectral Density 

(PSD) specified by the airframe manufacturer. 

The Interactive Modal Dynamics (IMD) facility is used to evaluate the response of the 

casing to this loading. A quarter model is initially defined with the sleeve modelled as if 

it were in the centre of the casing, and subsequently copied to create the full model. The 

sleeve is then repositioned to the location shown to show the associativity of features. 

Units of N, m, kg, s, C are used for the analysis. 

6.0

70.0

70.0

14.14

Bottom

Plate

All Dimensions in mm

Sleeve36.0

5.0
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Objectives 

The following results plots are to be obtained: 

 Deformed Shape A display of the deformed mesh for the first mode shape. 

 Frequency Response Function FRF of a node using support motion 

excitation. 

 Power Spectral Density PSD stress response at a node using a PSD 

excitation function. 
  

Keywords 

Linear, Eigenvalue, Scale Factor Transformation, Interactive Modal Dynamics 

(IMD), Default Attribute Assignment, Deformed Shape, Frequency Response 

Function (FRF), Power Spectral Density (PSD), Stress Contours. 

  

Associated Files 

If results processing and not the actual modelling of an example is only of interest to 

you the VBS file(s) provided will allow you to quickly build a model for analysis. For 

more details refer to Creating a Model from the Supplied VBS files in the Introduction. 

 casing_modelling.vbs carries out the modelling of the example. 
 
 

Modelling 

Running LUSAS Modeller 

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller 

in the Examples Manual Introduction. 

Note. This example is written assuming a new LUSAS Modeller session has been 

started. If continuing from an existing Modeller session select the menu command File> 

New to start a new model file. Modeller will prompt for any unsaved data and display 

the New Model dialog. 

Creating a new model 

 Enter the file name as casing 

 Use the Default working folder. 

 Enter the title as Modal Response of Sensor Casing 




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 Set the model units as N,m,kg,s,C 

 Ensure that timescale units are Seconds 

 Ensure an analysis type of Structural is set. 

 Select the model template Standard 

 Select the Vertical Y axis. 

 Click the OK button. 

Note. Save the model regularly as the example progresses. Use the Undo button to 

correct any mistakes made since the last save was done. 

Default assignments 

The material properties, plate thickness and mesh element type are uniform over the 

whole sensor casing. By using default attribute assignments, attribute datasets are 

automatically added to new features when they are created. 

Automatic Mesh Assignment 

 Define a Surface mesh using Thin shell, Quadrilateral elements with Linear 

interpolation. 

 Enter Thin shell for the mesh dataset name.  

 Click the OK button to add the mesh dataset to the  Treeview. 

 To set this mesh dataset as the default surface mesh assignment click the right-hand 

mouse button on the Thin shell dataset name in the  Treeview and select the Set 

Default option. The  icon will change to  indicating that Thin shell will 

automatically be assigned to all new Surfaces. 

Automatic Geometry Assignment 

 Enter a Surface element thickness of 0.0008 

 The eccentricity can be left blank or set to zero as it is not required.  

 Enter the dataset name as Thickness of 0.0008 and click OK to add the dataset to 

the  Treeview. 

 To set this geometry dataset as the default geometry assignment click the right-hand 

mouse button on the Thickness of 0.0008 dataset name in the Treeview and 

select the Set Default option. 



Attributes 

Mesh > 

Surface... 

Attributes 

Geometric > 

Surface... 
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Automatic Material Assignment 

 The sensor is made from steel so select Mild Steel from the drop down list. 

 Click OK to add the material to the  Treeview. 

 Set this material as the default material assignment by clicking the right-hand mouse 

button on the Iso1 (Mild Steel Ungraded) material dataset in the  Treeview and 

selecting the Set Default option. 

Feature Geometry 

In a natural frequency analysis, consistent units such (N, m, kg, sec) must be used. It is 

however more convenient to define the geometry in millimetres and scale the model 

when the geometry input is complete. 

Defining the sleeve of the sensor 

Note.  The sleeve is defined initially as if it were positioned centrally on the casing. 

Later in the example it will be moved to its actual position to show the associativity of 

features.  

 Define a Line on the sleeve from (0,0) 

to (-5,-5) and click the OK button. 

 Select the Line just drawn.  

 Sweep the line into a surface by 

choosing the Rotate option and entering an 

angle of  90 degrees to rotate the line about 

the Z-axis about an origin of 0,0,0  

 Click the OK button to complete the 

Sweep operation. 

 Select the fleshing on/off button to turn-

off geometric property visualisation. 

Attributes 

Material > 

Material Library... 



Geometry 

Line > 

Coordinates... 

 

Geometry 

Surface > 

By Sweeping... 
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The number of elements modelling the end of the sleeve will be reduced. 

 Select the two radial 

Lines and adjust the mesh 

by assigning Line mesh 

Division=1 from the 

Treeview. 

 

 

 

 

 

Defining the mesh for the sleeve 

The arc will now be swept to create a Surface.  

 Select the arc 

 Sweep the arc into a surface by 

selecting the Translate option and enter 

a translation of -5 in the Z direction. 

Click the OK button to create the 

surface.  

 

 Use the Isometric view button to 

view the Surface created. 

The sides of the sensor will now be 

defined.  

Note. To simplify the modelling the sleeve will be defined at the centre of the plate 

and moved when the full model has been generated. 

 Enter coordinates of (-35, -35, -5) and (35, -35, -5) to define a Line representing 

the bottom edge of the housing. Click OK to generate the Line. 

A new Surface can be created by joining this new Line to the previously defined arc to 

form a quarter of the housing plate. 

Select these

two lines

 

 

Geometry 

Surface > 

By Sweeping... 



Geometry 

Line > 

Coordinates... 



Modal Response of a Sensor Casing 

 156 

 Select the arc shown right and add the Line at 

the bottom edge of the sensor to the selection 

by hold down the Shift key. 

 A Surface will be created. 

 

The Line at the bottom edge of the sensor casing is 

now to be swept to create the bottom Surface of 

the casing. 

 Select the bottom edge Line of the housing. 

 Choose the Translate option and 

define a translation of -30 in the Z 

direction. Click the OK button to create 

the new Surface. 

To define the portion of casing beyond 

the bottom plate, select the Line shown. 

 Define a translation of -6 in the Z 

direction and click OK to sweep a new 

Surface. 

 

 Now adjust the mesh on the 

new surface by selecting the 2 

Lines of the casing indicated in 

the diagram and drag and drop 

the Line mesh Divisions=1 

from the  Treeview onto the 

selected features. 

 

 

 

 

This completes the definition of the features of the quarter model. 

 

2. Select this line

1. Select this arc

 

Geometry 

Surface > 

By Joining... 

Geometry 

Surface > 

By Sweeping… 
Sweep this line

through -6 units in

the Z direction

 

Geometry 

Surface > 

By Sweeping… 

Select these 2 lines and

assign Line Mesh

Divisions=1
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Supports 

Note. Supports are to be assigned to the quarter model before copying is done to save 

time assigning the support dataset to the equivalent copied Surfaces. 

 Select the Surface at the end of the sleeve. If 

necessary, zoom in and cycle though the displayed 

features by clicking the left-hand mouse button until 

the Surface required is highlighted. 

 

 Drag and drop the support dataset Pinned from the 

 Treeview onto the selected surface and click OK 

The full housing model can now be created from the 

quarter model  

 Using the Ctrl and A keys together, select the whole model.  

 Use the copy button to Rotate the selected features through 90 degrees about the 

Z-axis and create 3 copies of the original selection.  

 Click OK and Modeller will create and display the extra features. 

 

 To generate the bottom plate select the 4 

Lines shown. 

 The Surface defining the bottom plate will 

be created. 

 

 

 

 

 

 

 

 



 

Geometry 

Surface > 

Copy… 

Select these 4 lines

 

Geometry 

Surface > 

Lines... 
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Finally the sleeve must be moved off centre. 

 Rotate the model to view along the Z axis by clicking in the status bar at 

the bottom of the Modeller window. 

 For clarity delete the Mesh and Attributes layers from the  Treeview. 

 Box select the features which make up the 

sleeve. 

 

 

 

 

 

 

 Move the sleeve to the required position by 

entering a translation of -7.07 in the X direction 

and -7.07 in the Y direction and click OK 

 

 

 

 

 

Finally the geometry must be scaled so the units are metres. 

 Use the Ctrl + A keys together to select the full model. 

 Select the Scale option and enter an X, Y and Z scale factor of 0.001 about an 

origin of 0,0,0.  

 Click OK to scale the geometry from millimetres to metres. 

 

Select the Sleeve

 

Geometry 

Point > 

Move... 

 

Geometry 

Point > 

Move... 
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Eigenvalue Analysis Control 

To carry out results processing using the Interactive Modal Dynamics facility, an 

eigenvalue analysis must be performed. The results from the eigenvalue analysis 

normalised to global mass will be used to perform the Frequency Response Function 

calculations.  

The eigenvalue analysis control properties are applied as a function of the load case. 

 In the  Treeview expand Analysis 1 then right-click on Loadcase 1 and select 

Eigenvalue from the Controls menu option.  

The Eigenvalue dialog will appear. 

The following parameters need to 

be specified to perform a 

frequency analysis with the 

minimum number of eigenvalues. 

 Set the Number of 

eigenvalues required as 8 

 Set the Shift to be applied as 

0 

 Leave the type of eigensolver as Default 

Note. Eigenvalue normalisation is set to Mass by default. This is essential if the 

eigenvectors are to be used for subsequent IMD analysis in results processing as in this 

case. 

 Click the OK button to finish. 

The model is now complete. 

Running the Analysis 

 Open the Solve Now dialog and press OK to run the analysis. 

A LUSAS Datafile will be created from the model information. The LUSAS Solver 

uses this datafile to perform the analysis. 

 


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If the analysis is successful... 

Analysis loadcase results are added to the  Treeview.  

In addition, 2 files will be created in the Associated Model Data directory where the 

model file resides: 

 casing.out  this output file contains details of model data, assigned attributes 

and selected statistics of the analysis. 

 casing.mys  this is the LUSAS results file which is loaded automatically into 

the Treeview to allow results processing to take place. 
 

If the analysis fails... 

If the analysis fails, information relating to the nature of the error encountered can be 

written to an output file in addition to the text output window.   Any errors listed in the 

text output window should be corrected in LUSAS Modeller before saving the model 

and re-running the analysis.  

Rebuilding a Model  

If it proves impossible for you to correct the errors reported a file is provided to enable 

you to re-create the model from scratch and run an analysis successfully.  

 casing_modelling.vbs  carries out the modelling of the example.  
 
 

 Start a new model file. If an existing model is open Modeller will prompt for 

unsaved data to be saved before opening the new file. 

 Enter the file name as casing and click OK 

To recreate the model, select the file casing_modelling.vbs located in the \<LUSAS 

Installation Folder>\Examples\Modeller
 
directory. 

 

 Rerun the analysis to generate the results 





File 

New… 

File 

Script > 

Run Script... 
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Viewing the Results 

This section outlines some typical results processing operations for a natural frequency 

and Interactive Modal Dynamics (IMD) analysis. The following interactive results 

processing operations are performed: 

 Mode Shape Plots Displaying mode shapes from the natural frequency 

analysis. 

 Frequency Response Function (IMD) Graphing of Acceleration due 

to support motion vs. Frequency for a selected node (all frequencies) using a 

linear scale.  

 Power Spectral Density Response (IMD) Displaying the PSD stress 

response for a node on the top plate due to a PSD acceleration input at the 

supports. 
  

Selecting a Results Loadcase 

Analysis loadcase results are present in the  Treeview, and for eigenvalue analysis 

the loadcase results the first Eigenvalue is set active by default. 

Displaying the 1st Mode Shape 

 Turn off all layers in the  Treeview. 

 Ensure Eigenvalue 1 is set active in the  Treeview.  

 If not already visible, turn enable the Deformed mesh layer: With no features 

selected click the right-hand mouse button in a blank part of the graphics window 

and select Deformed mesh to add the deformed mesh layer to the  Treeview. 

 In the panel at the bottom of the  Treeview, press the Deformations... button  

and change the specified magnitude to 20 and click the OK button to display the 

deformed mesh for eigen mode 1. 
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 Use the Dynamic Rotation button to 

rotate the model to a similar view to that 

shown. 

 Return to normal cursor mode. 

Note. For more complex mode shapes it 

may be beneficial to animate the mode shape 

so it can be seen in more detail. 

Note. In some cases the mode shape may 

appear inverted. This is because the 

Eigenmode represents the shape of the 

vibrating body and the displacements may be 

multiplied by -1. 

Stresses as Filled Contours 

 Turn on the Mesh and turn off the Deformed mesh layers in the  Treeview 

 Transform the view to visualise the 

model from the X direction by clicking 

on the  in the status bar at 

the bottom of the Modeller window. 

 Select an area enclosing the top plate of 

the housing as shown.  

 Create a new group consisting of the 

elements forming the top plate. 

 Enter Top Plate as the group name and 

click OK. 

 Rotate the model to view 

along the Z axis by clicking in the status bar at the bottom of the Modeller window. 

 Make the top plate the only visible part of the model by clicking with the right-hand 

mouse button on Top Plate in the  Treeview and selecting Set as Only Visible 

 





Select

elements on

top plate by

boxing

region

shown.
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 Ensure the results for Eigenvalue 1 are set 

active in the  Treeview. 

 With no features selected right-click on a blank 

part of the screen and select Contours 

 Select the Stress (top) – Thin Shell entity and 

maximum absolute stress component Sabs 

 Click the OK button to display contours of 

maximum absolute stress. 

 To display the mesh on top of the contours 

select Mesh in the  Treeview and drag and 

drop it on top of the Contours layer name. 

The node where the maximum absolute stress occurs is noted at the bottom of the 

contour key.  

 Make a note of this node number as it will be used later in the example. 

Note. The contours are relative stress contours which have no quantitative meaning. 

 

Interactive Modal Dynamics  

Note. A FRF (frequency response function) is a transfer function in the frequency 

domain. In general terms, the transfer function indicates how much of the input 

excitation is transferred to the selected output point.  

Compute the modal acceleration response in the Z direction at the node in the centre of 

the bottom surface due to a harmonically varying acceleration applied to the structural 

supports. 

 Delete the Contours layer from the  Treeview. 

 Redisplay the full model by selecting the casing.mdl in the  Treeview with the 

right-hand mouse button and selecting Set as Only Visible. Select Yes to act on 

sub-group as well. 

Highest stressed node.
 


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 Rotate the model as shown  

 Return to normal cursor mode. 

 Select the node at the centre of the bottom 

plate.  

 

 

 

 

 

 

 Select the Modal Expansion option and click the Next button. 

 On the Modal Dynamics Graph 

dialog choose the Frequency 

entity. 

 Under the damping section choose 

Specified values from the drop 

down list. 

 Select the Set damping button and 

on the Damping Values dialog set 

the viscous damping to 0 and the 

structural damping to 2.8 

Note. If damping values are specified 

for the first mode only, the other modes will take the same values. 

 Click the OK button to return to the Modal Dynamic Graph dialog. 

 On the main dialog, from the Modal Excitation drop down list select Support 

Motion 

 

 

Select this node at centre of

back plate
 

Utilities 

Graph Wizard… 
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 Click on the Modal excitation Set button and 

on the Support Motion dialog specify 

Acceleration in the Z direction. 

 Click the OK button to return to the Model 

Dynamics Graph dialog and click Next 

 

 

 

 On the Modal Frequency 

Domain dialog select the 

Displacement entity in the 

DZ direction. 

 Set the calculated entity as 

Acceleration of Type 

Amplitude. The selected 

node number at the centre of 

the back plate will be 

displayed in the drop down 

node list.  

 Set the sampling frequencies 

start, end and step entries to 

50, 3000 and 5 respectively. 

 Click Next 

 

 On the Display Graph dialog ensure that the Show symbols option is not selected.  

 In the Y Scale section select the Use logarithmic scale option. 

 Click on the Finish button and a graph of log acceleration against frequency will be 

plotted.  

 To specify axis labels and title right click on the graph and select Edit graph 

properties 

 On the General tab set the graph title to FRF in Z Direction at Centre of Back 

Plate (2.8% Structural Damping) 

 Click on the X Axis Style tab and set the axis name to Frequency (Hz) 
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 Click on the Y Axis Style tab and axis name to Log Acceleration (m/s^2) 

 Click OK to update the graph display. 

 Delete the graph window 

Power Spectral Density definition 

A Power Spectral Density (PSD) force input defines the frequency content of a random 

loading, such as turbulent pressure acting on an aircraft component. A PSD analysis is, 

therefore, useful when broadband random dynamic forces excite structural vibrations.  

Graph of PSD Stress Response 

 Click the left-hand mouse button in a blank part of the graphics window to clear the 

current selection. 

 Click the right-hand mouse button in a blank part of the graphics window and select 

the Advanced Selection option.  

 With the Type and name option selected, choose Node from the drop down list and 

enter the node number at which the maximum principal stress occurs (as noted 

down at an earlier stage in this example).  

 Click OK to add the node to the selection. 
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 To compute a PSD stress response select the Modal expansion option and click 

Next  

 On the Modal Dynamics Graph dialog choose the Frequency entity. 

 Under the damping section choose Specified values from the drop down list. Select 

the Set damping button and set the viscous damping to 0 and the structural damping 

to 2.8 and click OK 

 From the Excitation drop down list select Support Motion 

 Click on the Set button and under support motion specify Acceleration in the Z 

direction and click the OK button to return to the Model Dynamics Graph dialog. 

 Click Next to move to the next dialog. 

 On the Modal 

Frequency Domain 

dialog select entity 

Stress (top) – Thin 

Shell with component  

S1 

 Select PSD Response 

from the Type drop 

down list and click the 

PSD set button. 

 

 

 

 

Utilities 

Graph Wizard… 
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 On the RMS response for Power Spectral density dialog 

ensure the Linear/Linear scale option is selected and 

define a frequency PSD dataset using the frequency and 

amplitude values shown in the table on the right (Use the 

Tab key to create a new line in the table).  

 Label the dataset Frequency PSD and click OK 

 The selected node number will be displayed in the drop 

down node list. 

 Click the Next button. 

 On the Display Graph dialog deselect the Show grid 

option. Deselect the Show symbols option and select the Use Logarithmic scale 

option for the Y Scale.  

 Click the Finish button to plot a graph of log PSD against frequency.  

The RMS value of the input PSD and response PSD are written to the message window 

when the graph is plotted. 

Linear 

Frequency 

Linear 

Amplitude 

15 8 

100 14 

125 30 

500 31 

600 61 

900 108 

1000 79 

3000 47 
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To specify axis labels and title right-click on the graph and select Edit graph 

properties 

 On the General tab set the graph title to Top Surface Maximum Principal Stress 

(2.8% Structural Damping) 

 Click on the X Axis Style tab and set the axis name to Frequency (Hz) 

 Click on the Y Axis Style tab and axis name to Log PSD 

 Click OK to update the graph. 

 Do not delete the graph. It will be also used to plot the PSD input values. 
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PSD Input 

The PSD input data used in the acceleration of the supports can be plotted on the same 

graph by following the above procedure until the Modal Frequency Domain dialog is 

reached.  

 With the node at which maximum principal stress occurs still selected, follow the 

steps in creating the PSD Response graph starting with the Utilities > Graph 

Wizard menu option but, when the Model Frequency Domain dialog is displayed, 

instead of selecting PSD Response select PSD Input in the Type drop down list. 

 When the Display Graph dialog is reached, select the option to Include existing 

graph and include Graph 2 and ensure that the Show symbols is not selected 

 Click Finish to update the graph. 

 

This completes the example.
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Thermal Analysis of 

a Pipe 

For software product(s):  Any Plus version 

With product option(s): Thermal, Dynamics (for the second stage of the example) 

Description 

This example provides an introduction to 

performing a thermal analysis with LUSAS.  

 

A continuous steel pipe is exposed to an 

atmospheric temperature of 25
o
C. Oil at 150

o
C is 

to be pumped through the pipe. The pipe has a 

thermal conductivity of 60 J s
-1

 m
-1

 
o
C

-1
 , a 

specific heat capacity of 482 J kg
-1

 
o
C

-1
 and a 

density of 7800 kg/m
3
. Two analyses will be 

carried out. A steady state analysis is required to 

determine the maximum temperature of the outer 

surface of the pipe and a transient thermal 

analysis is then performed to find out the time it will take the surface to reach this 

temperature once pumping begins. 

The units of the analysis are N, m, kg, s, C throughout. 

 

Note. There are three transport mechanisms for heat energy; conduction, convection 

and radiation.  The first of these is defined as a material parameter, the others are 

defined within the load attributes as environmental variable and environmental 

temperatures. In this example, the effects of radiation are ignored. 

 

0.05m0.1m
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Objectives 

The objectives of the analysis are: 

 To determine the maximum temperature the outer surface of the pipe reaches 

during continual pumping. 

 To determine how long it will take for the maximum temperature to be reached 

once pumping of the oil begins. 
 

Keywords 

Thermal, Steady State, Transient, Environmental Temperature, Prescribed 

Temperature. 

  

Associated Files 

 pipe_modelling.vbs  carries out the modelling of the example. 
 
 

Modelling 

Running LUSAS Modeller 

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller 

in the Examples Manual Introduction. 

Creating a new model 

 Start a new model file. If an existing model is open Modeller will prompt for 

unsaved data to be saved before opening the new file. 

 Enter the file name as pipe  

 Use the Default working folder. 

 Enter the title as Steady State Thermal Analysis of Pipe 

 Set the model units as N,m,kg,s,C 

 Leave the Timescale units as Seconds 

 Change the analysis type to Thermal 

 Change the startup template to None 

 Select the Vertical Y Axis option and click the OK button. 



File 

New… 
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Note. Save the model regularly as the example progresses. Use the Undo button to 

correct any mistakes made since the last save was done. 

Feature Geometry 

The pipe geometry will be generated by defining a vertical line that will be swept into a 

quarter segment. This segment will then be copied to generate the full model. 

 Enter coordinates of (0, 0.1) and (0, 0.15) to define a vertical line and click the 

OK button. 

 Select the line  

 On the Sweep dialog, choose the Rotate option and enter a rotation angle of 90 

about the Z-axis. 

 Leave the other options and click the OK button. 

 Select the Surface 

 In the Copy dialog, select the Rotate 

option.  

 Enter an Angle of 90 about the Z-axis 

 Enter the number of copies as  3 

 Click OK to create the full pipe cross 

section. 

 

 

 

Meshing 

Plane field elements are to be used for this analysis. These elements are used to model 

the cross section of ‘infinite’ components since they only model heat flow in the XY 

plane. 

 



Geometry 

Line > 

Coordinates... 

Geometry 

Surface > 

By Sweeping... 

 

Geometry 

Surface > 

Copy... 
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 Select Plane field, 

Quadrilateral shaped, Linear 

elements. 

 Deselect Allow transition 

pattern 

 Enter the attribute name as 2D 

Thermal Mesh and click the 

OK button. 

 

 

 

 

 

 

 

 

 Use Ctrl + A to select all the 

features. 

 Drag and drop the mesh attribute 2D 

Thermal Mesh from the  

Treeview onto the selection to assign 

the mesh to the selected surfaces. 

 

 

 

 

Geometric Properties 

Geometric properties are used to define the thickness of the pipe. Since the pipe is of 

infinite length a unit length is modelled. 

 Enter a thickness of 1 and leave the eccentricity blank. 

 Enter the attribute name as Thickness and click the OK button. 

 Select all the surfaces and assign the attribute Thickness 

 Select the fleshing on/off button to turn-off geometric property visualisation. 

 

Attributes 

Mesh > 

Surface.. 

 

Attributes 

Geometric > 

Surface... 
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Material Properties 

Within LUSAS the specific heat is defined as a massless quantity. In order to calculate 

this quantity, the standard specific heat capacity for a material is multiplied by the 

density. The result is a material parameter in the correct massless units, in this case J m
-

3
 C

-1
. 

The materials in this example have properties of steel.  

 On the Isotropic dialog enter the thermal conductivity as 60 

 Enter the specific heat as 3.7596E6  

 Enter the attribute name as Steel (J,m,C) and click the OK button. 

 Assign the material attribute Steel (J,m,C) to the surfaces. 

Boundary Conditions 

Unsupported nodes in thermal analyses are assumed to be perfect insulators. The 

environmental conditions are defined using environmental loading. This loading defines 

the amount of convection to the environment that occurs. 

 Select the 

Environmental 

Temperature 

option and click 

Next  

 On the 

Environmental 

Temperature dialog 

enter the 

environmental 

temperature as 25 

 Enter the 

convective heat 

transfer coefficient 

as 500 

 Since radiation is to 

be ignored set the 

radiation heat transfer coefficient to 0 

 Enter the attribute name as Environmental Temperature and click the Finish 

button. 

Attributes 

Material > 

Isotropic… 

Attributes 

Loading… 
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 Select the 4 lines defining the outside of the pipe and assign the attribute 

Environmental Temperature to the these lines Ensure the option to Assign to 

lines is selected. Ensure Analysis 1 and Loadcase 1 are selected. Click OK to 

finish the assignment. 

The pipe is heated by the oil 

passing along inside the 

pipe. This is modelled using 

a prescribed heat input 

assigned to the lines defining 

the inner surface of the pipe. 

 Select the Prescribed 

Temperature option and 

click Next 

 On the Prescribed 

Temperature dialog enter 

a temperature of 150 

 Ensure that the Total 

Prescribed temperature 

loading option is 

selected. 

 Enter an attribute name of Oil Temperature and click the Finish button. 

 Select the 4 lines defining the inner surface of the pipe and assign the attribute Oil 

Temperature to the these lines. Ensure the option to Assign to lines is selected and 

Analysis 1/Loadcase 1. Click OK to finish the assignment 

Saving the model 

 Save the model file. 

 

Running the Analysis 

 Open the Solve Now dialog and press OK to run the analysis. 

 

Attributes 

Loading… 

File 

Save 

File 

LUSAS Datafile... 
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If the analysis is successful... 

Analysis loadcase results are added to the  Treeview.  

In addition, 2 files will be created in the Associated Model Data directory where the 

model file resides: 

 Pipe.out  this output file contains details of model data, assigned attributes 

and selected statistics of the analysis. 

 Pipe.mys  this is the LUSAS results file which is loaded automatically into 

the Treeview to allow results processing to take place. 
 

If the analysis fails... 

If the analysis fails, information relating to the nature of the error encountered can be 

written to an output file in addition to the text output window.  Any errors listed in the 

text output window should be corrected in LUSAS Modeller before saving the model 

and re-running the analysis.  

Rebuilding a Model  

If it proves impossible for you to correct the errors reported a file is provided to enable 

you to re-create the model from scratch and run an analysis successfully. 

 Pipe_modelling.vbs  carries out the modelling of the example. 
 
 

 Start a new model file. If an existing model is open Modeller will prompt for 

unsaved data to be saved before opening the new file. 

 Enter the file name as pipe  

 Change the user interface to Thermal 

To recreate the model, select the file pipe_modelling.vbs located in the \<LUSAS 

Installation Folder>\Examples\Modeller
 
directory. 

 

 Rerun the analysis to generate the results 

Viewing the Results 

Analysis loadcase results are present in the  Treeview, and the  results for loadcase 1 

will be set active by default. 

 Turn off the Geometry layer in the  Treeview. 





File 

New… 

File 

Script > 

Run Script... 
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 If necessary any visualised thermal loadings can be removed by deselecting 

Visualise Assignments from both thermal loading datasets in the   Treeview. 

Temperature Contours 

With no features selected, click the 

right-hand mouse button in a blank 

part of the Graphics window and 

select the Contours option to add the 

Contours layer to the  Treeview. 

The contour plot properties will be 

displayed. 

 Select Potential contour results 

component PHI  

 Click the OK button.  

 

From the analysis it can be seen that the maximum temperature the outer surface of the 

pipe reaches is 108.5 
o
C. 

Note. If Plane field elements with 

quadratic interpolation order were to 

be used instead of elements with 

linear interpolation order the true 

shape of the pipe would be seen – as 

shown on the image to the right. The 

difference between the results, 

however, is negligible for this 

example. 

 

 

 

 

This completes the steady state part of the example. 
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Transient Thermal Analysis  

For software product(s):  Any Plus version 

With product option(s): Thermal, Dynamics. 

 

This part of the example extends the previously defined pipe model used for the steady 

state analysis. A file is supplied that can be used to recreate the model if required.  

If you are continuing from the first part of the example you have the option to save your 

model file as pipe_transient.mdl and continue from the heading ‘Setting up the 

Starting Conditions’. Otherwise you can use one of the supplied scripts to re-create a 

suitable model as follows: 

Creating a new model (if required) 

 Start a new model file. If an existing model is open Modeller will prompt for 

unsaved data to be saved before opening the new file. 

 Enter the file name as pipe_transient  

 To create the model, import the file pipe_modelling.vbs located in the \<LUSAS 

Installation Folder>\Examples\Modeller
 
directory. 

Setting up the Starting Conditions 

The first step of a transient analysis is used to establish the steady state conditions 

before any heat is input. In this example this means the oil temperature needs to be 

removed from the first loadcase to allow the pipe to reach the environmental 

temperature before the oil temperature is introduced and the transient analysis begins.  

 If present, turn off the Contours layer in the  Treeview 

 Ensure the Geometry, Mesh and Attributes layers are present and turned on in the 

 Treeview 

 In the  Treeview click the right-hand mouse button on the Oil Temperature 

attribute and choose the Deassign> From all option.  

Now we define how the transient analysis should take place: 

 Expand Analysis 1 then, using the right-hand mouse button, click on Loadcase 1 in 

the  Treeview and select Nonlinear & Transient from the Controls menu. 

File 

New… 

File 

Script > 

Run Script... 



Thermal Analysis of a Pipe 

 180 

 

 Select the Time domain option. 

 Ensure Thermal is selected in the drop down list. 

 Enter an Initial time step of 0.001 

 Leave the Total response time set to 100E6 

 In the Common to all section, enter the Max time steps or increments as 1 

 Click the OK button. 

Setting up the Transient Analysis 

Once the starting conditions have been established the transient analysis can begin. The 

heat input is assigned to the inner surface of the pipe and the time stepping regime is 

defined. 

Firstly reapply the environment temperature, which represents the atmospheric 

temperature. 

 In the  Treeview click on the attribute Environmental Temperature with the 

right-hand mouse button and choose the Select Assignments option. This will select 

the lines that are currently using this attribute.  
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 Drag and drop the attribute Environmental Temperature onto the graphics 

window to assign the attribute to Analysis 1 and edit the loadcase name in the drop 

down list to be Loadcase 2 by overtyping. Click the OK button. This will introduce 

Loadcase 2 into the  Treeview. 

Now apply the Oil Temperature.  

 Select the four lines defining the inner surface of the pipe. 

 Assign the dataset Oil Temperature to these Lines selecting Loadcase 2. Click OK 

to finish the assignment. 

 Using the right-hand mouse button click on Loadcase 2 in the  Treeview and 

select Nonlinear & Transient from the Controls menu. 

 

 Select the Time domain option. 

 Ensure Thermal is selected in the drop down list. 

 Enter an Initial time step of 10 

 In the Common to all section enter the Max time steps or increments as 120 

 Click the OK button. 
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Saving the model 

 Save the model file. 

 

Running the Analysis 

 Open the Solve Now dialog and press OK to re-run the analysis. 

A LUSAS Datafile will be created from the model information. The LUSAS Solver 

uses this datafile to perform the analysis. 

Viewing the Results 

The loadcase results can be seen in the  Treeview. For a nonlinear analysis the last 

solved loadcase increment will be set active by default. 

To establish the time taken to reach the steady state condition a graph of external 

temperature verse response time is to be generated. 

 First, select the node on the outside of the pipe 

as shown. 

 Choose the Time history option and click on 

the Next button 

Firstly we define the X axis data. 

 Select the Named option and click the Next 

button. 

 Choose Response Time from the drop down list 

and click the Next button. 

Then we define the Y axis data 

 Select the Nodal option and click the Next 

button. 

 Select Entity Potential component PHI 

 Select Specified single node from the Extent drop down list and the selected node 

number will appear in the Selected Node drop down list. 

 Click the Next button. 

File 

Save 

Select this Node

 

Utilities 

Graph Wizard... 
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It is not necessary to input the graph titles at this stage. They can always be modified 

later.  

 Ensure Use logarithmic scale is not selected. 

 Deselect the Show symbols option 

 Click on the Finish button to display the graph showing the variation of temperature 

on the outer surface of the pipe with time. 

 

From the graph it can be seen that the outside of the pipe reaches its steady state 

condition after approximately 300 seconds. 

 

This completes the transient thermal example. 

 

 

 

 

 

 

 



Thermal Analysis of a Pipe 

 184 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Description 

 185 

Linear Analysis of a 

Composite Strip  

 

For software product(s):  LUSAS Composite Plus 

With product option(s): None 

Description 

All Dimensions in mm

Distributed Loading

Simply supported

This quarter only to

be modelled

15

15

105

5

 

A 50mm x 10mm x 1mm thick composite strip, composed of an 8-layer composite 

material is to be analysed first using shell elements and then using solid elements in 

order to compare the results obtained.  

The strip is loaded with a global distributed line load of 10N/mm on the centreline as 

shown. The composite strip has two axes of symmetry therefore only a quarter of the 

strip needs to be modelled. Symmetry boundary conditions are to be simulated by 

applying supports on the appropriate Lines. The geometry of the strip and support 

positions are as shown. 

Units used are N, mm, t, s, C throughout. 

 Analysis 1 Surface features meshed with thick shell composite elements. 
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 Analysis 2 Volume features meshed with solid composite elements 
  

Objectives 

The output from the shell analysis will consist of: 

 Deformed Mesh Plot showing displacements with peak values annotated. 

 Bending Stress Contour Plot showing the direct stresses on the bottom Surface. 
  
The output from the solid analysis will consist of: 

 Deformed Mesh Plot showing displacements with peak values annotated. 

 Bending Stress Contour Plot showing the direct stress on the bottom Surface of 

layer 1. 

 Shear Stress Contour Plot showing the interlamina shear stress on the top 

Surface of layer 1. 
 

Keywords 

2D, 3D, Composite, Shell, Solid, Lay-up. Interlamina Shear, Failure Criteria, Tsai-

Wu 

Associated Files 

 strip_shell_modelling.vbs  carries out the modelling of the example 

using shell elements. 

 strip_solid_modelling.vbs  carries out the modelling of the example 

using solid elements. 

Modelling : Shell Model 

Running LUSAS Modeller 

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller 

in the Examples Manual Introduction. 

Note. This example is written assuming a new LUSAS Modeller session has been 

started. If continuing from an existing Modeller session select the menu command 

File>New to start a new model file. Modeller will prompt for any unsaved data and 

display the New Model dialog. 

Creating a new model 

 Enter the file name as strip_shell 


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 Use the Default working folder. 

 Enter the title as Composite Strip - Shell Model 

 Set the model units to N,mm,t,s,C 

 Ensure that timescale units are Seconds 

 Ensure an analysis type of Structural is set. 

 Select the Composite startup template. This populates the Attributes  Treeview 

with useful mesh, geometric and support entries. 

 Select the Vertical Z axis option and click the OK button. 

Note. Save the model regularly as the example progresses. Use the Undo button to 

correct any mistakes made since the last save was done. 

Defining the Geometry 

 Enter coordinates of (0,0), (10,0), (10,5) and (0,5) 

and click OK to define the first Surface. 

 Select the Line on the right hand side as shown. 

 

 Enter a translation 

distance of 15 in the X 

direction. 

 Click the OK button to 

create a new Surface. 

Meshing 

The Surfaces are to be meshed using thick shell elements. LUSAS provides a composite 

surface mesh attribute by default. This can be seen in the  Treeview. A thick shell 

element (QTS4) is used. 

 Select the whole model. (Using the Ctrl and A keys together). 

 Drag and drop the surface mesh attribute Composite Shell from the  Treeview 

onto the selected features.  



Geometry 

Surface > 

Coordinates... 

Select this Line

 

 

Geometry 

Surface > 

By Sweeping… 
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Modeller will draw a 

mesh based upon a default 

of 4 Line divisions per 

Line. This mesh density 

will be altered by using 

Line mesh datasets. 

Note. A number of Line mesh attribute are provided by LUSAS by default. These can 

simply be dragged and dropped onto the features to which they are to be assigned. 

With the whole 

model selected: 

 Drag and drop 

the Line mesh 

attribute 

Divisions=2 

from the  

Treeview onto 

the selected 

features. 

 Select the 2 horizontal Lines on the right-hand side of the model. (Hold the Shift 

key down to add to the initial line selection). 

 Drag and drop the Line mesh attribute Divisions=3 from the  Treeview onto the 

selected features. This overwrites the previous Line mesh assignment. 

Checking Local Element Directions 

In creating the second Surface from the first the orientation of the Surface axes will not 

necessarily be the same. In this example the local element directions should be checked 

because the composite lay-ups which are defined later in this example are assigned to 

the model using the local element axes. 

  Use the isometric 

rotation button to rotate the 

model to a similar view to 

that shown. 

Note. If manually rotating 

the model pressing the Ctrl 

key at the same time will 

rotate the model in the plane 

of the screen. 

 



Select these 2 Lines for Line mesk 'Divisions=3'

Select all Lines for Line mesh 'Divisions=2'
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 In the  Treeview double 

click Mesh and select the 

Show element axes 

option. 

 Click the OK button to 

display the element axes. 

The element axes in the right-

hand section of the model 

need to be re-oriented to lie 

along the global X axis. 

Changing the Element Directions 

 Select the right-hand 

Surface of the model.  

The orientation of the 

elements needs to be rotated 

to align them with the global 

X axis. 

 Click Apply to rotate the 

axis by 90 degrees each 

time, until the x axis 

match with those of the 

left-hand surface. 

The orientation of the elements will rotate to align the with the global Y axis. 

In the  Treeview double click the Mesh layer. 

 De-select the  Show element axes  option and click the OK button. 

Defining the Geometric Properties 

The strip is 1mm thick. A geometric property attribute of unity thickness is provided by 

default. This can be used to define the thickness of the Surfaces. 

 Select the whole model and drag and drop the geometry attribute Unit Thickness 

from the  Treeview onto the selected features. If the fleshing option is turned on 

the assigned geometric property will be automatically visualised. 

 Select the fleshing on/off button to turn-off geometric property visualisation. 

 

 

Geometry 

Surface > 

Cycle… 

Geometry 

Surface > 

Reverse 
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Note. Once assigned to the model, attributes such as geometric assignments may be 

visualised. 

 In the  Treeview click the right-hand mouse button on the geometry attribute 

Unit Thickness. Select Visualise Assignments to show where the attribute has been 

assigned to the model.  

 Follow a similar process and deselect Visualise Assignments to hide the attribute 

display again. 

Defining the Composite Material Properties 

The material properties of the strip will be modelled as a composite lay-up made up 

from 8 lamina each defined as an orthotropic material. Whilst LUSAS provides a range 

of composite material types by default this example is based upon a test study and 

requires specific material data to be defined. 

To define the orthotropic material: 

 With the Elastic tab displayed, select a Solid model from the drop down list. 

 Enter the Young's Modulus in the X direction as 1E5, in Y as 5000 and in Z as 5000 

 Enter the shear modulus in the XY plane as 3000, and in YZ and ZX as 2000 

 Finally, enter Poisson's ratio as 0.4 in the XY plane, and 0.3 in the other two planes. 

It is not necessary to enter the mass density.  

 Enter the attribute name as Strip Material and click the OK button to add the 

material attribute to the  Treeview. This will be assigned to the model later in the 

example. 



Attributes 

Material > 

Orthotropic… 
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Defining the Composite Lay-up Arrangement 

Details of the composite stack are shown in the 

attached table. The stack is symmetrical about the 

mid plane.  This enables the input of the stack to 

be reduced by using the symmetric option. 

 

 

 

 

 

 

Lamina  

Name 
Thickness Angle 

Lamina1 0.1 0 

Lamina2 0.1 90 

Lamina3 0.1 0 

Lamina4 0.2 90 
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 Select the Solids and 

Shells option and click 

Next 

 Ensure that the Normal 

tab is displayed for 

shells and solids. 

 Select the New button 

to enter the composite 

lay-up details. 

 

 

 

 

 

 

 

The Add Lamina dialog will appear. 

The Name for the first lamina will be 

automatically entered as Lamina1 

The material will automatically be 

entered as Strip material 

 Change the lamina thickness to 

0.1 

 Enter the angle as 0 

 Click the Apply button to define the lamina. 

Enter lamina 2, 3 and 4 in a similar manner using the values in the previous table. Click 

Apply after each lamina is defined. Note layer 4 has a different thickness to the other 

layers. Click OK when all are defined. 

 On the Solids and Shells dialog select the Symmetric option. 

 Enter the composite attribute name as Strip Layup 

 

Attributes 

Composite… 
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Now check the composite input 

 On the Composite 

Materials dialog, select 

the Grid tab. 

 Ensure that the values 

are as shown. Correct on 

this grid if necessary. 

Note. Whilst this example 

shows laminate thicknesses 

being defined that sum-up 

to the geometric thickness 

of the strip, lamina 

thicknesses for shell models that have been assigned a geometric thickness are actually 

relative values, not absolute, and represent the proportion of the total thickness (as 

specified by geometric surface properties) apportioned to each lamina. 

Visualising the Composite Lay-up arrangement 

 On the Solids and Shells dialog, select Visualise to view the lay-up sequence. 

 Click the Close button to return to the 

Composite Materials dialog.  

 Click the Finish button to add the 

composite material attribute to the  

Treeview. 

Note. The lay-up sequence always builds 

from the bottom to the top. In this example, 

Lamina1 is the bottom lamina in the stack. 

Note. Composite lay-up data may also be 

defined in external spreadsheets for copying 

and pasting into the composite layup Grid 

using the standard copy (Ctrl + C) and paste 

(Ctrl + V) keys.  
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Assigning the Composite Lay-up Arrangement 

 To assign the composite attribute to the model, drag a box around the model to 

select all the features. 

 Drag and drop the attribute Strip Lay-up from the  Treeview onto the selected 

features. 

 On the Assign Composite dialog, ensure 

that Assign to Surfaces and that Local 

Element Axes are selected. 

 Click the OK button. 

Note. In a composite analysis, assigning the 

composite material lay-up automatically 

assigns the material attribute to the model at 

the same time. The composite material 

attribute therefore does not have to be directly 

assigned to features. 

Checking the composite orientation 

To check the orientation of each composite lamina is correct.  

 Select the  Treeview and double click on the Attributes entry to display the 

attribute layer properties. 

 Select the Composite tab and select the Strip Layup check box option.  

 Click on the Settings 

button and ensure the 

option to Visualise ply 

directions is selected. 

 Click OK and OK again. 

 In the  Treeview expand 

the Composite Strip layup 

entry and right-click on the 

lamina you wish to check 

and Set Lamina Active 

 When you are satisfied the orientations are correct deselect this visualisation by 

selecting the  Treeview, double clicking on the Attributes entry, selecting the 

Composite tab and deselecting the Strip Layup option. 
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Supports 

By using LUSAS templates the more common types of support are provided by default. 

These can be seen in the  Treeview. The model will be supported in the Z direction 

at the internal Line between the two Surfaces. 

 Select the internal Line 

shown  

 Drag and drop the support 

attribute Fixed in Z from 

the  Treeview onto the 

selected feature, click OK 

ensuring that it is assigned 

to All analysis loadcases 

The supports will be visualised. 

 

Defining Symmetry Support Conditions 

LUSAS provides symmetry boundary conditions by default. These can be seen in the 

 Treeview. As only a quarter of the structure has been modelled the symmetry 

boundary conditions are assigned to two sides of the model.  

 Select the 2 upper 

Lines of the model as 

shown  

 Drag and drop the 

support attribute 

Symmetry XZ from 

the  Treeview 

onto the selected 

features. 

 Click OK to 

visualise the 

supports. 

 Select the right-hand Line of the model as shown. 

 Drag and drop the support attribute Symmetry YZ from the  Treeview onto the 

selected Line. 

 Click OK to visualise the supports. 

Select this Line for 'Fixed in Z' support

 

Select these 2 Lines for support

'Symmetry XZ Plane'

Select this Line for support

'Symmetry YZ Plane'
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Loading  

The model will be subjected to a load per unit length of 5 N/mm acting in the negative 

Z direction along the right-hand line which represents the mid-span centre-line of the 

strip. 

Note. The composite strip is modelled using a quarter model and the Line of load 

application coincides with one of the Lines of symmetry. The value of applied load is 

therefore half of that applied to the full model. 

 Select the Global Distributed option and click Next 

 On the Global Distributed dialog select the Per Unit Length option. 

 Enter a value of -5 in the Z direction.  

 Enter the attribute name as Global Distributed 

 Click the Finish button to add the loading attribute to the  Treeview. 

 Select the Line on the 

right of the model as 

shown. 

 Drag and drop the 

loading attribute 

Global Distributed 

from the  Treeview 

onto the selected Line. 

 Click the OK button 

to assign the load to 

the selected Lines and 

to accept the default 

loadcase. 

The loading will be visualised. 

Saving the model 

The model is now complete and the model data must be saved. 

 Save the model file.  

 


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Loading… 

Select this Line

 

File 

Save 
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Running the Analysis 

 Open the Solve Now dialog and click OK to run the analysis. 

A LUSAS Datafile will be created from the model information. The LUSAS Solver 

uses this datafile to perform the analysis. 

If the analysis is successful... 

Analysis loadcase results are added to the  Treeview.  

In addition, 2 files will be created in the Associated  Model Data directory where the 

model file resides: 

 strip_shell.out  this output file contains details of model data, assigned 

attributes and selected statistics of the analysis. 

 strip_shell.mys  this is the LUSAS results file which is loaded 

automatically into the  Treeview to allow results processing to take place. 
 

If the analysis fails... 

If the analysis fails, information relating to the nature of the error encountered can be 

written to an output file in addition to the text output window.  Any errors listed in the 

text output window should be corrected in LUSAS Modeller before saving the model 

and re-running the analysis.  

Rebuilding a Model  

If it proves impossible for you to correct the errors reported a file is provided to enable 

you to re-create the model from scratch and run an analysis successfully. 

 strip_shell_modelling.vbs  carries out the modelling of the example.  
 
 

 Start a new model file. If an existing model is open Modeller will prompt for 

unsaved data to be saved before opening the new file. 

 Enter the file name as strip_shell 

To recreate the model, select the file strip_shell_modelling.vbs located in the 

\<LUSAS Installation Folder>\Examples\Modeller
 
directory. 

 

 Rerun the analysis to generate the results 


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File 

New… 

File 

Script > 

Run Script... 
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Viewing the Results 

Analysis loadcase results are present in the  Treeview. 

  If necessary, use the isometric 

rotation button to rotate the model 

to a similar view to that shown.  

 

 

 

 

Plotting peak vertical displacements 

 In the  Treeview turn off the Attributes, Deformed Mesh and Geometry layers 

by right-clicking on the layer name and selecting the On/Off menu item. 

 With no features selected click the right-hand mouse button in a blank part of the 

Graphics window and select Values to add the Values layer to the  Treeview. 

The values properties dialog will be displayed. 

 With the Value Results tab 

selected, select entity results 

for Displacement of 

component DZ. 

(Displacement in the Z 

direction). 

 Select the Values Display 

tab, de-select Maxima and 

specify that 0 % of the 

Minima displacement 

values are to be plotted 

 Click the OK button to display peak values of vertical displacement. 

 Turn off the Values layer in the  Treeview. 
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Stress contour plots for lamina 

Note. For shell models the lamina results are output for the middle of each lamina 

selected. 

 Click the right-hand mouse button in a blank part of the graphics window and select 

Contours to add the contours layer to the  Treeview. 

The Contour Properties dialog will be displayed. 

 Select the Stress - Thick Shell lamina entity of stress Sx 

Note.  By default, the stresses will be calculated in the lamina material direction. The 

Transform button in the  Treeview can be used to transform stresses into global or 

user defined directions.  

 Click the OK button to display contours and the associated contour key. 

 In the  Treeview, in the 

Composite Strip Layup 

section, right-click on 

Lamina1 and Set Lamina 

Active.  

The contour key should be 

showing a maximum value of 

519.1 

 To display the mesh on top of 

the contours select the Mesh entry in the  Treeview and drag and drop it on top 

of the Contour entry in the  Treeview. 

 By selecting different lamina from the Composite Strip layup entry in the   

Treeview, the stresses throughout the composite strip can investigated. 

Note.  Because there are discontinuities between laminae the stress plots produced 

will always be for un-averaged results. 

Interlamina shear plots 

 In the  Treeview double-click the Contours layer to display the contour layer 

properties. 

 Select the Stress - Thick Shell lamina entity of stress Szx 


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 Click the OK button to display 

contours and the associated 

contour key for the active 

lamina. 

 

 

 

Modelling : Solid Model 

The composite strip in this example is now to be modelled using solid composite brick 

elements meshed onto Volumes. This is to compare the accuracy of the results obtained 

for each modelling method. 

If successfully created in the first part of this example, the shell composite model can be 

extended to create the solid composite model. If the model was not successfully created 

a suitable model can be built from a supplied file. See below for details. 

Extending the current shell model 

 To continue directly from the shell model toggle the menu entry 

Utilities>Mesh>Mesh Lock to ensure the Mesh Lock option is deselected and click 

Yes to confirm the closing of the results files. 

 Enter the model file name as strip_solid and click the Save button. 

 Ensure that only the Geometry, Attributes and Mesh layers are present and turned 

on in the   Treeview. 

Creating a suitable model from a supplied file 

 Start a new model file. If an existing model is open Modeller will prompt for 

unsaved data to be saved before opening the new file. 

 Enter the file name as strip_solid 

To recreate the model, import the file strip_shell_modelling.vbs located in the 

\<LUSAS Installation Folder>\Examples\Modeller
 
directory. 

Changing the model description 

 Change the model description to Composite strip - solid model and click OK 

 

File 

Save As... 

File 

New… 

File 

Script > 

Run Script... 

File 

Model Properties… 
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Converting the Model from Shells to Solids 

To convert the 2D model that uses Surfaces into a 3D model that uses Volumes a 

number of attributes assigned to the 2D model need to be deassigned. This is to prevent 

them being copied when the Surfaces are swept to create a 3D model. 

Note. In the following tasks, take care to deassign and NOT delete the Loading, 

Support attribute, Composite strip lay-up attribute or the Geometric material attribute 

from the  Treeview. 

Deassigning the loading 

 In the  Treeview click the right-hand mouse button on the loading attribute  

Global Distributed and select Deassign>From all 

Deassigning the supports 

 In the  Treeview, click the right-hand mouse button on the support attribute  

Fixed in Z, and select Deassign>From all 

 In the  Treeview, click the right-hand mouse button on the support attribute  

Symmetry XZ, and select Deassign>From all.  

 In the  Treeview, click the right-hand mouse button on the support attribute  

Symmetry YZ, and select Deassign>From all.  

Deassigning the composite material arrangement 

 Using the method described previously, deassign the composite attribute Strip 

Layup from the model. 

Deassign the geometry  

 Using the method described previously, deassign the geometry attribute Unit 

Thickness from all Surfaces on the model. 

Deassigning the Surface mesh 

 Using the method described previously, deassign the surface mesh attribute 

Composite Shell from the model. 

Note. When the an attribute is de-assigned from the model such that it is not used on 

any feature the assigned attribute symbol will change from its coloured form  to its 

unassigned grey form . 
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In the  Treeview the only assigned attribute left after this de-assignment process 

should be the 2 and 3 line mesh divisions and the strip material. 

Default mesh divisions 

The Lines on the model have been assigned different Line mesh divisions earlier in the 

example. However, the default number of line mesh divisions is still set by default to be 

4. If the existing surfaces were swept to create volumes any newly created lines between 

the top and bottom surfaces would have the default of 4 mesh divisions per line 

assigned to them when in fact only one mesh division per line is required.  

To adjust the default number of mesh divisions 

 Select the Meshing tab. Set the default number of divisions to be 1 and click OK 

Modifying the Geometry 

The 2D model will now be swept into 3D 

by sweeping the existing two Surfaces to 

create two  Volumes. 

 Select the whole model. 

 Enter a translation in the Z direction 

of 1 and click OK 

 If necessary use the isometric 

rotation button to rotate the model as shown. 

Note. With Composite analysis models the thickness of the volume defines the 

thickness of the strip and no geometric property thickness is required to be assigned to 

the model.  

Whilst this example shows laminate thicknesses being defined that sum-up to the 

thickness of the volume, lamina thicknesses for solid models comprised of pentahedral 

and hexahedral composite elements are relative, not absolute, and represent the 

proportion of the total space that the elements of the volume represent apportioned to 

each lamina. 

Meshing 

A Volume mesh is to be defined. LUSAS provides a number of volume mesh attribute 

by default. These can be seen in the  Treeview. The composite brick element to be 

used has a hexahedral element shape and a quadratic interpolation order. 

File 

Model Properties… 

 

Geometry 

Volume > 

By Sweeping... 
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 Select the whole model 

 Drag and drop the Volume mesh 

attribute Composite Brick (HX16L) 

from the  Treeview onto the 

selected features.  

Note. The Line mesh divisions (defined 

in the shell model of this example) are 

used to create the mesh arrangement for 

the top and bottom Surfaces. The default 

number of Line mesh divisions are used for each swept Line on the side Surfaces. 

Assigning Composite Properties 

 With the whole model selected, drag and drop the Composite material attribute 

Strip Lay-up from the  Treeview onto the selected features ensuring that it is 

assigned to Volumes using Local element axes. Click OK to carry out the 

assignment. 

Note. The lamina thicknesses for solid models comprised of pentahedral and 

hexahedral composite elements are relative values, not absolute, and represent the 

proportion of the total space that the elements of the volume represent apportioned to 

each lamina. 

Loading 

 Select the upper Line shown right. 

 Drag and drop the loading attribute 

Global Distributed from the  

Treeview onto the selected feature 

and click OK  

 

 

 


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Select this

upper Line
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Supports 

 Select the lower internal line as 

shown.  

 Drag and drop the support attribute 

Fixed in Z from the  Treeview onto 

the selected feature, Click OK 

ensuring that Assign to lines is 

selected for All loadcases 

 

In order to model the boundary conditions the supports must be assigned to the Surfaces 

that are, in effect, axes of symmetry for the entire strip. These supports are easier to 

assign on a view along the global Z axis. 

 Set the view direction along the global Z axis by pressing the Z axis button 

on the status bar at the bottom of the graphics window. 

 Drag a box around the 

2 upper Surfaces of 

the model and drag 

and drop the support 

attribute Symmetry 

XZ from the  

Treeview onto the 

selected features, Click OK ensuring that Assign to surfaces is selected for All 

analysis loadcases 

 Drag a box around the 

right-hand Surface of 

the model and drag 

and drop the support 

attribute Symmetry 

YZ from the  

Treeview onto the 

selected features, 

Click OK ensuring 

that Assign to surfaces is selected for All analysis loadcases 

Select this lower Line
 

Select these 2 Surfaces

 

Select this Surface
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 To view the applied 

supports use the isometric 

rotation button. 

 

Save the model 

The model is now complete.  

 Save the model file. 

 

Running the Analysis 

 Open the Solve Now dialog and press OK to run the analysis. 

A LUSAS Datafile will be created from the model information. The LUSAS Solver 

uses this datafile to perform the analysis. 

If the analysis is successful... 

Analysis loadcase results are added to the  Treeview.  

In addition, 2 files will be created in the Associated Model Data directory where the 

model file resides: 

 strip_solid.out  this output file contains details of model data, assigned 

attributes and selected statistics of the analysis. 

 strip_solid.mys  this is the LUSAS results file which is loaded 

automatically into the  Treeview to allow results processing to take place. 
 

If the analysis fails... 

Use a text editor to view the output file and search for ‘ERROR’. Any errors listed in 

the output file should be fixed in LUSAS Modeller before saving the model and re-

running the analysis.  

Rebuilding the Model 

If errors are listed that for some reason you cannot correct, a file is provided to re-

create the model information correctly, allowing a subsequent analysis to be run 

successfully. 

 

File 

Save 
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 strip_solid_modelling.vbs  carries out the modelling of the example.  
 
 

 Start a new model file. If an existing model is open Modeller will prompt for 

unsaved data to be saved before opening the new file. 

 Enter the file name as strip_solid 

To recreate the model, select the file strip_solid_modelling.vbs located in the 

\<LUSAS Installation Folder>\Examples\Modeller
 
directory. 

 

 Rerun the analysis to generate the results 

 

Viewing the Results 

 Ensure that only the Geometry, 

Attributes and Mesh layers are 

present and turned on in the   

Treeview. 

 If necessary, use the isometric 

rotation button to rotate the model 

as shown. 

 

Plotting peak vertical 

displacements 

 With no features selected click the right-hand mouse button in a blank part of the 

graphics window and select Values to add the values layer to the  Treeview. 

The values properties dialog will be displayed. 

 With the Value Results tab selected, select Displacement results of displacement in 

the Z direction, DZ 

 Select the Values Display tab, de-select Maxima and specify that 0 % of the 

Minima displacement values are to be plotted. 
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File 

New… 

File 

Script > 

Run Script... 

File 

LUSAS Datafile... 
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 Click the OK button to display 

the peak values of vertical 

displacement. 

 Turn off the Values layer in the  

 Treeview. 

 

 

 

Stress contour plots for lamina 

Note. For solid models the lamina results can be selected for the top, middle or the 

bottom of any selected lamina. 

 With no features selected click the right-hand mouse button in a blank part of the 

graphics window and select Contours to add the contours layer to the  Treeview. 

The contour Properties dialog will be displayed. 

 Select entity results of Stress - Solids lamina (bottom) of component Sx and click 

the OK button. 

 In the  Treeview expand 

the Composite Strip layup 

entry and right-click on the 

Lamina1 and Set Lamina 

Active 

The contour key should be 

showing a maximum stress in 

the lamina X direction of 679.4 

 By re-ordering the layers in 

the  Treeview the mesh 

can be viewed on top of the 

contour results. 
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Interlamina shear plots 

 In the  Treeview double-click the Contours layer to display the contour layer 

properties. 

 Select Stress - Solids lamina 

(top) contour results of stress 

Szx 

 Click the OK button to 

update the contours, 

The contour key should be 

showing a minimum value of  

-8.06 for Lamina 1. 

 

 

Defining Failure Strength 

The failure strength dialog will 

appear. 

 Enter the Dataset title as Layer 

Strength 

 Enter the Longitudinal Tensile 

Strength as 1978 

 Enter the Transverse Tensile 

Strength as 48.69 

 Enter the Longitudinal 

Compressive Strength as 1978 

 Enter the Transverse 

Compressive Strength as 48.69 

 Enter the Shear Strength as 133 

 Leave the interaction type as Default and click OK 

 

 

 

Composite 

Composite Failure… 
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Assigning Failure Strength 

The failure strength is assigned to the geometry.  

 Select the whole model. 

 From the  Treeview drag and drop Layer Strength onto the selected features and 

click OK to Assign to volumes 

Plotting contours of Failure Criteria 

 In the  Treeview double-click the Contours layer. 

 Select Stress - Solids lamina (bottom) contour results of Tsai-Wu failure, Tsai 

Wu. By default, the stresses will be shown in the laminate material direction. 

 Select the Contour Display tab and pick the Contour Key Details button, change 

the number of significant figures to 4 and deselect the Show minimum value 

option. 

 Click OK to update the 

contour key details and 

OK again to display 

contours of the Tsai Wu 

failure criteria. 

Note. Values greater than 

unity show that the material 

has exceeded the failure 

criteria.  

In this example the 

maximum failure value 

(shown on the contour key) 

is only 0.259 so no failure has occurred due to the applied loading. 

 

This completes the example. 
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Damage Analysis of 

a Composite Plate 

For software product(s):  LUSAS Composite Plus 

With product option(s): Nonlinear. 

Note: The example exceeds the limits of the LUSAS Teaching and Training Version. 

Description 

A 1mm thick 

composite plate made 

up from an IM Carbon 

cross ply laminate is 

placed under tensile 

loading to analyse the 

damage growth and 

stress redistribution 

around a stress 

concentration caused 

by a 10mm diameter hole. Because of symmetry a quarter model will be created. 

Units used are N, mm, t, s, C throughout. 

Objectives 

The objective of the analysis is: 

 To determine the onset of damage growth  

 To predict the effect of damage growth on the stress distribution within the 

composite stack 

Keywords 

Composite, Hashin, Damage, Nonlinear 

  

30 mm

70 mm

10 mm Diameter
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Associated Files 

 composite_plate_modelling.vbs  carries out the modelling of the 

example. 
 

Modelling 

Running LUSAS Modeller 

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller 

in the Examples Manual Introduction. 

Note. This example is written assuming a new LUSAS Modeller session has been 

started. If continuing from an existing Modeller session select the menu command 

File>New to start a new model file. Modeller will prompt for any unsaved data and 

display the New Model dialog. 

Creating a new model 

 Enter the file name as composite_plate  

 Use the Default working folder. 

 Enter the title as Damage Analysis of Composite Plate 

 Set the model units as N,mm,t,s,C 

 Ensure that timescale units are Seconds 

 Ensure an Analysis type of Structural is set. 

 Select the Startup template Composite 

 Select the Vertical Z axis. 

 Click the OK button. 

Note. Save the model regularly as the example progresses. Use the Undo button to 

correct any mistakes made since the last save was done. 

Feature Geometry 

The composite plate will be modelled as a quarter model and symmetry boundary 

conditions will be used to reduce the size of the model. Firstly the hole will be defined. 

 


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 Enter coordinates of (5, 0), (0, 5) and (0, 0) 

 Select the Centre option next to the (0, 0) coordinate entry and click the OK 

button. 

 

Now define the lines representing the edges of the specimen. 

 Enter coordinates of (35, 0), 

(35, 15) and (0,15) and click the 

OK button. 

Now create the lines on the 

symmetry planes. 

 Select the two points on the 

horizontal plane of symmetry  

 Create a line along the horizontal line of symmetry. 

 Select the two points on the vertical plane of symmetry. 

 Create a line along the vertical 

line of symmetry. 

 

 

 

Now create a surface from the boundary lines. 

 Change the selection mode so only Lines are selected from the display. Click and 

hold the left-hand mouse button on the selection button , then click on the  

button to select only lines. 

 Box-select all the lines in the model by clicking and dragging the cursor around all 

the lines that form the surface. 

 Create a general surface from the selected lines. 

 Change the selection mode back to the default pointer  and click in a blank area 

of the view window to deselect any selected features. 

Geometry 

Line > 

Arc/Circle > 

From 
Coords/Points... 

Geometry 

Line > 

Coordinates… 

Points on horizontal

plane of symmetry

Points on vertical

plane of symmetry

 

Geometry 

Line > 

Points… 

Geometry 

Line > 

Points… 

 

Geometry 

Surface > 

Lines… 
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Meshing 

In this example the mesh will be graded manually by specifying the number of elements 

on each of the boundary lines. The mesh pattern will not be visible until a volume mesh 

assignment has been made. 

Define a null line mesh with 16 divisions. 

 Enter 16 in the number of divisions. 

 Enter the dataset name as Divisions=16 and click the OK button. 

 Use the Ctrl and A keys together to select all the features and assign Divisions=16 

from the  Treeview to all lines. 

 Select the upper horizontal line representing the edge of the plate and assign the line 

mesh dataset Division=8 from the  Treeview. This will overwrite the previous 

assignment. 

 Select the line on the right hand side of the model and assign Divisions=2 from the 

 Treeview. This will overwrite the previous assignment. 

The surface will now be swept through the depth of the plate to create a volume. Lines 

on the newly created surface on the back face of the volume will automatically inherit 

the line mesh dataset from the swept surface. The lines through the depth will however 

adopt the default number of mesh divisions. Since one element only is required through 

the depth of the plate the default number of mesh divisions must be set to one. 

 Select the Meshing tab. 

 Change the default number of mesh divisions to 1 and click OK 

Now the volume that represents a quarter of the plate can be created. 

 Select the Surface (use the Ctrl and A keys together to select whole model). 

 Sweep the surface to form a volume. 

 Enter a translation in the Z direction of 1 and click the OK button. 

 Rotate the model to an isometric view to see the volume created. 

Now we assign a mesh to the volume. Because it is not a regular volume, a transition 

mesh is required. 

 Double click on the mesh dataset Composite Brick (HX16L) and select the Allow 

transition pattern option.  

Attributes 

Mesh > 

Line… 

File 

Model Properties… 

Geometry 

Surface > 

By Sweeping… 
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Note. Transition meshing is 

required to enable the five sided 

surface to be modelled 

predominantly with 

quadrilaterals. When using 

transitional meshing Modeller 

will introduce compatible 

triangular elements as necessary. 

 Click OK to change the mesh 

dataset. 

 Use the Ctrl and A keys to select the whole model and assign the mesh dataset 

Composite Brick (HX16L) 

 Click on  to return the model to the default view from the Z axis. 

Material Properties 

Properties of a number of the more commonly used composite materials are available 

from the composite library. The plate in this example is made up from a four layer stack 

of IM Carbon UD.  

 Select the material IM 

Carbon UD Vf=60% 

from the drop down list. 

 Ensure the option for 3D 

Solid is chosen. 

 Select the option to 

output parameters for the 

Hashin damage model 

 Click the OK button to 

add the selected 

composite material properties to the  Treeview.  

Defining the Composite Stack 

 Select the Solids and Shells option and click Next 

 Select the New  button. 
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Attributes 

Material > 

Composite 
Library… 

 

Attributes 

Composite… 
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The Add Lamina dialog will appear. 

The Name for the first lamina will be 

automatically entered as Lamina1 

The material will automatically be 

entered as IM Carbon UD Vf=60% 

(Damage) (N,mm,t,s,C) 

 Leave the thickness as 1 and the 

angle as 0 

 Click the Apply button to define the lamina and create a second lamina. 

 Lamina2 will be automatically entered for the lamina name 

 Leave the thickness as 1 but change the angle to 90 

 Click the OK button. 

 Select the Symmetric button to 

generate a four layer stack. 

 Enter the dataset name as 

Laminate Stack and click the 

Finish button. 

 

 

 

 

 

 

 

Note.  The lamina thickness values to be entered for solid models comprised of 

Pentahedral or Hexahedral composite elements are relative values, not absolute real 

thicknesses, and represent the proportion of the total thickness (as specified by 

geometric properties) apportioned to each lamina. In other words, for solid models 

comprised of Pentahedral or Hexahedral composite elements the sum of all the 

specified lamina thicknesses will always occupy the geometric thickness defined. 
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Assigning the Composite Stack 

The composite stack now needs to be assigned to the volume so that the zero fibre 

directions run along the length of the plate. To do this, a local coordinate system is 

defined such that the local axes defined correspond to the global axes. The composite 

stack is then assigned relative to this local coordinate system. 

 Ensure a Rotate Angle of 0 about the Z-axis is set. Enter the dataset name as Global 

and click the OK button. 

 Use Ctrl and A keys together to select the whole model and from the  Treeview 

drag and drop the composite dataset Laminate Stack onto the selected features. 

 On the Assign Composite dialog ensure Assign to Volumes is selected. Select the 

Local Coordinate option, ensure the dataset Global appears in the drop down list 

and click the OK button. 

Visualising lamina directions 

Now the laminate stack is assigned to the model the lamina orientation can be checked 

by visualising the lamina directions. 

 In the  Treeview click on Attributes with the right hand mouse button and select 

Properties 

 Select the Composite tab, then select the All datasets option. 

 Click on the Settings button. 

 On the Visualisation Settings 

dialog select the Visualise ply 

directions option and ensure 

Surface position Middle and 

Axis x are selected.  

 Click the OK button to return 

to the Attribute properties. 

 Click the OK button to 

visualise the layer directions. 

 In the  Treeview, in the Composite Laminate Stack section right-click on 

Lamina 2 and select the Set Lamina Active option. 

 Other lamina directions may be checked by setting each lamina active in turn. 

Attributes 

Local Coordinates… 
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 Turn off visualisation of ply directions by going to the  Treeview clicking on 

Laminate stack with the right hand mouse button and de-selecting Visualise 

assignments.. 

Supports 

Symmetry supports need to be assigned to the lines of symmetry of the model. This is 

best done by viewing the plate from above. 

 Click on  to return the model to the default view from the Z axis. 

 

1. Drag a box to select this vertical Surface

and assign support Symmetry YZ Plane

2. Drag a box to select this vertical Surface

and assign support Symmetry XZ Plane

3. Drag a box to

select this

vertical Surface

and assign

support Fixed in

Z

 

 Drag a box around the Surface on the vertical axis of symmetry. 

 Drag and drop the support dataset Symmetry YZ from the  Treeview. 

 Ensure the Assign to surfaces option is selected and click OK to assign the support 

dataset. 

 Similarly drag a box around the Surface on the horizontal axis of symmetry and 

assign the support dataset Symmetry XZ from the  Treeview to it. 

The model also needs to be restrained from moving in the out of plane direction. 

 Drag a box around the Surface on the right hand side of the model and assign the 

support dataset Fixed in Z from the  Treeview. 
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Loading 

The plate is to be placed under a tensile loading using a prescribed displacement. 

 Select the Prescribed Displacement option and click Next 

 Enter a Total displacement of 0.1 in the X direction. 

 Enter a dataset name of Prescribed Displacement and click the Finish button. 

 Drag a box around the Surface defining the right hand end of the plate and assign 

the dataset Prescribed Displacement from the  Treeview. 

 Click OK to assign to Analysis 1/Loadcase 1 

 Select the isometric view button and check the supports and loading have been 

applied as shown in this image. 

 

Analysis Control 

Because this is a nonlinear problem the load incrementation strategy needs to be 

defined.  

 From the  Treeview expand Analysis 1 right-click on Loadcase 1 and from the 

Controls option select the Nonlinear & Transient option. 

The Nonlinear & Transient dialog will appear. 

Attributes 

Loading… > 
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 Select the Nonlinear option. 

 Set Incrementation to Automatic 

 Set the Starting load factor to 0.5 

 Set the Maximum change in load factor to 0.25 

 Set the Maximum total load factor as 1 

 Change the Incremental displacement norm to 100 as convergence is to be 

monitored on the residual norm only. 

 Leave the Maximum number of time steps or increments as 0 as this ensures the 

solution will continue until the maximum load is reached. 

 

 Click the OK button to finish. 
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To avoid mechanisms in the element formulation when some of the Gauss integration 

points fail, it is necessary to switch on fine integration for the elements. 

 Select the Solution tab and click on the Element Options button. Ensure that Fine 

integration for stiffness and mass is selected and click OK. Click OK to finish. 

Saving the model 

 Save the model file. 

 

Running the Analysis 

 Open the Solve Now dialog and press OK to run the analysis. 

Note.  In running this nonlinear analysis a number of load increments are evaluated. 

An indication of the time remaining can be obtained by observing the number of the 

increment being evaluated. 

A LUSAS Datafile will be created from the model information. The LUSAS Solver 

uses this datafile to perform the analysis. 

If the analysis is successful... 

Analysis loadcase results are added to the  Treeview.  

In addition, 2 files will be created in the Associated Model Data directory where the 

model file resides: 

 composite_plate.out  this output file contains details of model data, 

assigned attributes and selected statistics of the analysis. 

 composite_plate.mys  this is the LUSAS results file which is loaded 

automatically into the Treeview to allow results processing to take place. 
 

If the analysis fails... 

If the analysis fails, information relating to the nature of the error encountered can be 

written to an output file in addition to the text output window.  Any errors listed in the 

text output window should be corrected in LUSAS Modeller before saving the model 

and re-running the analysis.  

Rebuilding a Model  

If it proves impossible for you to correct the errors reported a file is provided to enable 

you to re-create the model from scratch and run an analysis successfully. 

File 

Model Properties… 

File 

Save 




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 composite_plate_modelling.vbs  carries out the modelling of the 

example. 

 

 Start a new model file. If an existing model is open Modeller will prompt for 

unsaved data to be saved before opening the new file. 

 Enter the file name as composite_plate and click OK 

To recreate the model, select the file composite_plate_modelling.vbs located in the 

\<LUSAS Installation Folder>\Examples\Modeller
 
directory. 

 

 Rerun the analysis to generate the results 

Viewing the Results 

Loadcase results for each increment can be seen in the  Treeview. For a nonlinear 

analysis the last solved increment will be set active by default. 

 If necessary, select the isometric view button. 

 If present, turn off the Geometry and Attributes layers in the  Treeview. 

Stress Contours 

 In the  Treeview, ensure the final load increment Increment 3 Load Factor = 1 

is Set Active 

For solid models the lamina results can be selected for the top, middle or the bottom of 

any selected lamina. For this example the middle of selected laminae will be viewed. 

By default LUSAS will automatically transform results into the material direction. 

 With no features selected click the right-hand mouse button in a blank part of the 

graphics window and select Contours to add the contours layer to the  Treeview. 

The contour Properties dialog will be displayed. 



File 

New… 

File 

Script > 

Run Script... 
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 Select entity results of 

Stress - Solids lamina 

(middle) of component Sx 

and click the OK button. 

 In the  Treeview expand 

the Composite Strip layup 

entry and right-click on the 

Lamina1 and Set Lamina 

Active 

The contour key should be 

showing a maximum stress in the lamina X material direction of 1.8E3 

 By re-ordering the layers in the  Treeview the mesh can be viewed on top of the 

contour results. 

Note. When displaying layer contours the contours are displayed at the layer position 

through the thickness of the model. 

 In the  Treeview, in the  

Composite Laminate Stack entry, 

right-click on Lamina2 and Set 

Lamina Active  

The contour key should be showing a 

maximum stress in the lamina X 

material direction of 1.6e3 

Failure Contours 

When using the Hashin failure model the failure indicator (IFFLR) can be contoured. 

The indicator has the following values: 

Indicator (IFFLR) Description 

0-1 No failure 

1-2 Matrix failure 

2-3 Fibre failure 

3+ Matrix and fibre failure 

 

To display contours of the failure index for layer 2: 

 Double-click the Contours layer name in the  Treeview. 

 


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The contour Properties dialog will be displayed. 

 Select entity results of Stress - Solids lamina (middle) of component IFFLR. 

 Select the Contour Range  tab 

 Set the contour interval to 1 

 Set the maximum contour value to 3 

 Set the minimum contour value 

to 1 

 Click OK to display contours 

of Hashin failure in the 

material fibre direction for 

Lamina 2. 

 

 

 

 By zooming in the region of 

failure can be seen in more 

detail. 

 

 

 

 

 

 By changing the active loadcase it can be seen that no failure has occurred after the 

first load increment (a load factor of 0.5). By the second load increment (a load 

factor of 0.75) a small amount of matrix failure has occurred adjacent to the hole. 

 

This completes this example.
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Mixed-Mode 

Delamination 

For software product(s):  Any Plus version. 

With product option(s): Nonlinear. 

Note: The example exceeds the limits of the LUSAS Teaching and Training Version. 

Description 

This example demonstrates the use of delamination elements in a 2D analysis. Both 2D 

and 3D delamination elements are available within LUSAS. These elements have the 

ability to model all modes of crack growth under mixed-mode conditions - mode I 

(open) mode II (shear) and mode III (tear 3D only). 

 

The model is required to predict the growth of a crack within a unidirectional composite 

laminate subjected to mixed-mode loading. A starter crack 30 mm long is introduced at 

one end of a double cantilever beam (DCB) specimen. A tensile (crack opening) load is 

applied to the cracked end of the sample while a compressive (crack closing) load is 

applied to the centre of the specimen. The resulting delamination crack propagates 

along the length of the sample under mixed-mode conditions. 

The DCB specimen is constrained at either end and prescribed displacements are 

applied to the centre of the span in a negative Y direction and to the cracked arm, in a 

30 mm

Starter Crack

100mm

50 mm

P
2
=0.7125PP

1
=0.2125P

HS Carbon UD Vf=60%Interface Properties

Fracture Energy = 4

Initiation Energy = 57

3 mm

 



Mixed-Mode Delamination 

 226 

positive Y direction. No axes of symmetry other than the plane strain assumption may 

be made. The geometry of the strip and support positions are as shown. 

Units of N, mm, t, s, C are used throughout. 

Objectives 

This analysis will: 

 Predict the initiation of delamination 

 Predict the propagation of a delamination crack with increasing displacement 

 Produce an animated Deformed Mesh Plot showing the growth of delamination  

 Produce a Contour Plot showing the redistribution of direct stress caused by 

delamination on the cracked Surface. 

 Produce an animated Yield Plot showing the behaviour of the interface during 

incrementation 
  

Keywords 

Delamination, Composite, Shell, Nonlinear, Yield Symbol, Contour Plot, 

Animation 

Associated Files 

 delamination_modelling.vbs carries out the complete modelling of the 

example. 

Modelling : Delamination Model 

Running LUSAS Modeller 

For details of how to run LUSAS Modeller see the heading Running LUSAS Modeller 

in the Examples Manual Introduction.  

Note. This example is written assuming a new LUSAS Modeller session has been 

started. If continuing from an existing Modeller session select the menu command 

File>New to start a new model file. Modeller will prompt for any unsaved data and 

display the New Model dialog. 

Creating a new model 

 Enter the file name as delamination 

 Use the Default working folder. 

 Enter the title as Delamination Model 

 Set the model units to N,mm,t,s,C 




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 Ensure that the timescale units are Seconds 

 Ensure an analysis type of Structural is set. 

 Select the startup template Composite 

 Select the Vertical Y axis option. 

 Click the OK button. 

Note. It is useful to save the model regularly as the example progresses. Use the Undo 

button to correct any mistakes made since the last save was done. 

 Select the Meshing tab and set the default number of divisions to 2 

 Select the Solution tab, select Element Options and select the option for Fine 

integration for stiffness and mass 

 Click the OK button to set the element options and the OK button to set the model 

properties. 

Defining the Geometry 

 Enter coordinates of (0,0), (30,0), (50,0) and (100,0) and click OK to define the 

Points. 

 Use the Ctrl and A keys together to select the Points just defined.  

 Defines a series of straight Lines between the Points. 

 

 Select the whole model using the Ctrl + A keys together. 

 Ensure that the 

Translate option is selected 

and enter a value of 1.5 in 

the Y direction. 

 Click the OK button to finish to generate the first half of the model.  

The second half of the model will now be created by copying the existing data and 

specifying a suitable gap to enable the interface elements to be embedded in the model. 

Once the interface elements have been assigned this gap will be closed. 

 Select the whole model using the Ctrl + A keys. 




File 

Model Properties… 

Geometry 

Point > 

Coordinates... 

Geometry 

Line > 

Points... 

Geometry 

Surface > 

By Sweeping… 
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 Ensure that the Translate option is selected and enter a value of 20 in the Y 

direction. 

 

Note. At this stage the two halves of the model are separated to simplify the definition 

of the delamination interface elements. 

Meshing 

Delamination modelling requires a fine mesh density. The mesh density is controlled 

using Line mesh attributes. 

 Select Plane strain, Quadrilateral, Quadratic elements. Ensure the Regular mesh 

option is selected with automatic divisions so that Modeller uses the default number 

of mesh divisions on each line. 

 Give the attribute the name Plane Strain Mesh 

 Click the OK button to add the attribute to the  Treeview. 

 Select the whole model using the Ctrl + A keys. 

 Drag and drop the Plane Strain Mesh attribute from the  Treeview onto the 

selected features. 

The  Treeview contains some commonly used line meshes. Null line meshes with 10 

and 30 divisions need to be added to those present. 

 With the Element description set to None define a line mesh attribute containing 10 

divisions and named Divisions=10 

 Click the Apply button to add the attribute to the  Treeview. 

 Edit the number of divisions to 30 and change the attribute name to Divisions=30 

 Click the OK button to add the attribute to the  Treeview. 

1. Assign Divisions=10

to these Lines 2. Assign Divisions=30 to these Lines

 

Geometry 

Surface > 

Copy… 



Attributes 

Mesh > 

Surface… 

Attributes 

Mesh > 

Line… 
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 Assign the Divisions=10 attribute to the horizontal lines on the left-hand section of 

the model. 

Assign the Divisions = 30 attribute to the remaining horizontal lines of the rest of the 

model to give a mesh arrangement as shown. 

 

Geometric Properties 

Because this model is using plane strain elements there is no need to define or assign a 

geometric thickness to the model. Plain strain elements assume infinite thickness. 

Interface Elements 

 On the Line Mesh dialog define an Interface, 2-dimensional, Quadratic line mesh 

with 30 divisions.  

 Name the dataset Interface mesh  

 Click OK to add the dataset to the  Treeview. 

 Select the two horizontal lines on the right-hand side of the upper face of the bottom 

set of surfaces as shown in the following diagram. 

1. Select these lines and

add to selection memory

 

 Add these two lines to Selection Memory. These will form the slave surfaces of the 

interface elements. 

Attributes 

Mesh > 

Line… 

Edit 

Selection Memory > 

Set 
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Note. Items can also be added to selection memory by using the right-hand mouse 

button in the display area and selecting the Selection Memory>Set menu entry from 

the popup menu, or pressing Ctrl + M. 

Note. The order in which the lines are selected is important. The interface elements 

are drawn between sequential pairs of lines in the two selections, i.e. the first set will be 

drawn between the first line in the selection memory and the first line in the selection.  

 Click in a blank area to deselect the initial selection (note that the lines in selection 

memory will remain highlighted) 

2. Select these lines

 

 Select the two horizontal lines on the right-hand side of the lower face of the top set 

of surfaces as shown in the previous diagram. Ensure the lines in the selection match 

those in selection memory as described in the note above. 

 Drag and drop the Interface mesh attribute onto the model. Ensure Mesh from 

master to slave is selected. Click OK to finish the assignment. 

 

 Clear the selection memory. 

 

Note. It is only necessary to make use of Selection Memory if assignment of the 

interface mesh is to be carried out on more than one line in one operation. By selecting 

a lower master line, holding the Shift key down, and selecting the corresponding upper 

slave line the assignment could also be carried out on a line by line basis. 







Edit 

Selection Memory > 

Clear 




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Composite Material 

LUSAS provides a number of the more common types of composite material in the 

Composite Material Library. In this example the component is fabricated from a 

unidirectional High Strength Carbon fibre reinforced polymer matrix composite. 

 Select HS Carbon UD Vf=60% from the drop down box. 

 With the Composite properties option selected, choose Plane Strain and click the 

OK button to add the properties to the  Treeview.  

The composite material is assigned to the surfaces of the model. Firstly check the 

surface axes to show the directions for the orthogonal material. 

 In the  Treeview click the right-hand mouse button on the Geometry layer and 

select Properties 

 On the dialog select the Surface Axes option and click the OK button. All surfaces 

should appear with the double arrow (X direction) horizontal. 

Note. If required the Surface > Reverse, Cycle and Cycle Relative tools can be used 

to re-orientate surface axes as desired. 

 De-select the display of Surface axes as described above. 

Now assign the material properties: 

 Select the whole model using the Ctrl + A keys. 

 Select the HS Carbon UD Vf=60% Plane Strain (N,mm,t,s,C) attribute from the 

 Treeview and drag and drop it onto the model.  

 Ensure the Assign to surfaces option is selected on the pop up dialog and click OK 

Interface Material 

Information concerning the fracture energies and the initiation stresses for the relevant 

failure modes are defined to describe the behaviour of the interface delamination 

model. For this example it is assumed that the interface characteristics are similar for 

the two modes. Mode 1 representing opening and mode 2 shear. 

 Ensure the number of fracture modes equals 2 (default) 

 Enter the value 4 for the fracture energy and 57 for the initiation stress for both 

modes. 

 Name the attribute Interface Material and click on OK to add the attribute to the 

Treeview. 

Attributes 

Material > 

Composite 
Library…  





Attributes 

Material > 

Specialised > 

Delamination 
Interface… 
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Note.  The interface material attribute need only be assigned to the master features. 

 Click the right-hand mouse button on the Interface Mesh attribute in the  

Treeview and choose the Select Master Assignments option from the drop down 

menu. 

 Drag and drop the Interface Material attribute from the  Treeview onto the 

model to assign to Lines. 

Supports 

LUSAS provides the more common types of support by default. These can be seen in 

the  Treeview. The model will be supported in the Y direction at the cracked (left-

hand) end and in the X and Y directions at the uncracked (right-hand) end. 

 


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 Select the point at the bottom left-hand corner of the model, drag and drop the 

support attribute Fixed in Y onto the selection and click OK to assign to Points. 

 Select the point at the bottom right-hand corner of the model, drag and drop the 

support attribute Fixed in XY onto the selection and click OK to assign to Points. 

The supports will be visualised as shown. 

Loading  

The model is subjected to two prescribed displacements.  The left-hand (cracked) end 

of the model has a crack opening load assigned to it. A crack closing load is  assigned 

to the mid-span. 

The structural Loading attributes dialog will be displayed. 

 With the Concentrated option selected click Next 

 On the Concentrated dialog enter a Concentrated load in Y Dir of 0.2125  

 Enter the attribute name as Opening 

 Click the Apply button to add the attribute to the  Treeview. 

 Edit the value in the Y direction to be -0.7125 

 Enter the attribute name as Closing 

 Click the Finish button to add the loading attribute to the  Treeview. 

Now assign the loads to the model. 

 Select the uppermost Point in the top left-hand corner of the model. See following 

diagram) 

 Drag and drop the loading attribute Opening from the  Treeview onto the 

selected Point. 

 Click the OK button to accept the default Loadcase 1 and assign the loading to the 

model. 

Attributes 

Loading… 
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Select this Point to assign Closing load

Select this Point to assign Opening load

 

 Select the uppermost Point in the middle of the top section of the model. 

 Drag and drop the loading dataset Closing from the  Treeview onto the selected 

Point. 

 Click the OK button to accept the default Loadcase 1 and assign the loading to the 

model. 

The loading will be visualised. 

Final Geometry Manipulation 

It is significantly easier to assign the appropriate mesh and the material properties of the 

interface region to the model if the interface surfaces are apart. Once these 

manipulations are complete it only remains to close the interface to complete the 

construction of the model. 

Drag a box to select the top section of the model

 

 Select the top section of the model. 
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Make the points of the upper section unmergable. This will ensure the nodes either side 

of the embedded crack in the model are not merged together. Note that making points 

unmergable will also ensure that the lines are also unmergable 

 

 Move the selection to join the bottom half of the model by selecting the Translate 

option, enter a value of  -18.5 in the Y direction and click OK to confirm. 

Analysis Control 

Since this is a nonlinear problem the load incrementation strategy needs to be defined. 

The analysis is to be terminated when the vertical displacement at the left-hand tip of 

the specimen reaches 6mm. 

 Select the point at the top-left of the model where the opening load is applied. 

 From the  Treeview expand Analysis 1, then click the right hand mouse button 

on Loadcase 1 and select Nonlinear & Transient from the Controls menu. 

The Nonlinear & Transient dialog will be displayed. 

 Select the Nonlinear 

option. 

 Set Incrementation to 

Automatic 

 Set the Starting load 

factor to 10. This will 

multiply the applied 

loading by a factor of 

10 on the first load 

increment. 

 To enable the load to 

increase as required 

set the Max total load 

factor to 0 

 To prevent the 

analysis carrying on too long if an error has been made set the maximum number of 

time step or increments to 50 

Geometry 

Point > 

Make 
Unmergable 

Geometry 

Point > 

Move... 
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 In the Incremental LUSAS file output section set the Plot file value to 3. This will 

ensure results are output to the Modeller plot file every third load increment. 

 In the Incrementation section on the top-left of the dialog select the Advanced 

button. 

 Select Use arc length control 

 Select the option to Use root with lowest residual norm 

 In the Termination criteria section select the Terminate on value of limiting 

variable option. The point at the top left-hand corner of the model should be 

entered in the drop down list. Note that this may not be the same point number as 

shown in this dialog. 

 Select the Variable type as V and the value as 6 

 

 In the Step reduction section of the form ensure the Allow step reduction option is 

selected and set the Load reduction factor to 0.75 

 Click the OK button to return to the control dialog. 

 Click the OK button to exit the Nonlinear & Transient dialog. 

A  Nonlinear and Transient entry will be added to the  Treeview . A separate  

Nonlinear analysis options entry will also be added to the loadcase. 

 



Running the Analysis 

 237 

 

Saving the model 

The model is now complete and the model data must be saved. 

 Save the model file.  

 

Running the Analysis 

With the model loaded: 

 Open the Solve Now dialog and press OK to run the analysis. 

Note.  In running this nonlinear analysis a number of load increments are evaluated. 

On modern personal computers this will take just a minute or so. An indication of the 

time remaining can be obtained by observing the number of the increment being 

evaluated. 

A LUSAS Datafile will be created from the model information. The LUSAS Solver 

uses this datafile to perform the analysis. 

If the analysis is successful... 

Analyis loadcase results will be added to the  Treeview.  

In addition, 2 files will be created in the Associated Model Data directory where the 

model file resides: 

 delamination.out  this output file contains details of model data, assigned 

attributes and selected statistics of the analysis. 

 delamination.mys  this is the LUSAS results file which is loaded 

automatically into the  Treeview to allow results processing to take place. 
 

If the analysis fails... 

If the analysis fails, information relating to the nature of the error encountered can be 

written to an output file in addition to the text output window.  Any errors listed in the 

text output window should be corrected in LUSAS Modeller before saving the model 

and re-running the analysis.  

File 

Save 


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Rebuilding a Model  

If it proves impossible for you to correct the errors reported a file is provided to enable 

you to re-create the model from scratch and run an analysis successfully. 

 delamination_modelling.vbs carries out the complete modelling of the 

example. 

 

 Start a new model file. If an existing model is open Modeller will prompt for 

unsaved data to be saved before opening the new file. 

 Enter the file name as delamination 

To recreate the model, select the file delamination_modelling.vbs located in the 

\<LUSAS Installation Folder>\Examples\Modeller
 
directory. 

 

 Rerun the analysis to generate the results 

Viewing the Results 

Analyis loadcase results will be present in the  Treeview. For a nonlinear analysis the 

last solved loadcase increment is set active by default. The first stage in any results 

post-processing is to examine the deformed mesh. 

Plotting the deformed mesh 

The outline of the crack which has been initiated and grown during the solution with 

load incrementation may be observed using a solid representation of the model. For this 

the deformed mesh will be examined alone. All of the model information currently 

displayed must be removed. 

With the last (lowest) available loadcase from the  Treeview set active:  

 If the deformed mesh is not already visible, with no features selected click the 

right-hand mouse button in a blank part of the graphics area and select Deformed 

Mesh and press OK 

 Turn off each of the layer entries under the  Treeview except Deformed Mesh 

 Press the Deformations button in the  Treeview, and then select the Specify 

Factor option and enter a value of 1. Press OK 

 Double click on the Deformed Mesh entry in the  Treeview  and select the 

Mesh tab. 



File 

New… 

File 

Script > 

Run Script... 
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 Select the Solid and Outline only options. 

 Click the OK button to add the deformed mesh layer to the  Treeview. 

Note. It is useful to use a magnification factor for displaying the deformed mesh for 

nonlinear analyses so that change in shape through the analyses can be observed. 

 

The deformed mesh plot for the final loadcase increment will be displayed. 

Plotting the load deflection graph 

 Select the node at the top left-hand corner of the model where the opening load is 

applied. 

 With Time history selected click Next 

 With the Nodal option selected click Next 

 Select Entity Displacement with Component RSLT 

 The selected node will be visible in the drop down box. Click Next 

 Select the Named option and click Next 

 From the drop down list pick Total load factor and click Next 

 Enter the desired graph titles and click Finish to display the load deflection graph. 



Utilities 

Graph Wizard… 
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 Close the graph window. 

Stress contours  

The growth of the delamination seen in the deformed mesh affects the stress distribution 

within the structure. This stress redistribution is easily visualised using stress contour 

plots.  

With the last (lowest) available loadcase from the  Treeview still set active:  

 With no features selected click the right-hand mouse button in a blank part of the 

Graphics area and select Contours to add the Contours layer to the  Treeview. 

The Contour Properties dialog will be displayed. 

 Select Stress - Plane Strain contour results in the direction SX 

 Click the OK button to finish.  

 

The contour plot and the associated contour key will be displayed. 
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Animating the effect of delamination growth 

By setting other loadcase attributes active the effect of the delamination growth on the 

stress distribution may be observed. The most effective way to view this effect is to 

animate the deformed mesh with the stress contours layer showing.  

Before animating each loadcase the contour range must be set to avoid the contour key 

changing between animation frames. 

 Double click on the Contours layer in the  Treeview. 

 Select the Contour Display tab. 

 Select the Contour Range tab. 

 Select the Maximum and Minimum values and insert 1000 and -1000 for these 

cells respectively. 

 Select the Set as global range option 

 Click the OK button to finish.  

To create the animation 

 Select Load History 

 Select Next 

 Select the All Loadcases option. 

 Select Finish to display the animated sequence. 

Note. Animations may be saved for replay using other Windows animation players 

using the File>Save As AVI menu option. 

 After viewing the animation close the animation window and maximise the 

graphics window. 

Yield Plot 

The interface material formulation is an energy based model. The model allows the 

material to display three zones of behaviour. These are the elastic, softening and failed 

regions. Yield flags may be used to indicate which nodes within the model (if any) lie 

within a particular region. This technique allows a precise demonstration of the 

delamination crack extent within the model. 

 Turn off the Contours layer in the  Treeview. 

Utilities 

Animation Wizard... 


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 With no features selected, click the right hand mouse button in the graphics 

window and select the Values layer from the menu. 

 In the Properties dialogue box select the entity as Stress - Interface Elements and 

the component Yield 

 Click OK to display the softening zone. 

 

The extent of the delamination for the current loadcase can be clearly seen. The 

delamination growth can be visualised by animating this plot through successive 

loadcases.  

Animating delamination growth with yield flags 

To create an animation of the delamination growth with yield flags:. 

 Select Load History 

 Select Next 

 Select the All Loadcases option. 

 Select Finish 

 

This completes the example. 
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